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NOTICE

The information in this document is subject to change without notice and should not be 
construed as a commitment by Waters Corporation. Waters Corporation assumes no 
responsibility for any errors that may appear in this document. This document is believed 
to be complete and accurate at the time of publication. In no event shall Waters 
Corporation be liable for incidental or consequential damages in connection with, or 
arising from, the use of this document.

© 2002 WATERS CORPORATION. ALL RIGHTS RESERVED. THIS DOCUMENT 
OR PARTS THEREOF MAY NOT BE REPRODUCED IN ANY FORM WITHOUT 
THE WRITTEN PERMISSION OF THE PUBLISHER.

Micromass and Waters are registered trademarks, and MassLynx is a trademark of Waters 
Corporation.

All other trademarks or registered trademarks are the sole property of their respective 
owners.
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Safety Information

General

The Micromass Q-Tof micro is designed solely for use as a mass spectrometer; any 
attempt to use it for any other purpose is liable to damage the instrument and will 
invalidate its warranty.

The Micromass Q-Tof micro mass spectrometer conforms to European standard 
EN61010-1:2001, Safety Requirements for electrical equipment for measurement, control 
and laboratory use - Part 1: General requirements.

The instrument has been designed and tested in accordance with recognized safety 
standards. If the instrument is used in a manner not specified by the manufacturer, the 
protection provided by the instrument may be impaired.

Whenever the safety protection of the instrument has been compromised, disconnect the 
instrument from all power sources and secure the instrument against unintended operation.

The instrument must be installed in such a manner that the user can easily access and 
isolate the power source.

Safety Symbols

Warnings in this User's Guide, or on the instrument, must be observed during all phases of 
service, repair, installation and operation of the instrument. Failure to comply with these 
precautions violates the safety standards of the design and intended use of the instrument.

Micromass UK Limited assumes no liability for the user's failure to comply with these 
requirements.

The following safety symbols may be used in the User's Guide, or on the instrument. A 
Caution is an instruction that draws the user's attention to the risk of injury or death; a 
Attention is an instruction that draws attention to the risk of damage to the instrument.

Caution:  This is a general warning symbol, indicating that there is a potential health or 
safety hazard; the user should refer to this User's Guide for instructions.

Caution: This symbol indicates that hazardous voltages may be present
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Caution: This symbol indicates that hot surfaces may be present.

Caution: This symbol indicates that there is danger from corrosive substances.

Caution: This symbol indicates that there is danger from toxic substances.

Caution: This symbol indicates that there is danger from flammable substances.

Caution: This symbol indicates that there is danger from laser radiation.

Attention: This is a general caution symbol, indicating that care must be taken to avoid 
the possibility of damaging the instrument, or affecting its operation.
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Q-Tof micro Mass Spectrometer Information

Intended Use

The Micromass Q-Tof micro Mass Spectrometer can be used as a research tool to deliver 
authenticated exact mass in both MS and MS-MS mode. It is not for use in diagnostic 
prodedures.

Biological Hazard

When you analyze physiological fluids, take all necessary precautions and treat all 
specimens as potentially infectious. Precautions are outlined in “CDC Guidelines on 
Specimen Handling,” CDC – NIH Manual, 1984.

Calibration

Follow acceptable methods of calibration with pure standards to calibrate methods. Use a 
minimum of five standards to generate a standard curve. The concentration range should 
cover the entire range of quality-control samples, typical specimens, and atypical 
specimens.

Quality Control

Routinely run three quality-control samples. Quality-control samples should represent 
subnormal, normal, and above-normal levels of a compound. Ensure that quality-control 
sample results are within an acceptable range, and evaluate precision from day to day and 
run to run. Data collected when quality-control samples are out of range may not be valid. 
Do not report this data until you ensure that system performance is acceptable.
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Preface

The Micromass QTof micro Mass Spectrometer is intended for a wide variety of users 
whose familiarity with Mass Spectrometers, computers and software ranges from novice 
to expert. This guide describes the basics of how to Startup the instrument, obtain an Ion 
Beam, Calibrate and Acquire Data using MassLynx Software, and maintain the 
instrument.

Organization

This guide contains the following:

Chapter 1 gives a brief description and overview of the instrument

Chapter 2 describes the routine procedures that are required to Startup and Shutdown 
the Instrument

Chapter 3 describes the the Electrospray Interface.

Chapter 4 describes the Nanoflow Interface.

Chapter 5 describes the APcI Interface.

Chapter 6 describes the Tuning page and how to Obtain an Ion Beam.

Chapter 7 describes how to calibrate the instrument.

Chapter 8 describes how to Acquire data from the MassLynx sample list and how to set 
up a method.

Chapter 9 describes a Parent Ion Discovery experiment.

Chapter 10 describes Maintenance and Fault Finding for the instrument.

Related Documentation

Waters Licenses, Warranties, and Support: Provides software license and warranty 
information, describes training and extended support, and tells how Waters handles 
shipments, damages, claims, and returns.

Online Documentation

MassLynx Help: Describes all MassLynx windows, menus, menu selections, and 
dialog boxes for the base software and software options. Also included are help Files 
1
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on Inlet Control, Interfacing, Security and any application software that may have been 
purchased.

MassLynx ReadMe File: Describes product features and enhancements, helpful tips, 
installation and/or configuration considerations, and changes since the previous 
version.

Printed Documentation for Base Product

Instrument User’s Guides: Provides an introduction to the running and maintenance 
of the Instrument and also basic instructions on how to acquire data and calibrate the 
instrument.

MassLynx User’s Guide: Provides a comprehensive introduction to the MassLynx 
software. Describes the basics of how to use MassLynx software to acquire data 
develop an acquisition method, review and process results, and print a report. 

MassLynx Interfacing Guide: Provides information on how to interface MassLynx 
with other Software applications.

MassLynx Inlet Control Guide: Provides information on how to install and run 
Autosamplers, LC and GC systems, UV detectors using MassLynx.

MassLynx Security User’s Guide: Describes how to add security to your MassLynx 
system.

Printed Documentation for Software Options

QuanLynx User’s Guide: Describes the procedures for installing, configuring and 
using QuanLynx Software.

OpenLynx User’s Guide: Describes the procedures for installing, configuring and 
using OpenLynx Software.

FractionLynx User’s Guide: Describes the procedures for installing, configuring and 
using FractionLynx Software.

MetaboLynx User’s Guide: Describes the procedures for installing, configuring and 
using MetaboLynx Software.

BioLynx and ProteinLynx User’s Guide: Describes the procedures for installing, 
configuring and using BioLynx and ProteinLynx Software.

MicrobeLynx User’s Guide: Describes the procedures for installing, configuring and 
using MicrobeLynx Software.
2
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NeoLynx User’s Guide: Describes the procedures for installing, configuring and using 
NeoLynx Software.

TargetLynx User’s Guide: Describes the procedures for installing, configuring and 
using TargetLynx Software.

GCLynx User’s Guide: Describes the procedures for installing, configuring and using 
GCLynx Software.

Documentation on the Web

Related product information and documentation can be found on the World Wide Web. 
Our address is http://www.waters.com/micromass.

Documentation Conventions

The following conventions can be used in this guide:

Convention Usage

Bold Bold indicates user action such as keys to press, menu selections, 
and commands. For example, “Click Next to go to the next page.”

Italic Italic indicates information that you supply such as variables. It also 
indicates emphasis and document titles. For example, “Replace 
file_name with the actual name of your file.”

Courier Courier indicates examples of source code and system output. For 
example, “The SVRMGR> prompt appears.”

Courier Bold Courier bold indicates characters that you type or keys you press in 
examples of source code. For example, “At the LSNRCTL> prompt, 
enter set password oracle to access Oracle.”

Keys The word key refers to a computer key on the keypad or keyboard. 
Screen keys refer to the keys on the instrument located immediately 
below the screen. For example, “The A/B screen key on the 2414 
Detector displays the selected channel.”

… Three periods indicate that more of the same type of item can 
optionally follow. For example, “You can store filename1, 
filename2, … in each folder.”

> A right arrow between menu options indicates you should choose 
each option in sequence. For example, “Select File > Exit” means 
you should select File from the menu bar, then select Exit from the 
File menu.
3
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Notes

Notes call out information that is helpful to the operator. For example:

Note: Record your result before you proceed to the next step.

Attentions

Attentions provide information about preventing damage to the system or equipment. For 
example:

Cautions

Cautions provide information essential to the safety of the operator. For example:

Attention: To avoid damaging the detector flow cell, do not touch the flow cell 
window.

Caution: To avoid burns, turn off the lamp at least 30 minutes before removing it for 
replacement or adjustment.

Caution: To avoid electrical shock and injury, unplug the power cord before 
performing maintenance procedures.

Caution: To avoid chemical or electrical hazards, observe safe laboratory practices 
when operating the system.

Caution: Operating the source without the source enclosure will result in solvent 
vapor escape.

Caution: Strong acid causes burns. Carry out this procedure in a fume cupboard 
using protective equipment.

Caution: Cleaning the source requires the use of solvents and chemicals which 
may be flammable.
4
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Chapter 1
Overview

This chapter gives a brief description of the following

• The Micromass Q-Tof micro Section 1.1
• The Ion Optics Section 1.2
• The Internal Layout Section 1.3
• The Vacuum System Section 1.4 
• Front and Rear Panel Connections Section 1.5 and Section 1.6
• The MassLynx Data System Section 1.7

Figure 1-1  The Micromass Q-tof micro
5
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1.1  Instrument Description

The Q-Tof micro hybrid quadrupole time of flight mass spectrometer is available with 
electrospray ionisation (ESI) and atmospheric pressure chemical ionisation (APcI).

Q-Tof micro utilises a high performance, research grade quadrupole mass analyser,  
incorporating a prefilter assembly to protect the main analyser from contaminating 
deposits, and an orthogonal acceleration time of flight (TOF) mass spectrometer. A 
hexapole collision cell, between the two mass analysers, can be used to induce 
fragmentation to assist in structural investigations.

Ions emerging from the second mass analyser are detected by the microchannel plate 
detector and ion counting system. 

A PC computer runs the MassLynx NT software system to control Q-Tof micro, and to 
acquire and process data.

1.1.1  Ionisation Techniques

Using the Micromass Z-spray atmospheric pressure ionisation (API) source, two 
techniques are available.

1.1.2  Atmospheric Pressure Chemical Ionisation

Atmospheric pressure chemical ionisation (APcI) generally produces protonated or 
deprotonated molecular ions from the sample via a proton transfer (positive ions) or 
proton abstraction (negative ions) mechanism. The sample is vapourised in a heated 
nebuliser before emerging into a plasma consisting of solvent ions formed within the 
atmospheric source by a corona discharge. Proton transfer or abstraction then takes place 
between the solvent ions and the sample. Eluent flows up to 2 millilitres/minute can be 
accommodated without splitting the flow.

1.1.3  Electrospray

Electrospray ionisation (ESI) takes place as a result of imparting a strong electrical charge 
to the eluent as it emerges from the nebuliser. An aerosol of charged droplets emerges 
from the nebuliser. These undergo a reduction in size by solvent evaporation until they 
have attained a sufficient charge density to allow sample ions to be ejected from the 
surface of the droplet (“ion evaporation”).
6 Overview
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A characteristic of ESI spectra is that ions may be singly or multiply charged. Since the 
mass spectrometer filters ions according to their mass-to-charge ratio ( ), compounds of 
high molecular weight can be determined if multiply charged ions are formed.

Eluent flows up to 1 ml/min can be accommodated although it is often preferable with 
electrospray ionisation to split the flow such that 5-50 µl/min of eluent enters the mass 
spectrometer.

1.1.4  Nanoflow Electrospray

The optional nanoflow interface allows electrospray ionisation to be performed in the flow 
rate range 5 to 1000 nanolitres per minute.

For a given sample concentration, the ion currents observed in nanoflow are comparable 
to those seen in normal flow rate electrospray. Great sensitivity gains are therefore 
observed when similar scan parameters are used, due to the great reductions in sample 
consumption.
Instrument Description 7
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1.2  Ion Optics

Figure 1-2  Q-Tof micro Ion Optics

The principal components of the ion optical system are shown in Figure 1-2.

Ions generated in the Z-spray source are transferred to the quadrupole analyser MS1 via 
the independently pumped RF lens. After leaving the quadrupole analyser the ions flow 
into the orthogonal time of flight analyser MS2. The ion beam is focused into the pusher 
by the acceleration, focus, steer and tube lenses. The pusher then pulses a section of the 
beam towards the reflectron, which then reflects ions back to the detector.

As ions travel from the pusher to the detector they are separated in mass according to their 
flight times, with ions of the highest mass to charge ratio ( ) arriving later.

Probe

MS1 (Quadrupole MS)

MS2 (TOF MS)

MCP
Detector

Pusher

Z-spray
Ion Source

RF Lens

Hexapole
Transfer Lens

Quadrupole
Analyser
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Collision Cell

Reflectron
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The pusher may be operated at repetition frequencies of up to 30 kHz, resulting in a full 
spectrum being recorded by the detector every 33 microseconds. Each spectrum is 
summed in the histogram memory of the time to digital converter until the histogrammed 
spectrum is transferred to the host PC.

If the user has requested an acquisition rate of 1 spectrum/second, each spectrum viewed 
on the host PC will be the result of summing up to 30,000 individual spectra recorded at 
the detector.

Unlike scanning instruments, the TOF performs parallel detection of all masses within the 
spectrum at very high sensitivity and acquisition rates. This characteristic is of particular 
advantage when the instrument is coupled to fast chromatography, since each spectrum is 
representative of the sample composition at that point in time, irrespective of how rapidly 
the sample composition is changing.

1.3  Internal Layout

Caution: The covers should not be removed without first isolating the instrument at the 
electricity supply.

Attention: The internal layout is shown in the following diagrams for information only, and 
does not imply that labelled components are user-serviceable.
Internal Layout 9
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1.3.1  Mechanical Components

Figure 1-3  Mechanical Components - Internal View.

The main internal mechanical components of the instrument are:

• The source housing, containing the RF (hexapole) lens.
• The MS1 analyser housing, containing the quadrupole analyser, hexapole collision 

cell and hexapole transfer lens
• The TOF analyser housing, containing the pusher, detector and reflectron assemblies.
• One 250 litre/second turbomolecular pump, plus one split-flow turbomolecular 

pump.
• Two active inverted magnetron (Penning) gauges and two Pirani gauges.

1.3.2  Electrical Components

The main electronics unit is located in the lower rear section of the instrument. This 
contains:

Osmc Osmc

DESOLVATION GAS CAPILLARY CORONA

NANOFLOW PROBES

NEBULISER GAS

LOAD

INJECT

GAS CELL NANOFLOW

RF  G enerator

PSU

Z-spray
Source

Turbom olecular
Pum ps
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• High voltage power supplies. 
• These supply the probe or corona, reflectron, TOF flight tube and lens circuits.
• Low voltage power supplies.
• These supply the PCBs, high voltage supplies and turbomolecular pumps.
• Main PCBs.
• For communications, lenses and quadrupole control.

Figure 1-4  Rear View of Instrument

M ain PCBs

Flight Tube

High Voltage PSU
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1.4  The Vacuum System

Figure 1-5  Q-Tof micro Vacuum System

1.4.1  Fine Pumping

Q-Tof micro is equipped with three water cooled turbomolecular pumps, providing 
independent fine pumping of the source hexapole, quadrupole and TOF analysers. Details 
of the operation and maintenance of the pumps can be found in the manufacturer’s 
manuals provided.

TOF
 Analyser

Quadrupole Analyser

Automatic 
Vent

(to N )2Exhaust

Oil Mist
Filter

Rotary 
Pump

Pirani 
Gauge

Active Inverted 
Magnetron Gauge

Pirani 
Gauge

Turbomolecular 
Pump

Split Flow
Turbomolecular 

Pump

CID 
Gas 

Solenoid 
Valve

Speedivalve

Probe

Z-spray
Ion Source

Gas Cell
12 Overview



1

Qtof Micro.book  Page 13  Thursday, December 19, 2002  3:39 PM
1.4.2  Rotary Pumping

Source pumping and turbomolecular pump backing is by a direct drive rotary pump. The 
rotary pump is situated at the front of the instrument. Details of the operation and 
maintenance of the pump can be found in the manufacturer’s manual provided.

1.4.3  Pressure Measurement

The backing pressure is monitored by an active Pirani gauge. The analyser and TOF 
pressures are monitored by active inverted magnetron (Penning) gauges. These gauges act 
as vacuum switches, switching the instrument out of Operate mode if the pressure is too 
high. Pressure readings may be displayed on the MassLynx NT tune page.

The analyser Penning gauge only comes on when the vacuum display window is open. At 
other times the gauge is off. The analyser Pirani gauge is used when the diaply is off, 
though no pressures are shown. 

1.4.4  Vacuum Protection

The vacuum system is fully interlocked to provide adequate protection in the event of:

• a fault in the vacuum system.
• a failure of the power supply.
• a failure of the water supply.
• a vacuum leak.
The Vacuum System 13
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1.5  Front Panel Connections

Figure 1-6  Front Panel

1.5.1  Desolvation Gas and Probe Nebuliser Gas

The PTFE gas lines for the Desolvation Gas and probe Nebuliser Gas are connected to the 
front of the instrument using threaded metal fittings. Cone Gas is connected internally.

1.5.2  High Voltage

The electrical connection for the ESI capillary or the APcI corona discharge pin is via the 
coaxial high voltage connector. This socket is labeled Capillary / Corona.

1.5.3  Heaters

The electrical connection for the APcI probe or the ESI desolvation heater is via the 
multi-way connector labeled Probes. This is removed from the front panel by pulling on 
the metal sleeve of the plug. Both the electrospray desolvation heater and the APcI probe 
heater use this connector.

The power for the source block heater is permanently connected. As a consequence, the 
source block assembly is usually very hot, and should not be touched.
14 Overview
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1.5.4  Front Panel Controls and Indicators

Status Display

The display on the front panel of the instrument consists of two 3-colour light emitting 
diodes (LEDs).

The display generated by the Pump LED is dependent on the vacuum status of the 
instrument. The Operate LED depends on both the vacuum status and whether the operate 
mode has been selected from the Data System. Further information is included in 
Automatic Pumping and Vacuum Protection (see Routine Procedures).

Divert / Injection Valve

The divert / injection valve may be used in several ways depending on the plumbing 
arrangement:

• As an injection valve, with the needle port and sample loop fitted.
• As a divert valve, to switch the flow of solvent during a LC run.
• As a switching valve to switch, for example, between a LC system and a syringe 

pump containing calibrant.

This valve is pneumatically operated, using the same nitrogen supply as the rest of the 
instrument.

The two switches marked Load and Inject enable the user to control the valve when 
making loop injections at the instrument.
Front Panel Connections 15
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1.6  Rear Panel Connections

Figure 1-7  Rear Panel Connections

1.6.1  Water

Water is used to cool the turbomolecular pumps.

1.6.2  Nitrogen Gas In

The nitrogen supply (100 psi, 7 bar) should be connected to the Nitrogen Gas In push-in 
connector using 6mm PTFE tubing. If necessary this tubing can be connected to ¼ inch 
tubing using standard ¼ inch fittings.

Caution: Use only PTFE tubing or clean metal tubing to connect between the nitrogen 
supply and the instrument. The use of other types of plastic tubing will result in chemical 
contamination of the source.

Rotary Pump Power

Supply Inlet Water In
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1.6.3  Exhausts

The exhaust from the rotary pump should be vented to atmosphere outside the laboratory.

The gas exhaust, which also contains solvent vapours, should be vented via a separate 
fume hood, industrial vent or cold trap.

The gas exhaust should be connected using 10mm plastic tubing connected to the push-in 
fitting.

Caution: Do not connect these two exhaust lines together as, in the event of an instrument 
failure, rotary pump exhaust could be admitted into the source chamber producing severe 
contamination.

1.6.4  Supply Inlet

The mains power cord should be wired to a 230V mains outlet using a suitable plug, or to 
a transformer. For plugs with an integral fuse, the fuse should be rated at 13 amps (UK 
only).

1.6.5  Electronics

This circuit breaker switches power to the electronics. In the event of the instrument 
drawing more than the rated current, the circuit breaker will trip. 

1.6.6  Rotary Pump

This circuit breaker switches power to the rotary and turbomolecular pumps. In the event 
of the pumps drawing more than the rated current, it will trip. 

1.6.7  Event Out

Four outputs, Out 1 to Out 4 (Figure 1-8), are provided to allow various peripherals to be 
connected to the instrument. Switches S1 to S4 allow each output to be set to be either a 
contact closure (upper position) or a voltage output (lower position).

Out 1 and Out 2, when set to voltage output, each have an output of 5 volts. The voltage 
output of both Out 3 and Out 4 is 24 volts.

During a sample run an event output may be configured to close between acquisitions and 
is used typically to enable an external device to inject the next sample.
Rear Panel Connections 17
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1.6.8  Contact Closure In

In 1 and In 2 inputs are provided ((Figure 1-8) to allow an external device to start sample 
acquisition once the device has performed its function (typically sample injection).

1.6.9  Analog Channels

Four analog channel (Figure 1-8) inputs are available, for acquiring simultaneous data 
such as a UV detector output. The input differential voltage must not exceed one volt.

Figure 1-8  Rear Panel Outputs

1.7  MassLynx Data System

A PC computer runs the MassLynx NT software system to control Q-Tof micro, and to 
acquire and manipulate data from it. A high resolution colour monitor is also supplied.

Interaction with MassLynx NT is via the mouse and keyboard using menu-driven 
commands. Printing, file management and other routine procedures are performed using 
the appropriate Windows NT modules.
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1.7.1  Software

The following software packages are supplied with Q-Tof micro:

• MassLynx NT.
• DataBridge, a utility to convert other format data files into MassLynx format.
• Microsoft Windows NT/2000/XP graphical environment.
• Mouse configuration.

A range of optional software modules for different applications is also available.

The MassLynx NT User’s Guide describes the many facilities of the Micromass software. 
Documentation for the other software is also supplied.
MassLynx Data System 19
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Chapter 2
Routine Procedures

The following Routine Procedures are described in this chapter:

• Section 2.1, Start Up Following a Complete Shutdown
• Section 2.2, Start Up Following Overnight Shutdown
• Section 2.3, Automatic Startup and Shutdown 

2.1  Start Up Following a Complete Shutdown

2.1.1  Preparation

If the instrument has been unused for a lengthy period of time, proceed as follows:

1. Check the level of oil in the rotary pump sight glass. Refill or replenish as necessary 
as described in the pump manufacturer’s literature.

2. Connect a supply of dry, high purity nitrogen to the connector on the service panel at 
the rear of the instrument. Adjust the outlet pressure to 7 bar (100 psi).

3. Connect the water supply to the connections at the rear of the instrument.
4. Check that the rotary pump exhaust is connected to a suitable vent.

5. Check that the instrument, data system and other peripheral devices (LC equipment, 
printer etc.) are connected to suitable mains supplies.

6. Check that the etherlink connection is made between the control PC and the 
instrument PC.

7. Switch on the host PC. Log on to Windows NT and wait for the system to boot up 
before the Q-Tof micro is switched on.

8. Switch on the mains to the mass spectrometer using the two circuit breakers situated 
on the service panel at the rear of the instrument.

Attention: Do not connect the two exhaust lines together. In the event of an instrument 
failure, rotary pump exhaust could be admitted into the source chamber, producing 
severe contamination
Start Up Following a Complete Shutdown 21
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9. Switch on the embedded PC using the switch at the rear of the instrument.
10. Log on to Micromass account (password analysis).

Note: Windows NT and MassLynx are configured to prevent unauthorized access. 

11. On the host PC, select Instrument >MS Tune from the MassLynx Shortcut bar. 
This will invoke the Instrument Tune Page.

2.1.2  Pumping

1. Select Vacuum from the menu bar at the top of the tune page.
2. Click on Pump.
3. The rotary pump and the turbomolecular pumps start simultaneously.
4. The Vacuum LED on the front of the instrument shows amber as the system pumps 

down.

When the system has reached operating vacuum the Vacuum LED changes to a steady 
green.

5. If the rotary pump oil has been changed or replenished, open the gas ballast valve on 
the rotary pump. See the pump manufacturer's literature for details.

Rotary pumps are normally noticeably louder when running under gas ballast.

6. If opened, close the gas ballast valve when the rotary pump has run under gas ballast 
for 30 minutes.

Attention: To minimize wear to the lubricated components of the rotary pump, the 
manufacturers recommend that the pump is not started when the oil temperature is below 
12°C.
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2.1.3  MCP Detector Conditioning

Figure 2-1  MCP Conditioning Dialog

The MCP detector must be conditioned before use, by gradually increasing the applied 
voltage over a long time period. This is necessary to allow escape of all absorbed water 
from within the microchannels.

Under normal operation the analyzer automatically vents to dry nitrogen. However, if the 
nitrogen supply was not connected to the instrument when last vented, or if the instrument 
has been left vented for more than one day, a significant amount of water vapor may have 
entered the analyzer. Under these circumstances it is good practice to allow the instrument 
to pump for 12 hours before commencing the conditioning process.

In all cases, the TOF pressure must be 2e-6 mbar prior to commencing MCP conditioning.

MCP conditioning should be repeated after every instrument venting.

Note: It is not necessary to recondition the detector if the instrument has been left out of 
the operate mode while still under vacuum.

Note: During routine cleaning of the source sample cone, the source isolation valve is 
closed in order to maintain analyzer vacuum. It is not, therefore, necessary to recondition 
the detector after this procedure.

The procedure for MCP conditioning is as follows:

1. Ensure that the TOF pressure is 2e-6 mbar.
2. Check that the MCP Detector voltage is set to zero on the tune page.
3. Switch the instrument into Operate.
Start Up Following a Complete Shutdown 23
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4. Select Options > MCP Conditioning to access the MCP conditioning program 
(Figure 2-1).

5. Set Start to 100V, Stop to 2700V, Duration to 600 minutes and Step to 5 minutes.
6. A ‘quick condition’ may be performed following brief venting, after source cleaning 

for example.
7. Set Start to 100V, Stop to 2700V, Duration to 180 minutes and Step to 1 minute.

2.1.4  Instrument Warm-up 

Switch the instrument into the operate mode by selecting Operate on the MassLynx tune 
page.

For the best mass accuracy to be obtained the instrument temperature must be stabilized 
for a minimum of two hours after switching into operate.

Note: Leaving the instrument continuously in operate does not shorten the detector 
lifetime. It is recommended that the instrument is left in operate at all times (except of 
course during maintenance procedures) in order to reduce mass scale drifts due to 
temperature changes. Switching the instrument out of operate mode overnight is not 
necessary.

2.1.5  Using the Instrument

The Q-Tof micro is now almost ready to use. To complete the start up procedure and 
prepare for running samples, follow the instructions in Start Up Following Overnight 
Shutdown in the following pages.

2.2  Start Up Following Overnight Shutdown

The instrument will have been left in the operate mode under vacuum.

It is recommended that the data system is left on overnight. However, if the data system 
has been switched off, switch it on as described in the preceding section.

Attention: Failure to follow the recommended MCP conditioning procedure can severely 
reduce detector lifetime.
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2.2.1  Preparation for Electrospray Operation

If the corona discharge pin is fitted, proceed as follows:

1. Deselect Operate from the tune page to put the instrument into standby mode.
2. Disconnect the gas and electrical connections from the front panel.
3. Unscrew the probe thumb nuts and remove the probe.
4. Undo the three thumb screws and remove the probe adjustment flange and glass 

tube.

5. Disconnect the APcI high voltage cable from the socket positioned at the bottom 
right corner of the source flange.

6. Remove the corona discharge pin from its mounting contact, and fit the blanking 
plug.

7. Replace the glass tube and adjustment flange.
8. Ensure that the source enclosure is in place.

Note: The Z-spray source enclosure consists of the glass tube and the probe adjustment 
flange.

9. With the corona discharge pin removed, the plug fitted and the source enclosure in 
place, proceed as follows:

10. Connect the source’s gas line to Desolvation Gas on the front panel. Tighten the nut 
to ensure a good seal.

11. Check that the lead of the probe adjustment flange is plugged into the socket 
labelled Probes on the front panel.

12. Connect the electrospray probe's gas line to Nebuliser Gas on the front panel.
13. Connect the liquid flow of a LC system or syringe pump to the probe.
14. Insert the probe into the source and tighten the two thumb nuts to secure the probe 

firmly.

Caution: The ion source block can be heated to temperatures of 150°C, and will be 
maintained at the set temperature when the source enclosure is removed. Touching the 
ion block when hot may cause burns to the operator

Caution: Operating the source without the source enclosure will result 
in solvent vapor escape and the exposure of hot surfaces and high 
voltages.
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15. Plug the probe lead into Capillary / Corona on the front panel.
16. If necessary, change the ionization mode using the Ion Mode command.
17. Set Source Block Temp to 100°C and Desolvation Temp to 120°C.

2.2.2  Preparation for APcI Operation

If the corona discharge pin is not fitted, proceed as follows:

1. Deselect Operate from the tune page to put the instrument into standby mode.
2. Disconnect the gas and electrical connections from the front panel.
3. Unscrew the probe thumb nuts and remove the probe.
4. After a period of operation at high flow rates, allow the glass source enclosure to 

cool before removal.
5. Undo the three thumb screws and remove the probe adjustment flange and glass 

tube.

6. Remove the blanking plug from the discharge pin mounting contact and fit the 
corona discharge pin, ensuring that the tip is in line with the tip of the sample cone.

7. Connect the APcI high voltage cable between Capillary / Corona and the socket 
positioned at the bottom left corner of the source flange.

8. Replace the glass tube, adjustment flange and moulded cover.

9. With the corona discharge pin fitted and the source enclosure in place, proceed as 
follows:

10. Insert the APcI probe into the source and tighten up the two thumb screws.
11. If necessary, change the ionization mode using the Ion Mode command.

Attention: The maximum operating temperature for the source heater is 150°C. Do not 
set Source Block Temp higher than 150°C.

Attention: The ion source block can be heated to temperatures of 150°C, and will be 
maintained at the set temperature when the source enclosure is removed. Touching the 
ion block when hot may cause burns to the operator.

Caution: Operating the source without the source enclosure will result 
in solvent vapor escape and the exposure of hot surfaces and high 
voltages.
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12. Set Source Temp to 150°C.

Note: Do not start the liquid flow until the gas flow and probe heater are switched on with 
the probe inserted.

2.2.3  Transient Pressure Trip

The transient trip is designed to protect the instrument from potentially damaging pressure 
surges and operates routinely whenever the pressure rises.

Should the vacuum gauge(s) detect a pressure surge above the preset trip level (normally 
set at 1e-5 mbar by software) the following events occur:

• The green Pump lamp becomes amber.
• If in the operate mode, the system turns off the critical source, analyzer and 

detector voltages, and the green Operate lamp becomes amber.
• Acquisition continues though, of course, no real data are recorded.

When the vacuum recovers:

• The amber Pump lamp becomes green.
• If previously in the operate mode, voltages are restored and Operate reverts to 

green.

The period during which the trip was operative will appear in a raw total ion 
chromatogram as a period of reduced baseline noise.

Further deterioration of the system pressures results in a “vacuum fault” condition and the 
system is shut down (see below).

2.2.4  Power Failure

In the event of an unexpected failure of the electrical supply the instrument is vented 
safely. If power is unlikely to be restored quickly, follow the shutdown procedure 
described later in this chapter. When power is restored follow the startup procedure.

Should the power fail and then be restored while the instrument is unattended, the system 
will continue to vent, and will require to be pumped down in accordance with the start-up 
procedure.

Attention: The maximum operating temperature for the source heater is 150°C. Do not 
set Source Block Temp higher than 150°C.
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2.2.5  Nitrogen Supply

Replacement of nitrogen cylinders should be conducted in accordance with the operation, 
handling and storage instructions provided by the local gas supplier.

Toggle the API gas button to Off, to close the nitrogen inlet valve prior to 
disconnecting the supply.
Set the nitrogen inlet pressure to 7 bar (100 psi).

2.3  Automatic Startup and Shutdown 

MassLynx comes with automatic Startup and Shutdown files. They are found in the 
C:\MassLynx\Shutdown directory and are called ShutDownxxx.acl and StartUpxxx.acl 
where xxx refers to the instrument configuration. E.g. ShutDownESI_ACE.acl for an 
instrument configured as an ACE system. 

2.3.1  The Shutdown Editor 

The shutdown editor allows the automatic startup and shutdown procedures to be modified 
or new procedures to be created. These can be run automatically before or after a batch if 
the relevant boxes are checked in the Batch Control frame of the Shutdown Page 
(Section 2.3.3).

Select Edit Shutdown or Startup from the MassLynx Instrument Shortcut Bar. 
This Invokes the Shutdown Editor which has two tabbed pages, the Shutdown Page 
(described in Section 2.3.3 on page 29) and the Auto Control Tasks Page (described 
in Section 2.3.4 on page 33)

Attention: Under no circumstances should the nitrogen pressure exceed 10 bar (140 
psi).
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2.3.2  The Shutdown Editor Toolbar 

2.3.3  Shutdown Page
Select Edit Shutdown or Startup from the MassLynx Instrument Shortcut Bar.
By default the Shutdown Page is displayed (Figure 2-2) with the following 
parameters.

Toolbar 
Button

Menu 
Equivalent

Purpose

File... New Create a new Startup or Shutdown file

 File... Open Open an existing Startup or Shutdown 
file

File... Save or Save 
As 

Save a Startup or Shutdown file

File... Print Print a Startup or Shutdown file

Control List..Run 
List

Run a Startup or Shutdown file

Control List...Stop 
List

Stop a Startup or Shutdown file

Enable startup before 
batch 

Enables/disables the running of a task file before the start 
of a batch of samples. Startup Enabled will appear on the 
right of the Status bar on the bottom of the MassLynx 
window when checked.

Startup file The file name of the task file that is run before the start of a 
batch. 

Browse startup file Brings up a file dialog allowing a task file to be selected 
for the startup before batch procedure. 

Enable shutdown after 
batch 

Enables/disables the running of a task file after the end of a 
batch of samples. Shutdown Enabled will appear on the 
right of the Status bar on the bottom of the MassLynx 
window when checked.
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Figure 2-2  Shutdown Page

Configure Shutdown on Error 

Clicking on the Configure Error Shutdown button displays the following dialog.

Shutdown file The file name of the task file that is run after the end of a 
batch. 

Browse shutdown file Brings up a file dialog allowing a task file to be selected 
for the shutdown after batch procedure. 

Shutdown Time This is the delay (in minutes) between the batch finishing 
and the shutdown procedure initiating. 

Shutdown On Error This allows shutdown on error to be enabled/disabled and 
to determine whether the shutdown tasks should be initi-
ated immediately, or after the time entered in the Shutdown 
Time edit box. 

Configure Error Shutdown Brings up the Shutdown on Error Configuration dialog (see 
Section  on page 30). 

Optimization Check this box to optimize the procedure. 
E-mail on Shutdown Check box and enter the e-mail address for shutdown 

information to be sent. 
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Figure 2-3  Shutdown on Error Configuration Dialog 

Configure Contact Closures 

Clicking on the Configure CCs displays the following dialog.

MS error Enables/disables running a task file when an MS error 
occurs. 

MS error shutdown file The task file to run on an MS error. 
MS error browse file Allows user to browse for task files. 
MS Comms Error Enables/Disables running task file when MS comms error 

occurs 
MS comms error shut-
down file 

The task file to run on an MS comms error. 

Inlet fatal error Enables/disables running a task file when a LC error 
occurs. 

Inlet error shutdown file The task file to run when a LC error occurs. 
Inlet error browse file Allows user to browse for task files. 
Ext. device error Enables/disables running a task file when an external 

device error occurs. 
Ext. device shutdown file The task file to run when an external device error occurs. 
Ext. device browse file Allows user to browse for task files. 
Gas Threshold Invokes the Gas Threshold dialog (see Section  on page 

32)
Configure CCs Invokes the Configure Event In dialog (see Section  on 

page 31). 
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Figure 2-4  Configure Event In Dialog

This window is used to configure the Event In contact closures on the back of the MS. 
These can be used to detect errors in external devices enabling the External device error 
flag to be set. Only contact closures not used to signal the completion of an injection, or 
not used by MUX systems, are enabled. Each of the CCs available has the following 
controls. 

Gas Thresholds 

Clicking on the Gas Thresholds button displays the following dialog.

Event In Number Relates to the Event In number on the rear of the MS. 
Availability This can either be ‘Used By Inlet’ , ’Available’ , ‘Used by 

MUX’ or ‘Not Configured’. The controls are only enabled 
if the CC is ‘Available’. 

Use For Ext. Dev. Error Enables/disables the use of this contact closure to signal an 
error in an external device. 

State When in Error Determines what state the CC will be in when an error is 
present in an external device. 
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Figure 2-5  Gas Threshold Dialog

Clicking Gas Thresholds on the Configure Shutdown on Error dialog (Figure 2-3) 
invokes the Gas Threshold dialog; an MS error is flagged if the source gas flow rate falls 
below the value entered in the Low Threshold… (L/Hr) text box. 

Note: The Gas Thresholds button is only available when the MS error option is selected.

2.3.4  The Auto Control Tasks Page 

Figure 2-6  Auto Control Tasks Page

Task This is a dropdown list box with all the available tasks. 
Pre-Delay This is the length of time that will elapse before the current 

task is performed 
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To Add a Task

1. Select a task from the dropdown Task list box.
2. Enter the required parameters.
3. Press the add  button.

Note: If this is a new task timetable the task will be added to the end of the list. If a task 
has been inserted into the task timetable then all subsequent tasks will be added after the 
inserted task. To add a task to the end of the timetable after inserting a task, double click 
below the last entry in the timetable and then add the new task.

To Insert a Task

1. Click on the entry in the task timetable before which you want to insert the 
new task.

2. Select a task from the dropdown Task list box.
3. Enter the required parameters.
4. Press the add button. The task will be inserted before the selected entry.

To Modify a Task

1. Click on the entry in the task timetable. The details for the task will be 
displayed in the fields on the left of the screen.

2. Change the required parameters.
3. Press the modify  button. The details will change in the task timetable.

To Delete a Task

1. Click on the entry in the task timetable. The details for the task will be 
displayed in the fields on the left of the screen.

Post-Delay This is the length of time that will elapse after the current 
task has been completed and before the next task is started. 
E.g. a Post delay of 60s, in the Tune File task above, 
means that there will be a delay of 60 seconds before the 
next task is started, to allow the machine to stabilize with 
the new tune page settings. 

Ion Mode This is a dropdown list box with all the available ionization 
modes. 

File Name This is the name of the Tune file to be used. The file name 
can be typed in, including the full path name, or selected 
from the browser displayed when the Browse button is 
pressed. 
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2. Press the add  button. The task selected will be deleted from the task 
timetable.

To Delete All Tasks

Press the add  button. All tasks will be deleted from the task timetable.

To Change the Width of a Column

The width of the columns can be changed, by positioning the mouse pointer on 
the heading between two columns until the  symbol appears, and then click 
and drag until the column is the required width.

Saving/Loading Startup and Shutdown Files 

To Open a Startup or Shutdown file 

1. Press  or select Open from the File menu. This displays the Open file 
dialog. 

2. Select a data file and press the Open button. 

To Save a Startup or Shutdown file 

1. Press or select Save or Save As from the File menu. If this is a new file, 
or the Save As option has been selected, the Save As dialog is displayed 

2. Type a name into the File Name box and press the Save button. 

Printing Startup and Shutdown Files 

1. Press  or select Print from the File menu. This displays the Print dialog. 
2. Select the printer, print range and number of copies and press the OK button. 

Creating Startup and Shutdown Files 

Press or select New from the File menu. 

Running Startup and Shutdown Files 

If Startup or Shutdown is selected from the MassLynx Short cut bar or from the 
Shutdown editor Control List menu then the automatic startup and shutdown files 
are run. 

To Run a Different Startup or Shutdown file: - 

1. Open the required file in the Shutdown editor and press the toolbar button or 
select Run List from the Shutdown editor Control List menu. 
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2. Press the toolbar button or select Stop List from the Shutdown editor Control 
List menu if you wish to stop running this file. 

Alternatively if the Enable startup before batch or Enable shutdown after batch options are 
checked on the Shutdown Page (Section 2.3.3) the files will be run before or after a 
Sample List run.

2.3.1  Shutdown Log 

Figure 2-7  Shutdown Startup Log

Shutdown / Startup Log 

The Shutdown / Startup Log keeps a record of the most recent startups and shutdowns. 
Select Shutdown Log > Recent Shutdowns and Startups invokes the Shutdown 
Startup Log (Figure 2-7). Selecting the most Recent Shutdowns and Startups in the top 
pane will show the tasks carried out in the bottom pane. 
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Log Parameters 

Figure 2-1  Log Parameters Dialog

Selecting Shutdown Log > Log Parameters from the main menu bar invokes the 
Shutdown Log Parameters dialog. The number of startups and shutdowns recorded in the 
Startup / Shutdown Log can be altered by changing the number in the text box.
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Chapter 3
Electrospray

3.1  Introduction

Figure 3-1  Electrospray Scheme

The ESI interface consists of the standard Z-spray source fitted with an electrospray 
probe. See the following chapter for additional information concerning the optional 
nanoflow interface.

Mobile phase from the LC column or infusion pump enters through the probe and is 
pneumatically converted to an electrostatically charged aerosol spray. The solvent is 
evaporated from the spray by means of the desolvation heater. The resulting analyte and 
solvent ions are then drawn through the sample cone aperture into the ion block, from 
where they are then extracted into the analyzer.

The electrospray ionization technique allows rapid, accurate and sensitive analysis of a 
wide range of analytes from low molecular weight (less than 200 Da) polar compounds to 
biopolymers larger than 100 kDa.
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Generally, compounds of less than 1000 Da produce singly charged protonated molecules 
([M+H]+) in positive ion mode. Likewise, these low molecular weight analytes yield 
([M-H]–) ions in negative ion mode, although this is dependent upon compound structure.

High mass biopolymers, for example peptides, proteins and oligonucleotides, produce a 
series of multiply charged ions. The acquired data can be transformed by the data system 
to give a molecular weight profile of the biopolymer.

The source can be tuned to fragment ions within the ion block. This can provide valuable 
structural information for low molecular weight analytes.

The most common methods of delivering sample to the electrospray source are:

Syringe Pump and Injection Valve

A flow of mobile phase solvent passes through an injection valve to the electrospray 
source. This is continuous until the pump syringes empty and need to be refilled. Sample 
is introduced through the valve injection loop (usually 10 or 20µl capacity) switching the 
sample plug into the mobile phase flow. Tuning and acquisition are carried out as the 
sample plug enters the source. (At a flow rate of 10 µl/min a 20µl injection lasts 2 
minutes.)

Reciprocating Pump and Injection Valve

A flow of mobile phase solvent passes through an injection valve to the electrospray 
source. Sample injection and analysis procedure is the same as for the syringe pump. The 
pump reservoirs are simply topped up for continuous operation. The most suitable 
reciprocating pumps for this purpose are those which are specified to deliver a flow 
between 1 µl/min and 1 ml/min. A constant flow at such rates is more important than the 
actual flow rate. The injection valve on reciprocating pumps may be replaced by an 
autosampler for unattended, overnight operation.

Infusion Pump

The pump syringe is filled with sample in solution. The infusion pump then delivers the 
contents of the syringe to the source at a constant flow rate. This arrangement allows 
optimization and analysis while the sample flows to the source at typically 5-30 µl/min. 
Further samples require the syringe to be removed, washed, refilled with the next sample, 
and replumbed.

A 50:50 mixture of acetonitrile and water is a suitable mobile phase for the syringe pump 
system and the reciprocating pump systems. This is appropriate for positive and negative 
ion operation.
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Positive ion operation may be enhanced by 0.1 to 1% formic acid in the sample solution.

Negative ion operation may be enhanced by 0.1 to 1% ammonia in the sample solution. 
Acid should not be added in this mode.

These additives should not be used in the mobile phase for flow injection analysis (FIA) 
studies, to allow easy change over between positive and negative ion analysis.

Degassed solvents are recommended for the syringe and reciprocating pumps. Degassing 
can be achieved by sonification or helium sparging. The solvents should be filtered, and 
stored under cover at all times.

It is wise periodically to check the flow rate from the solvent delivery system. This can be 
carried out by filling a syringe barrel or a graduated glass capillary with the liquid 
emerging from the probe tip and timing a known volume, say 10µl. Once the rate has been 
measured and set, a note should be made of the back pressure readout on the pump as 
fluctuation of this reading can indicate problems with the solvent flow.

3.1.1  Post-column Splitting

Although the electrospray source can accommodate flow rates up to 1 ml/min, it is 
recommended that the flow is split post-column to approximately 200 µl/min. Also, even 
at lower flow rates, a split may be required to save valuable samples.

The post-column split consists of a zero dead-volume tee piece connected as shown in 
Figure 3-2.

The split ratio is adjusted by increasing or decreasing the back pressure created in the 
waste line, by changing either the length or the diameter of the waste tube. A UV cell may 
also be incorporated in the waste line, avoiding the requirement for in-line, low volume “Z 
cells”. As the back pressure is varied, the flow rate at the probe tip should be checked as 
described above.

These principles apply to splitting for both megaflow and normal flow electrospray.
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Figure 3-2  Post Column Split

Figure 3-3  Comparison of Normal and Megaflow Electrospray
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3.1.2  Megaflow

Megaflow electrospray (Figure 3-3) enables flow rates from 200 µl/min to 1 ml/min to be 
accommodated. This allows microbore (2.1mm) or 4.6mm diameter columns to be 
interfaced without splitting.

Changing Between Flow Modes

When changing between megaflow and standard electrospray operation, it is essential that 
the correct tubing is used to connect the probe to the sample injector. For megaflow 
operation 1/16" o.d., 0.007" i.d. peek tubing, easily identified by its yellow stripe, is used. 
This replaces the standard fused silica tube, together with the PTFE sleeves.

3.2  Operation

Figure 3-4  ESI Source

Caution: Operating the source without the source enclosure will result 
in solvent vapor escape and the exposure of hot surfaces and high 
voltages.
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Ensure that the source is assembled as described in Maintenance and Fault Finding, and 
that the instrument is pumped down and prepared for electrospray operation as 
described in Routine Procedures.

Ensure that a supply of nitrogen has been connected to the gas inlet at the rear of the 
instrument and that the head pressure is between 6 and 7 bar (90-100 psi).

Ensure that the exhaust liner and the cleanable baffle are fitted to the source.

This is important for optimum electrospray intensity and stability when operating at low 
flow rates.

Checking the ESI Probe

1. Connect the electrospray probe to a pulse free pump.
2. Solvent should be degassed to prevent beam instabilities caused by bubbles.
3. Connect the PTFE tubing of the electrospray probe to Nebuliser Gas on the front 

panel. Secure with the nut provided.
4. With the probe removed from the source turn on the liquid flow at 10 µl/min and 

check that liquid flow is observed at the tip of the capillary.
5. To avoid unwanted capillary action effects, do not allow liquid to flow to the probe 

for long periods without the nitrogen switched on.
6. Turn on Nitrogen by selecting API Gas, and check that a nebuliser flow of less than 

100 litres/hour is registered.
7. To monitor the flow rate, select Window then Gas Flow on the tune page and 

observe the readback window.
8. Check that there is gas flow at the probe tip and ensure that there is no significant 

leakage of nitrogen elsewhere.
9. Adjust the probe tip to ensure complete nebulization of the liquid.
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There should be approximately 0.5 mm of sample capillary protruding from the nebulizing 
capillary (Figure 3-5).

Figure 3-5  Electrospray Tip

The tip of the electrospray probe can influence the intensity and stability of the ion beam. 
A damaged or incorrectly adjusted probe tip will lead to poor electrospray performance.

10. Using a magnifying glass ensure that both inner and outer stainless steel capillaries 
are straight and circular in cross-section.

11. Ensure that the inner stainless steel capillary is coaxial to the outer capillary.

If the two capillaries are not coaxial, it is possible to bend the outer capillary slightly using 
thumbnail pressure.

12. Insert the probe into the source and tighten the two thumb screws.
13. Plug the probe high voltage cable into Capillary / Corona on the front panel.

Obtaining an Ion Beam

1. If necessary, change the ionization mode using the Ion Mode command.
2. Using the needle valve on the front panel, set the desolvation gas flow rate to 

300 litres/hour.
3. Turn on the liquid flow at 10 µl/min and set Desolvation Temp to 100°C.
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Tuning and Optimization

The following parameters, after initial tuning, should be optimized using a sample 
representative of the analyte to be studied. It will usually be found, with the exception of 
the sample cone voltage, that settings will vary little from one analyte to another.

Probe Position

Figure 3-6  Optimum Probe Position

The position of the probe (Figure 3-6) is adjusted using the probe adjustment collar (in and 
out) and the adjustment knob (sideways) located to the left of the probe (Figure 3-7). The 
two screws can be adjusted singly or simultaneously to optimize the beam. The position 
for optimum sensitivity and stability for low flow rate work (10 µl/min) is shown.

Figure 3-7  Probe Adjustment
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Small improvements may be gained by varying the position using the sample and solvent 
system under investigation. The following information should be considered when setting 
the probe position:

• 10 mm of movement is provided in each direction, with 1.25mm of travel per 
revolution of the probe positioning controls.

• At higher liquid flow rates the probe tip should be positioned further away from the 
sample cone to achieve optimum stability and sensitivity. The position is less critical 
than at lower flow rates.

Nebuliser Gas

Optimum nebulization for electrospray performance is achieved with a nitrogen flow 
between 70 and 90 litres per hour. This can be achieved by fully opening the Nebuliser 
flow control valve, which is situated on the instrument’s front panel.

Desolvation Gas

The desolvation gas, also nitrogen, is heated and delivered as a coaxial sheath to the 
nebulized liquid spray by the desolvation nozzle.

Note: The position of the desolvation nozzle heater is fixed relative to the probe tip and 
requires no adjustment.

The Desolvation Gas flow rate is adjusted by the control value situated on the 
instrument’s front panel. The optimum Desolvation Temp and flow rate is dependent on 
mobile phase composition and flow rate. A guide to suitable settings is given below.

The Desolvation Gas flow rate indicated on the MassLynx tune page represents total 
drying flow, that is desolvation gas + cone gas (nanoflow only) + purge gas (if enabled).

Solvent Flow Rate
µl/min

Desolvation Temp 
OC

Desolvation Gas Flow Rate
Litres/hour

<10 100 - 120 200 - 250
10 - 20 120 - 250 200 - 400
20 - 50 250 - 350 200 - 400

>50 350 - 400 500 - 750
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Higher desolvation temperatures give increased sensitivity. However increasing the 
temperature above the range suggested reduces beam stability. Increasing the gas flow rate 
higher than the quoted values leads to unnecessarily high nitrogen consumption.

Cone Gas

The cone gas reduces the intensity of solvent cluster ions and solvent adduct ions. The 
cone gas flow rate should be optimized by increasing until solvent cluster ions and / or 
adduct ions are reduced as much as possible without diminishing the intensity of the ion of 
interest, normally (M+H)+.

Typical cone gas flow rates are in the range 100 to 300 litres per hour.

Purge Gas

The purge gas is not necessary for most ESI applications. It may be useful for megaflow 
operation where an analyte is susceptible to acetonitrile adducting.

Purge gas is enabled simply by removing the blanking plug from the outlet situated within 
the source enclosure. 

Purge gas flow rate is a constant fraction (30%) of the total desolvation gas flow.

Source temperature

100°C is typical for 50:50 CH3CN:H2O at solvent flow rates up to 50 µl/min. Higher 
source temperatures, up to 150°C, are necessary for solvents at higher flow rates and 
higher water content.

Capillary Voltage

Capillary usually optimizes at 3.0kV, although some samples may tune at values above or 
below this, within the range 2.5 - 4.0kV for positive electrospray. For negative ion 
operation a lower voltage is necessary, typically between 2.0 - 3.5kV.

At high flow rates this parameter may optimize at a value as low as 1kV.

Attention: Do not operate the desolvation heater for long periods of time without a gas 
flow. To do so could damage the source.

Attention: The maximum operating temperature for the source heater is 150°C. Do not 
set Source Temp higher than 150°C
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Sample Cone Voltage

A Cone setting between 25V and 70V will produce ions for most samples, although 
solvent ions prefer the lower end and proteins the higher end of this range. Whenever 
sample quantity and time permit, Cone should be optimized for maximum sensitivity, 
within the range 15V to 150V. Increasing Cone will increase ion fragmentation within the 
source.

Extraction Cone Voltage

Extractor optimizes at 0 - 5V. Higher values may induce ion fragmentation of low 
molecular weight samples.

3.2.3  Megaflow Hints

With this high flow rate technique the setup procedure involves making the following 
adjustments:

• Increase Desolvation Gas flow to 500 litres/hour.
• Increase Desolvation Temp to 400°C.
• Increase Source Block Temp to 150°C.
• Move the probe further away from the sample cone.

Note: When changing from electrospray to megaflow operation it is not necessary to 
adjust any source voltages.

Cluster ions are rarely observed with Z-spray. However solvent droplets may form within 
the source enclosure if the source and desolvation temperatures are too low.

Refer to the previous section on operating parameters for typical desolvation gas flow 
rates.

Purge gas can be used during megaflow operation to stop the source enclosure from 
overheating. This is also beneficial when the analyte is susceptible to acetonitrile 
adducting. Purge gas is enabled by removing the blanking plug from the outlet situated 
within the source enclosure.

Attention: The maximum operating temperature for the source heater is 150°C. Do not 
set Source Block Temp higher than 150°C.
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If the sample is contained within a 'dirty matrix' the probe may be moved away from the 
sample cone to extend time between source cleaning operations. This may incur a small 
loss in sensitivity.

The source enclosure will run cooler if purge gas is used.

3.2.4  Removing the Probe

To remove the probe from the source proceed as follows:

1. On the tune page deselect Operate to put the instrument into standby mode.
2. Switch off the liquid flow and disconnect from the probe.
3. Deselect API Gas and turn off Nitrogen.
4. Disconnect the probe cable from the instrument.
5. Disconnect the nebulizing gas supply from the instrument.

3.3  Sample Analysis and Calibration

3.3.5  General Information

Care should be taken to ensure that samples are fully dissolved in a suitable solvent. Any 
particulates must be filtered to avoid blockage of the transfer line or the probe’s capillary. 
A centrifuge can often be used to separate solid particles from the sample liquid.

Caution: It is normal for the source enclosure, the glass tube and parts of the probe 
mounting flange, to get hot during prolonged megaflow operation. Care should be taken 
when handling source components during and immediately after operation.

Attention: For health and safety reasons always ensure the exhaust line is vented 
outside the building or to a fume hood.

Attention: Ensure that a plastic bottle is connected in the exhaust line to collect any 
condensed solvents.
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There is usually no benefit in using concentrations greater than 20 pmol/µl for 
biopolymers or 10 ng/µl for low molecular weight compounds.

Higher concentrations will not usually improve analytical performance. Conversely, for 
biopolymers, lower concentrations often yield better electrospray results. Higher levels 
require more frequent source cleaning and risk blocking the transfer capillary.

Optimization for low molecular weight compounds may usually be achieved using a 
concentration of 1ng/µl.

Samples with phosphate buffers and high levels of salts should be avoided. Alternatively, 
at the expense of a small drop in sensitivity, the probe can be pulled away from the sample 
cone to minimize the deposit of involatile material on the cone.

To gain experience in sample analysis, it is advisable to start with the qualitative analysis 
of known standards. A good example of a high molecular weight sample is horse heart 
myoglobin (molecular weight 16951.48) which produces a series of multiply charged ions 
that can be used to calibrate the m scale from 800-1600 in either positive ion or negative 
ion mode. 

Polyethylene glycol mixtures, for example 300 / 600 / 1000, are low molecular weight 
samples suitable for calibrating the m scale from approximately 100 to 1200 in positive 
ion mode. A mixture of sugars covers the same range in negative ion mode.

Alternatively, sodium iodide or caesium iodide can be used for calibration.
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Typical ES Positive Ion Samples

• Peptides and proteins.
• Small polar compounds.
• Drugs and their metabolites.
• Environmental contaminants (e.g. pesticides, pollutants).
• Dye compounds.
• Some organometallics.
• Small saccharides.

Typical ES Negative Ion Samples

• Some proteins.
• Some drug metabolites (e.g. glucuronide conjugates).
• Oligonucleotides.
• Some saccharides and polysaccharides.

3.4  Chromatographic Interfacing

Electrospray ionization can be routinely interfaced to reversed phase and normal phase 
chromatographic separations. Depending on the LC pumping system, chromatography 
column and setup, there are some basic options:

• Microbore and capillary chromatography separations employing 1mm diameter (and 
smaller) columns can be interfaced directly to the electrospray probe. Typical flow 
rates for such columns may be in the region of 3-50 µl/min. It is suggested that a 
syringe pump is used to deliver these constant low flow rates through a capillary 
column. Alternatively, accurate pre-column splitting of higher flow rates from 
reciprocating pumps can be investigated.
In all cases, efficient solvent mixing is necessary for gradient elution separations. 
This is of paramount importance with regard to low flow rates encountered with 
capillary columns. HPLC pump manufacturers’ recommendations should be heeded.

• 2.1mm diameter reversed phase columns are gaining popularity for many separations 
previously addressed by 4.6mm columns. Typically flow rates of 200 µl/min are 
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used, allowing direct coupling to the electrospray source. The increased sample flow 
rate requires increased source temperature and drying gas flow rate.
A UV detector may be placed in-line to the probe, provided that the volume of the 
detector does not significantly reduce the chromatographic resolution. Whenever a 
UV detector is used, the analog output may be input to MassLynx NT for 
chromatographic processing.

• The interfacing of 4.6mm columns to the electrospray source can be achieved either 
by flow splitting or by direct coupling. In both cases an elevated source temperature 
and drying gas flow rate are required. In general, the best results are obtained by 
splitting after the column using a zero dead volume tee piece so that 200-300 µl/min 
is transferred to the source.

Conventional reverse phase and normal phase solvent systems are appropriate for 
LC-electrospray.

Involatile buffers may be used but prolonged periods of operation are not recommended. 
When using involatile buffers the probe should be moved as far away from the sample 
cone as possible. This may reduce sensitivity slightly, but will reduce the rate at which 
involatile material will be deposited on the sample cone.

Trifluoroacetic acid (TFA) and triethylamine (TEA) may be used up to a level of 0.05%. If 
solvents of high aqueous content are to be used then tuning conditions should be 
appropriate for the solvent composition entering the source.

Higher source temperatures (150°C) are also recommended for high aqueous content 
solvents. Tetrahydrofuran (THF) should not be used with peek tubing.

3.4.1  LC-MS Sensitivity Enhancement

The sensitivity of a LC-MS analysis can be increased or optimized in a number of ways, 
by alterations to both the LC operation and the MS operation.

In the LC area some examples include the use of high resolution columns and columns 
with fully end capped pickings. For target compound analysis, techniques such as trace 
enrichment, coupled column chromatography, or phase system switching can have 
enormous benefits.

Attention: The maximum operating temperature for the source heater is 150°C. Do not 
set Source Block Temp higher than 150°C.
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Careful choice of the solvent, and solvent additives or modifiers, may also prove 
important.
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Chapter 4
Nanoflow Electrospray

Figure 4-1  The Nanoflow Interface

The optional nanoflow interface allows electrospray ionization to be performed in the flow 
rate range 5 to 1000 nl/min. There are two options for the spraying capillary, which can be 
alternately fitted to the interface:

• Borosilicate metal coated glass capillary.

Metal coated glass capillaries allow the lowest flow rates to be obtained although they are 
used for one sample only and must then be discarded.

• Nano-LC.
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This option is suitable for flow injection analyses or for coupling to nano-HPLC, and uses a 
pump to regulate the flow rate down to 100 nl/min. If a syringe pump is to be used, a 
gas-tight syringe is necessary to obtain correct flow rates without leakage. A volume of 
25µl is recommended.

Figure 4-2  Nanoflow Electrospray Scheme

For a given sample concentration, the ion currents observed in nanoflow are comparable 
to those seen in normal flow rate electrospray. Great sensitivity gains are therefore 
observed when similar scan parameters are used, due to the great reductions in sample 
consumption.

The nanoflow end flange consists of a three-axis manipulator, a stage, a protective cover 
and a stop / handle arrangement for rotation of the manipulator and stage.

The manipulator and stage are rotated by 90 degrees to change option or, in the glass 
capillary option, to load a new nanovial.

Attention: Failure to use the stop and handle to rotate the stage can result in permanent 
damage to the three-axis manipulator.

Exhaust

Exhaust 
Liner

Turbom olecular
PumpsRotary Pump

Cone Gas

Purge Gas

Analyser

S a m p le  
C o n e

Extraction
C o n e

Isolation 
Valve

Source 
Enclosure

RF
Lens

Cleanable
Baffle 

Sample
Capillary
56 Nanoflow Electrospray



4

Qtof Micro.book  Page 57  Thursday, December 19, 2002  3:39 PM
4.1  Installing the Interface

To change from the normal electrospray interface and install the nanoflow interface:

1. If fitted, remove the probe.
2. Remove the moulded cover from around the source.
3. Undo the three thumb screws and withdraw the probe adjustment flange 

assembly and glass tube.
4. Place the glass tube, end on, on a flat surface and place the probe support 

flange assembly on top of the glass tube.
5. Remove the PTFE encapsulated source O ring.

Figure 4-3  Electrospray Source Being Removed

6. Unscrew the three probe flange mounting pillars, using the holes to obtain 
the necessary leverage.

Caution: When the source enclosure has been removed the ion block heater is exposed. 
Ensure that the source block heater has been switched off and has cooled before 
proceeding. Observe the Source Block Temp readback on the Tune Page
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7. If the cone gas nozzle is not in place, close the sample cone isolation valve. 
Remove the two screws that secure the sample cone and fit the cone gas 
nozzle.

8. Replace the two screws.
9. Connect the cone gas outlet to the cone gas nozzle using the PTFE tubing 

provided (Figure 4-4). Open the sample cone isolation valve.

Figure 4-4  Nanoflow Source Without Cover

The cone gas flow rate is set at 30% of the total desolvation gas flow.

10. Ensure that the purge gas is plugged (disabled).
11. Ensure that the cleanable baffle, the exhaust liner and the corona discharge 

pin blanking plug are fitted.
12. Fit a viton O ring and the three shorter nanoflow pillars.
13. Install the perspex cover and the nanoflow end flange, securing this with 

socket head screws.
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Figure 4-5  Nanoflow Source with Cover and End Flange

Do not attempt to refit the moulded cover.

14. If not already in place, attach the microscope or camera brackets using the 
screw hole and dowels at the top of the bracket.

15. Insert the flexible light guide into the grommet at the base of the perspex 
cover.

16. Set the light source to its brightest.
17. Block the Desolvation Gas outlet on the instrument's front panel.
18. Close the nebuliser needle valve.

The cone gas is split from the desolvation gas internally.

19. Attach the two cables to the sockets marked Capillary / Corona and Probes 
on the front panel of the instrument.

20. Set Source Block Temp to approximately 80°C.

Attention: The maximum operating temperature for the source heater is 150°C. Do not 
set Source Block Temp higher than 150°C.
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4.1.1  Operation of the Camera System

Figure 4-6  Nanoflow Camera and Microscope System

Magnification is controlled by the zoom lens. A fine focus can be achieved by rotating the 
objective lens.

Using the Microscope

Focusing is adjusted by rotating the top of the microscope.

M icroscope

Cam era

Zoom
Lens

Objective
Lens

Grom m et
60 Nanoflow Electrospray



4

Qtof Micro.book  Page 61  Thursday, December 19, 2002  3:39 PM
4.1.2  Glass Capillary Option

Installation 

1. With the stage rotated outwards, unscrew the union from the end of the assembly.
2. Carefully remove the capillary from its case by lifting vertically while pressing 

down on the foam with two fingers.
3. Over the blunt end of the capillary, pass the knurled nut, approximately 5mm of 

conductive elastomer and finally the union.
4. Tighten the nut (finger tight is sufficient) so that 5mm of glass capillary is 

protruding from the end of it. This distance is measured from the end of the nut to 
the shoulder of the glass capillary.

5. Load sample into the capillary using either a fused silica syringe needle or a 
GELoader tip.

6. Screw the holder back into the assembly - finger tight is sufficient.
7. Ensure that Capillary is set to 0V on the tune page.
8. Rotate the stage back into the interface using the stop and handle.

When using a GELoader tip, break the nanovial in half, by scoring with a fused silica 
cutter. This enables the GELoader to reach the tip of the nanovial

Nanovial Tip Position

The position of the nanovial is adjusted as shown (Figure 4-7). The tip is in line with the 
centre of the sample cone, at a distance between two and three times the diameter of the 
cone orifice, as observed through the microscope.

Caution: Do not touch the sharp end of the capillary. As well as the risk of injury by a 
sliver of glass, the capillary may contain toxic sample.s

Caution: The capillaries are extremely fragile and must be handled with great care. 
Always handle using the square end of the capillary. The needle may become inoperable 
if the sharp end is touched.
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Figure 4-7  Nanovial Tip Position

Operation

Manoeuvre the stage so that the microscope or camera can view the capillary tip.

Using the nanoflow regulator, apply pressure to the back of the tip until a drop of liquid is 
seen.

On the tune page, select APIGas to turn on Nitrogen.

Select Operate.

Set Capillary between 600 and 1.0kV.

Adjust Desolvation Gas flow to 100 litres/hour using the knob on the front panel of the 
instrument.

An ion beam should now be visible on the tune page.

Tune the source voltages, adjust the gas flow and adjust the three-axis manipulator for 
maximum ion current.

The ion current may change dramatically with very slight changes of position but the high 
resolution of the threads in the manipulator allows very fine tuning.

Restarting the Spray

Should the spray stop, it is possible to restart it by adjusting the three-axis manipulator so 
that, viewed under magnification, the capillary tip touches the sample cone and a small 
piece of the glass hair shears off. Set the capillary to zero when doing this.
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It may also be necessary to apply some back pressure to the holder to force a drop of liquid 
from the capillary. Up to 1.4 bar (20 psi) can be applied and, with this pressure, a drop 
should be visible unless the capillary is blocked.

4.2  Nano-LC Option

4.2.1  Installation

With the sprayer assembly removed from the stage and with refrence to Figure 4-8:

1. Cut approximately 25mm of the red stripe peek tubing and, using the plug cap and a 
Valco nut, set a ferrule to the correct position on the tubing.

At this stage the ferrule is required only to grip the tubing lightly, and should not be too 
tight.

2. Cut the peek such that 10mm of the peek protrudes from the back of the ferrule.
3. Thread approximately 70mm of the 90 micron o.d. fused silica through the new 

fitting.
4. Ensure that the fused silica is flush with the peek sleeve.
5. Again using the plug cap, tighten the nut further to ensure that the fused silica is 

gripped. Some force may be required to do this.
6. Remove the sleeved fused silica from the plug cap and remove the Valco nut.
7. Place an O ring onto the peek tube, using tweezers if necessary.

The O ring is required to seal the region between the ferrule and the end of the thread on 
the nano-LC chamber.

8. Thread the sleeved fused silica through the nano-LC chamber.
9. Rotate the microvolume union in the body such that the ferrule seat is aligned 

correctly.
10. Insert the chamber into the nano-LC body and tighten using a pair of spanners.

The capillary can now be checked for flow by connecting the output from a Harvard 
syringe pump to the other side of the union and setting the flow to 1 µL/min, using a 
micropipette to measure the flow. It is recommended that a syringe with a volume of no 
more than 50 millilitres is used.
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Figure 4-8  Nano-LC Assembly

11. Thread the fused silica through the nebulizing tip and screw in the nano-LC 
chamber such that it is screwed in approximately half way.

12. Cut the fused silica using a tile cutter and adjust the nebulizing tip further, such that 
1mm of fused silica protrudes from the tip.

13. Attach the nebulizing gas tubing to the sprayer using an O ring and the special 
screw.

14. Attach the sprayer assembly to the stage.
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It may be necessary to alter the position of the thumbscrew underneath the baseplate to 
attach the sprayer correctly.

15. Swing the stage into the interface using the stop and handle.

4.2.2  Operation

For tuning purposes it may be useful to infuse a known sample in 95% water using a 
Harvard syringe pump. 

1. Set the liquid flow to about 200 nl/min.
2. Switch on Gas at the MassLynx tune page.
3. Set the pressure of the gas on the regulator to approximately 0.5 bar (7 psi).
4. Ensure there are no leaks of gas at the sprayer, particularly where the PTFE tubing is 

connected to it.

Note: By viewing under magnification, the spray emanating from the capillary may be 
examined and tuned by altering the nebulizing tip such that a fine spray is observed. 
Altering the gas slightly may also help in this tuning process.

5. Swing the stage back out of the source and place the cover over the sprayer ensuring 
that the tubing coming from the sprayer is threaded correctly through it.

6. Lock the cover in place with two screws.
7. Swing the stage back into the source and alter the translation stage (in / out 

direction) such that the capillary is approximately 5mm from the cone.
8. Select Operate and set Capillary to approximately 2.5kV.

An ion beam should now be present.

9. Optimize the ion beam by altering the position of the spray using the controls of the 
translation stage.

10. The sprayer can now be connected to the HPLC system. The injection valve is 
plumbed as follows:

• P from the pump.
• C to the column (or to the union).
• S is the sample port, attach a VISF sleeve here.
• W is a waste port.

Note: A short tail of fused silica, attached to the entrance port of the union, and the use of 
low pressure PTFE connectors will remove the need to move the stage. This will prevent 
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accidental alteration of the sprayer's position when changing between tuning and HPLC 
operation.

4.3  Changing Options

To change between the glass capillary and the nano-LC options:

Rotate the stage outwards.: 

Remove the protective cover and release the captive screw located underneath 
the stage.
Lift off the holder and replace it with the alternative holder, securing it with the 
captive screw.
Replace the protective cover, ensuring that either the PTFE back pressure tubing 
(glass capillary option) or the fused silica transfer line is fed through the slot in 
the back of the protective cover along with the HV cabling.

Attention: Failure to use the stop and handle to rotate the stage can result in permanent 
damage to the three-axis manipulator.
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Chapter 5
APcI

Atmospheric Pressure Chemical Ionization (APcI) is an easy to use LC-MS interface that 
produces singly-charged protonated or deprotonated molecules for a broad range of 
involatile analytes.

Figure 5-1  Schematic Representation of APcI

The ability to operate with 100% organic or 100% aqueous mobile phases at flow rates up 
to 2 ml/min makes APcI an ideal technique for standard analytical column (4.6 mm i.d.) 
normal phase and reverse phase LC-MS.

The APcI interface consists of the standard Z-spray source fitted with a corona discharge 
pin and a heated nebuliser probe. Mobile phase from the LC column enters the probe 
where it is pneumatically converted into an aerosol and is rapidly heated and converted to 
a vapor / gas at the probe tip. Hot gas from the probe passes between the sample cone and 
the corona discharge pin, which is typically maintained at 2.5kV. Mobile phase molecules 
rapidly react with ions generated by the corona discharge to produce stable reagents ions. 
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Analyte molecules introduced into the mobile phase react with the reagent ions at 
atmospheric pressure and typically become protonated (in positive ion mode) or 
deprotonated (in the negative ion mode). The sample and reagent ions pass through the 
sample cone into the ion block prior to being extracted via the extraction cone into the RF 
lens.

Changeover between electrospray and APcI operation is simply accomplished by 
changing the probe and installing the corona discharge pin within the source enclosure.

For APcI operation, the desolvation gas is not heated in the desolvation nozzle. However, 
it is important that desolvation gas is used throughout.

The background spectrum for 50:50 acetonitrile:water is dependent upon the settings of 
Cone and Extractor. The main reagent ions for typical sample cone and extraction cone 
voltages of 40V and 10V respectively are 42, 56, 83 and 101.

The transmission of these ions will be dependent on the setting of RF Lens. A lower RF 
Lens voltage is required for optimum transmission at lower m.

Acetonitrile adducting may be minimized by optimization of the probe position, as 
described in the chapter entitled Electrospray.

5.1  Preparation

Ensure that the source is assembled as described in Maintenance and Fault Finding, and 
that the instrument is pumped down and prepared for APcI operation as described in 
Routine Procedures.

APcI may be operated with or without the cleanable baffle fitted.

Ensure that a supply of nitrogen has been connected to the gas inlet at the rear of the 
instrument and that the head pressure is between 6 and 7 bar (90-100 psi).

5.1.1  Checking the Probe

1. Ensure that the probe heater is off.
2. Unplug the probe from the instrument’s front panel and remove the probe from the 

source.
3. Connect the PTFE tube to the Nebuliser Gas outlet on the front panel.
4. Remove the probe tip assembly by carefully loosening the two grub screws.
68 APcI



5

Qtof Micro.book  Page 69  Thursday, December 19, 2002  3:39 PM
5. Disconnect the heater from the probe body by pulling parallel to the axis of the 
probe.

6. Ensure that 0.5 to 1 mm of fused silica is protruding from the stainless steel 
nebuliser tube.

7. Connect the LC pump to the probe with a flow of 50:50 acetonitrile:water at 1 
ml/min.

8. Check that the liquid jet flows freely from the end of the capillary and that the LC 
pump back pressure reads 250 to 400 psi.

9. Check that the nitrogen supply pressure is 6 to 7 bar (90 to 100 psi).
10. Select API Gas and turn on Nitrogen.
11. Check that the liquid jet converts to a fine uniform aerosol.
12. Switch off the liquid flow.
13. Deselect API Gas and turn off Nitrogen.
14. Reconnect the probe tip assembly.
15. Insert the APcI probe into the source and secure it by tightening the two thumb 

screws.
16. Connect the probe cable to Probes on the instrument's front panel.

5.2  Obtaining an Ion Beam

1. Ensure that the corona discharge pin is fitted as described in Section 2.2.2 on page 
26 and that the pin is connected using the APcI HV cable.

2. Ensure that the APcI probe is fitted as described above, that the desolvation gas tube 
is connected to the front panel, and that the cone gas and purge gas outlets are 
plugged.

3. If necessary, change the ionization mode using the Ion Mode command.
4. Set Source Block Temp to 150°C.

5. Set APcI Probe Temp to 20°C with no liquid flow and Nitrogen off.
6. Initially set Corona to 2.5kV and Cone to 30V.

Attention: The maximum operating temperature for the source heater is 150°C. Do not 
set Source Block Temp higher than 150°C
Obtaining an Ion Beam 69



5

Qtof Micro.book  Page 70  Thursday, December 19, 2002  3:39 PM
When Source Block Temp reaches 150°C:

1. Select API Gas to switch on the nitrogen gas.
2. Using the valves on the front of the instrument, adjust Desolvation Gas to 150 

litres/hour and set Nebuliser Gas to its maximum setting.
3. Set one of the peak display boxes to show masses down to at least 100 Da.
4. Select Operate.
5. Set APcI Probe Temp to 350°C.

When APcI Probe Temp reaches 350°C:

1. Start the LC pump at a flow of 1 ml/min.
2. Optimize Corona so that the peaks reach maximum intensity.
3. Optimize the probe position for intensity and stability.

The two screws can be adjusted singly or simultaneously to optimize the beam.

Figure 5-2  Illustration of Probe Adjustment

The position of the probe will affect sensitivity. However, if the sample is contained in a 
‘biological matrix’ or is contained in an involatile solvent the probe should be moved away 
from the sample cone and towards the corona discharge pin
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. 

5.3  Hints for Sample Analysis

Tuning

• Start by tuning on the solvent ions.
• It is generally found that the most significant analyte tuning parameter to adjust 

following tuning on the solvent ions is Cone.
• Fine tuning on the analyte of interest can be performed either by large loop injections 

(100µl) or by constant infusion in the mobile phase typically at analyte 
concentrations of a few ng/µl.

• 10µl loop injections can be monitored using real time chromatogram updates.

Mobile Phase

• The choice of mobile phase is an important compound specific factor in APcI. For 
example, steroids prefer methanol:water mixtures as opposed to acetonitrile:water.

• Analyte sensitivity is also dependent on mobile phase composition, which can be 
varied from 100% aqueous to 100% organic for any particular mixture.

Probe Temperature

This can be a critical factor for some analytes.

Caution: It is normal for the source enclosure, the glass tube and parts of the probe 
adjustment flange to reach temperatures of up to 60°C during prolonged APcI operation. 
Care should be exercised when handling source components immediately after 
operation.

Caution: Switch off the liquid flow and allow the probe to cool (<100°C) before removing 
it from the source.

Attention: Failure to employ a desolvation gas flow during APcI operation may lead to 
heat damage to the source.
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• Involatile samples (for example steroids) generally require high probe temperatures 
(>400°C).

• Volatile samples (for example pesticides) can be analyzed with low probe 
temperatures (<400°C).

• In some cases, too high a probe temperature can lead to thermal degradation of labile 
samples.

Desolvation Gas

Although a Desolvation Gas flow of approximately 150 litres/hour is typical for most 
samples, this flow rate should be tuned for maximum sensitivity while ensuring that the 
flow rate is not decreased below 100 litres/hour.

5.4  Removing the Probe

Figure 5-3  APcI Probe showing twin Thumb Nuts used for Removal

After a session of APcI operation:

Turn off the LC flow.

Set APcI Probe Temp to 20°C.

Deselect Operate to put the instrument in standby mode.

When the probe temperature falls below 100°C:
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Deselect API Gas and turn off Nitrogen.

Undo the two thumb nuts and remove the probe from the source (Figure 5-3).  

If the instrument is not to be used for a long period of time the source temperature should 
be reduced to 60°C.

Caution: Take care when removing the APcI probe. There is a risk of burns to the 
operator.

Attention: Removal of the APcI probe when hot will shorten the life of the probe heater.
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Chapter 6
Tuning

Before sample data are acquired, the instrument should be tuned and, for highest mass 
accuracy, calibrated using a suitable reference compound (see Chapter 7).

Consult the relevant sections of this manual for information concerning source tuning 
procedures in the chosen mode of operation. See:

• Chapter 3, Electrospray
• Chapter 4, Nanoflow Electrospray
• Chapter 5, APcI

For information on optimizing peak shape, intensity and resolution and adjusting the 
tuning parameters see the following sections:

• Section 6.2.4, Source Tuning Page
• Section 6.2.5, Quadrupole Tuning Page (Analyzer)
• Section 6.2.6, Time Of Flight Page 
• Section 6.3, Obtaining an Ion Beam

Note: Care should be taken to optimize the value of the collision energy. 

6.1  Tuning

The preceding sections have outlined the software controls and connections to establish 
the physical conditions required as a prerequisite to mass spectrometer operation. 

Within the source and analyzer enclosures, electric fields controlled via MassLynx are 
applied to the components to manage the ion beam generated, according to the sample to 
be analyzed, the ionization mode and the type of information required. The ion optical 
system elements are indicated in Figure 6-1 on page 76.

Considering the variable nature of the beam with different samples, the instrument should 
be tuned for signal strength and calibrated for accurate m using suitable reference 
compounds, prior to the acquisition of sample data. 
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Figure 6-1  The Ion Optical System of the Q-Tof micro

Tuning parameters have been grouped in MassLynx into 3 pages as inSection 6.3 on page 
89. Full details of source tuning procedures for electrospray, APcI and nanoflow 
electrospray are given in the relevant chapter of this manual.
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6.2  Tune Page 

Figure 6-2  The QTof micro Tune Page

The Tune Page Consists of a peak display window and 3 pages of parameters viewable by 
selecting the relevant tab. These are:

• The Source Page (see Section 6.2.4)
• The Quadrupole Page (see Section 6.2.5)
• The time of Flight Page (see Section 6.2.6)

6.2.1  Tune Page Basics

To Display the Tune Page:

Select MS Tune from the Masslynx Shortcut bar (Figure 6-2).
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Printing Tune Information

To print a report, containing a copy of the tune peak information displayed on the screen 
along with a record of each parameter setting:

Press , or select Print from the Tune Page File menu.

This report is not configurable by the user.

Experimental Record

Tuning parameters are stored with every data file as part of the experimental record. The 
tuning parameters for a particular data file can be viewed or printed from the data browser, 
see the MassLynx User Guide, Selecting and Viewing Data, for more information.

6.2.2  Saving and Restoring Parameter Settings

Whole sets of instrument tuning parameters can be saved to disk as a named file and then 
recalled at a future date.

A tune parameter file contains the latest settings for the source controls for all supported 
ionization modes not just the ionization mode currently selected. Tune parameter files also 
contain settings for the analyzer, inlet set points and peak display.

To save the current tune parameters with the existing file name:

1. Press , or choose Save from the tune page File menu.
2. Press Save.

To save the current tune parameters with a new file name:

1. Select Save As from the tune page File menu.
2. Enter a new file name or select an existing file from the list displayed.
3. Press Save.

If the selected file already exists on disk a warning is displayed. Press Yes to overwrite the 
existing information or No to enter a different file name.

To restore a saved set of parameters:

1. Press , or choose Open from the tune page File menu.
2. Select the required tuning parameter file, either by typing its name or by selecting 

from the list displayed.
3. Press Open.
78 Tuning



6

Qtof Micro.book  Page 79  Thursday, December 19, 2002  3:39 PM
6.2.3  Changing the Peak Display

To change the display using the mouse:

Figure 6-3  The Customize Display Menu

Click in the peak display area with the right mouse button to display the pop up 
menu (Figure 6-3).

The display area for each peak can be individually changed, e.g. the peak color for peak 1 
can be red and for peak 2 green etc.

Customize Plot Appearance

To change the color of the background and traces and to change the number of traces 
displayed:

Figure 6-4  The Customise Plot Appearance Dialog
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Select Customize, Plot Appearance.

The Customize Plot Appearance dialog is displayed (Figure 6-4).

To change the colours on the display:

Press Newest Trace, Background or Trace Fill and select a new color from the 
dialog displayed.

To change the number of traces:

Use to change the number, or enter a new value in the Visible Traces box, within 
the range 2 to 20.

If more than one trace is displayed then the older traces can be displayed in a different 
shade to the new ones:

Drag the Color Interpolation slider toward the full position. The color of the old 
traces is shown in the Trace color sample (new->old) field.

Trace

From the pop-up menu do one of the following:

• Select the Trace, Outline option to display the peak outline only.
• Select the Trace, Fill option to fill the trace with the trace fill color.
• Select the Trace, Min/Max option to show the minimum and maximum data points 

only.

The option selected has a tick next to it.

Intensity

Select either Intensity, Relative Intensity or Intensity, Absolute Intensity as 
required.
Select Intensity, Normalize Data to display normalized data.
The options selected each have a tick next to them.

Grid

The options allow vertical and horizontal grid lines to be independently displayed or 
hidden.

Selected Options have ticks next to them. Selecting and option a second time deselects the 
option.
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6.2.4  Source Tuning Page

The main parameters that are changed during tuning can be found on this page. The two 
that have the most effect are the Capillary Voltage and Sample Cone Voltage.

Figure 6-5  The Source Tuning Page

The positive ion electrospray (ESP+) Source Tuning page is shown. Suggested tuning 
parameters are as follows:
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Capillary This sets the absolute voltage on the electrospray probe or 
APCI corona needle, and is typically adjusted to 3000V. The 
value shown in the display is for illustration only.

Sample Cone This sets the voltage on the sampling cone relative to the extrac-
tion lens. It is dependent on compound and charge state. For 
multiply charged species this is set to 30 - 50eV, and higher for 
singly charged species. In general, higher cone voltages are 
needed for larger mass ions.

Extraction Cone This sets the voltage on the extraction lens, and is normally set 
from 0 - 2V.

Desolvation Temp This sets the temperature of the desolvation gas heater. It is 
usually set to 150ºC, and increased for higher solvent flow 
rates.

Source Temp The source block temperature is usually set to 80ºC, but is 
increased for higher solvent flow rates.

Gas Flows Gas Flow will normally be set at 20 l/h for cone and 380 - 
400 l/h for Desolvation

Syringe Pump Enter the desired flow rate for the Analyte.
Lock Spray Choose from Reference or Analyte.

Note: This box only appears if LockSpray is selected on the 
MassLynx Options dialog
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6.2.5  Quadrupole Tuning Page (Analyzer)

Figure 6-6  The Quadrupole Tuning Page

Note: The Parameters on this page do not routinely need changing.

Ion Energy This sets the quadrupole offset DC with respect to the collision 
energy of the ions travelling between the quadrupoles. This 
should be set between 1 - 1.8V.
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Collision Energy This sets the collision energy of the ions when they reach the 
collision cell. The cell itself is grounded but the collision energy 
voltage is simultaneously applied to all the optical elements 
preceding it. i.e cone, extraction lens, source hexapole, differen-
tial pumping aperture, and quadrupole. In Q-Tof micro gas is 
always introduced into the cell, affording collisional cooling and 
consequently higher resolution. The collision energy is set to 
10eV for MS mode to maximize ion transmission but produce 
little or no fragmentation. When in the MS/MS mode the colli-
sion energy is adjusted to give the best fragmentation pattern for 
the selected parent

Low Mass Res and 
High Mass Res

These set the resolving DC on the quadrupoles. The two sliders 
are set to give constant resolution across the mass range. When 
the quadrupoles have been set up, settings of 15 on both sliders 
should give unit resolution at 20% peak height.

RF1 DC Offset Normal value is between 0 and 1V. The value shown in the 
display is for illustration only (item 3 in Figure 6-2).

Pre/Post Filter Normal value is between 5 and 15V (items 4 and 5 in 
Figure 6-2).

RF2 DC Offset Normal value is between 0 and 4V (item 7 in Figure 6-2).
Pump Aperture Normal value is between 2 and 10V (item 6 in Figure 6-2).
Plate 1 This is the voltage applied to the entrance plate of the gas cell. 

Normal value is 2V. The value shown in the display is for illus-
tration only.

Entrance This sets the voltage on the pusher entrance and exit, and defines 
the axial speed of the ions through the TOF. The theoretical value 
is 105 eV when the ion beam should be central to the detector. It 
should be optimized when looking at a TOF beam, not on the 
first detector. It should be possible to correctly tune the instru-
ment using this value. The value shown in the display is for 
illustration only.

Can This is the voltage applied to the hexapole gas cell surrounding 
shield. Normal value is 0.

Plate 2 This is the voltage applied to the exit plate of the gas cell. 
Normal value is -3V.

Auto MS Profiling If the box is checked then automatic MS/Hex profile will be 
used. If the box is not checked then Quad Mass and Gas Cell 
must be set manually.
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6.2.6  Time Of Flight Page

Figure 6-7  The Time Of Flight Page

Note: The Parameters on this page do not routinely need changing.

Quad Mass This is the mass in Da at which the quad mass is set in RF only 
mode

Gas Cell RF (V) This is the peak to peak amplitude of the applied RF voltage.
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Acceleration Lens Usually set to maximum voltage (200V) in all modes of opera-
tion.The factory setting should be noted, before attempting to 
improve resolution by changing this voltage.

Focus This adds an equal voltage to both the top and bottom 
steering/focus lens halfplates. For maximum TOF resolution it is 
set to zero.

Steering This adjusts the voltage difference between the top and bottom 
half plates of the steering/focus lens. It acts as a y-deflector, 
directing the beam into the pusher. A setting close to zero should 
produce an optimum beam. Better sensitivity can be achieved, 
however, with a voltage (positive or negative) close to zero, e.g. 
+1.0, -0.5 etc., and not more than ±2V. 

Tube Lens This is set to its optimum value in the factory and by the engineer 
at installation. It helps shape the ion beam on entry into the 
pusher and so has a large effect on resolution and peak shape.

Grid 2 Offset This determines the voltage difference between the two plates of 
the first acceleration region of the Tof (Pusher and Grid3). It is 
used as a fine tuning control to optimize resolution.
The optimum value for this element may change with pusher 
frequency. The pusher frequency is dependent on mass range 
when in automatic pusher mode and takes one of six discrete 
values. See pusher rates on Page 41.

Flight Tube This sets the flight tube voltage. It is always set to 5630V. 
Adjusting this will change the peak position and resolution.

Reflectron This is set expressed as a percentage of the flight tube voltage 
and its value is 1780V. Adjusting this will change the peak posi-
tion and resolution.

Pusher Offset This is the DC value applied to the puller plate to collimate the 
beam. Normal value is -1V. The value shown in the display is for 
illustration only.

Pusher This sets the amplitude of the pusher pulse and is normally set to 
830V. 

Puller This sets the amplitude of the puller pulse and is normally set to 
645V.
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Manual Pusher

Cycle Time may be set between 30 µsec and 255 µsec. Setting Cycle Time at less than 30 
µsec defaults to 30 µsec. Entering 0 µsec switches the pusher off.

Increasing the flight time reduces the duty cycle (sampling efficiency) of the TOF 
analyzer resulting in decreased sensitivity.

For the best mass accuracy the instrument should be re-calibrated if the flight time is 
changed.

If Manual Pusher is not selected then the repetition frequency of the pusher pulse is 
determined automatically according to the highest m requested in the acquisition range, as 
shown in the table below.

MCP This sets the voltage on the TOF detector. MCP must be condi-
tioned before applying high voltage (see Section 2.1.3 on page 
23). The TOF analyzer is usually operated with this detector set 
at 2800V. The value shown in the display is for illustration only.
It is recommended that a record of these values is kept for future 
reference.

Manual Pusher If the Manual Pusher box is selected from the Other sub-menu 
then the repetition frequency of the pusher pulse is determined by 
the Cycle Time entered. See below.

Width This is the width of the pusher pulse in µs, the default value is 9 
µs but for low mass (< 80Da) acquisitions a lower value may be 
needed.

Maximum Flight Time Highest

33 µsec 1000
47 µsec 1001 - 2000
66 µsec 2001 - 4000
94 µsec 4001 - 8000
132 µsec 8001 - 16000
188 µsec 16001 - 32000
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6.2.7  Other Tune Page Settings

TDC Settings

Figure 6-8  The TDC Settings Dialog

To access the TDC (time to digital converter) settings select Options >TDC settings. 

Start This is the size of the trigger signal that is necessary to trigger the 
TDC (start the clock). The start signal is derived from the pusher 
voltage itself, and a typical value is 500mV. This voltage may be 
different in negative ion mode.

Stop This is the size of pulse needed to register as being an ion, so 
stopping the clock. It is usually set at 150mV, a value high 
enough to prevent electronic noise being detected as ions. 

Threshold This parameter should normally be set to zero. Setting to 1 will 
cause all peaks in the spectrum with one count to be thresholded 
out.

Centroid 
Threshold

Any peak above this value in height (counts) will be classed as 
ions and a centroid will be produced

Min Points Any peak above this value in width (bins) will be classed as ions 
and a centroid will be produced.

NP Multiplier Used in deadtime correction calculations. A normal value is 0.7.
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6.3  Obtaining an Ion Beam

This section refers exclusively to the positive ion mode of operation using the ESI source. 
This is often the simplest mode of operation for getting and checking the ion beam.

Note: This method should also be followed through when it is suspected there may be a 
problem with the instrument. It is likely that, should the user ever need to contact 
Micromass’ Technical Support specialists, they will ask that these steps have been 
performed.

It is standard practice to use a sample with which the user is familiar. This sample should 
be of reasonable concentration and have at least one readily recognized component or 
pattern of masses. 

Commonly used compounds are listed below:

A normal concentration is 2ng/µl. The general method outlined here can be used in either 
mode - positive or negative.

Resolution Used in deadtime correction calculations. A normal value is 
6000, but will vary according to instrument resolution.

Lock Mass The mass to be entered in accurate /exact mass corrections to 
ensure data drift is minimized.

Mass Window The window searched around the set lock mass in order to estab-
lish a suitable peak to be the lock mass

Veff Effective flight tube voltage, used for setting up the non-cali-
brated mass scale. A normal value is 5630.

Temp Correction Enables the DXC corrections to be applied, if installed.
Lteff This is used to make the TOF mass measurement nominally 

correct without a calibration. The value is usually around 1080.
See Chapter 7 for further details.

Compound Mwt

Leucine Enkephalin 556Da
PEG 200/400/600 (mix) 100-1000Da

Sodium Iodide 100-2500Da
Obtaining an Ion Beam 89



6

Qtof Micro.book  Page 90  Thursday, December 19, 2002  3:39 PM
The sample should be infused at a rate of 5 µl/min via a syringe pump (on the instrument 
or otherwise) or using a dedicated LC system. This ensures a uniform, continuous spray 
that will last for a relatively long period.

6.3.1  Standard Tune Parameters

1. Enter the Standard Tuning Parameters (or load from a file) as described in 
Section 6.2 and Section 6.3. 
Ensure that the Peak Display window is open.

2. Switch the instrument into OPERATE. 
Press the button on the tune page marked ‘Press For Operate’ to get the following 
(the indicator goes to green and the button changes to ‘Press For Standby’)

3. Ensure that the API Gas , Col Gas , and Syringe , buttons are 
selected and operating.

Note: It may take a while for the sample to appear in the peak display window as any dead 
volume will need to be cleared first.

4. Assuming that the probe is spraying the Peak Display window should be showing 
some response.

Note: Adjustment of the Capillary and Sample Cone Voltage will vary the peak height and 
shape

6.3.2  Checking the Resolution

While there may be a beam showing in the peak display, a single peak needs to be “Tuned” 
to give a resolution of at least 5000 (FWHM), for the QTof micro to perform to its 
specification.

The resolution is calculated by the following equation:

In the following example Leucine Enkephalin (2ng/ml) has been enthused at 5 µl/min.

1. Press the Tune Page Acquire button. This invokes the Tune page Acquisition dialog 
(Figure 6-9)

Enter a Data File Name together with any necessary comments.
Ensure TOF MS is selected for the Function and that the Data Format is set to 
Continuum.

Resolution Mass( ) PeakWidthHalfHeight( )÷=
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Set the mass range from 100 Da to 1000 Da and a Duration of 1 minutes.
The scan time can be any reasonable value, but a setting of 1s with an inter scan 
time of 0.1 s gives one second scans for each individual spectrum saved to disk.

2. Click Start.

Figure 6-9  The Tune Page Acquisition Dialog

3. Open Chromatogram from the MassLynx Sample List menu and click on Real 
Time Update.

4. Combine data from at least 30 scans. On completion the Spectrum window will 
open

Note: See the MassLynx User’s Guide for details on how to use Chromatogram, Spectrum 
and Combine.

5. In the Spectrum window Zoom in on the main peak at 556 Da.

Note: Ensure that a Grid is shown on the Spectrum. Select Display > View to display the 
Spectrum Display dialog
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6. With the aid of the grid right click and drag the mouse across the width of the peak 
at half height. The width is show in the bottom left corner of the Spectrum window 
(Figure 6-10)

Figure 6-10  Combined Spectrum of Leucine Enkephalin Showing Peak Width at Half Height

7. The resolution can now be calculated.

In this case it is quite clearly adequate and above 5000.

If the resolution is not above 5000 the process will have to be repeated with different 
tuning parameters. With experience it will possible estimate the resolution from the Peak 
Display on the Tune Page.

Note: If a resolution of 5000 can not be achieved it is likely that there is a problem with the 
instrument and Micromass Technical Support should be contacted.

Resolution 556.2214 0.0899÷ 6187= =
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Chapter 7
Calibration 

There are several steps to carrying out a Calibration for Accurate Mass on the Micromass 
Q-Tof Micro MS:

1. Calculation of Nominal Mass Accuracy (Section 7.2.1)
2. Acquire data for Calibration. (Section 7.2.20)
3. Check for Deadtime distortion (Section 7.2.3)
4. Calibration (Section 7.2.4)
5. Deadtime Correction (Section 7.2.6)

You will need to refer to the following chapters of the MassLynx User’s Guide.

• Chapter 6 - Chromatogram
• Chapter 7 - Spectrum
• Chapter 8 - Strip and Combine

Note: To use the Calibration file for Accurate Mass refer to Chapter 15 “Accurate Mass 
Measure” of the MassLynx User’s Guide.

7.1  Introduction

Extremely accurate mass measurements can be performed with the Q-Tof micro, due to 
the elevated resolution and inherent stability of the calibration law of orthogonal TOF 
instruments. 

The basic time of flight calibration from mass (m) to time (t) is of the form:

where:

The term P represents the resultant gain from the instrument geometry (pathlengths and 
voltages).

Q Pt+=
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Q is an offset, arising from propagation delays through the electronics (detector rise 
time and delays of trigger signals through cables).

If a data file is acquired from the instrument with no calibration applied, then it is assumed 
that the offset is zero and the gain P is calculated from the instrument geometry.

7.1.1  Nominal Mass Accuracy - Lteff

Lteff is the effective length of the flight tube, it is important that this should be set up to 
give at least nominal mass accuracy.

Nominal mass measurement is achieved on the Q-Tof micro by adjustment of the Lteff 
factor, a term which quantifies the difference between the indicated and actual mass. 

A TOF spectrum of a standard compound is acquired with Lteff set to its default value of 
1078. 

A new value of Lteff can be calculated from the following relation:

where:

mind = indicated m/z

mact = actual m/z

The new value is entered on the Tune Page under Options > TDC Parameters 
(Figure 7-1).

Lteff 1078 mind mact÷=
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Figure 7-1  TDC Settings Dialog

All Subsequent mass measurements will be nominally correct. This value should only ever 
need to be set once.

7.1.2  Calibration

With no calibration applied, the spectral data in MassLynx is merely a set of mass intensity 
pairs {Mn, In} based upon instrument geometry. 

The inherent relationship between mass and time shown above makes it prudent to 
generate higher order calibration coefficients that are applied to the square root of the 
nominal masses {Mn}:

where:

The terms A, B, C, D…. are calculated by fitting a polynomial to the acquired mass 
spectral data. 
Mc is the calibrated displayed mass. 

• If a polynomial of order 1 is requested, the values for A & B are calculated, and the 
higher terms are set to zero. 

Mc A B Mn CMn DM3 2⁄
n+ ++=
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• For a polynomial of order 5 (the highest supported in MassLynx) there will be six 
terms generated. 

• When calibrating over a large mass range (>500 Da) it is advisable to use a higher 
order polynomial, as the deviations from the straight line fit become more 
appreciable.

• Once a calibration has been generated from a reference compound such as PEG it 
should be used as an ‘instrument calibration’ to be applied to all subsequently 
acquired data. 

The procedure for this is described below. 

7.1.3  Lock Mass

Temperature variations in the environment and in the instrument power supplies can cause 
drifts in measurements of a few hundred parts per million (ppm) over the course of a day. 
For accurate mass work, the instrument should be kept in OPERATE at all times to enable 
stabilization of the power supplies. 

Users can compensate for instrument drift by applying a single point lock mass correction 
that recalculates the term B in the above equation. This can be done in two ways:

1. Using a Micromass LockSpray / NanoLockSpray Interface 
2. Teeing in, post column, a Lock Mass reference compound. 

Note: There are inherent problems with the second approach which can lead to poor 
exact mass capability. Consequently we recommend that the first option is used when ever 
possible.

7.1.4  Deadtime Correction

The data acquisition system for the instrument is a time to digital converter (TDC). This is 
an ion counting system which generates a mass spectrum by storing the arrival times of 
ions in a histogram memory. 

After the arrival and registration of an ion by the TDC there is a minimum time interval 
before a subsequent ion arrival can be registered. This is called the ‘dead time’ of the TDC 
and is of the order of 5 nanoseconds. 

At high ion currents some of the ions generated are not registered, leading to a shift to 
lower mass centroids, with consequently lower measured areas on reported peaks. 
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However, the MassLynx software incorporates a correction facility which allows for 
accurate mass measurements to be achieved over a large range of ion currents, and the use 
of dead time correction is described below.

7.2  Generation of an Instrument Calibration

Make up an analyte solution consisting of: 

PEG 300 (10 nanolitres/millilitre),                   

PEG 600 (10 nanolitres/millilitre), 

in a stock solution of 2mM ammonium acetate in 50/50 acetonitrile/water.

Dilute this by a factor of ten (with the stock solution) and introduce this to the instrument 
using a syringe pump operating at 5 microlitres per minute.

Note: The Quad ramp is predetermined for every mass range and can not be set by the 
user.

7.2.1  Calculation of Lteff

Figure 7-2  The Tune Page Acquisition Dialog
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To calculate Lteff it is recommended that a solution such as Leucine Enkephalin is used 
that will produce a single peak.

1. Make up a solution of Leucine Enkephalin at 2 ng/ml in 50:50 methanol:water.
2. Introduce this into the instrument with the syringe pump at 5 µl/min.
3. Click Aquire, this will invoke the Tune Page Acquisition dialog (Figure 7-2).
4. Acquire for about 2 minutes.
5. Combine the data and then Center the Spectrum.

Note: For further information on Combining data see Chapter 8 of the MassLynx User’s 
Guide and for Centering Spectral data, Chapter 6.

6. Note the indicated mass. In this case 561.2170.

Figure 7-3  Indicated Mass of Leucine Enkephalin prior to Lteff Correction
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7. Use this value and the actual mass of Leucine Enkephalin (556.2771) to calculate 
Lteff. In this case:

Lteff = 1082.78.
8. Enter the new Lteff value on the TDC Settings dialog.
9. Repeat steps 3 - 5. The new Lteff setting will give a nominal mass accuracy for 

Leucine Enkephalin.

Figure 7-4  Indicated Mass of Leucine Enkephalin after Lteff Correction.

7.2.2  Acquire Data for Calibration

1. Set the Cone Voltage (30 - 40 volts)so as to give a good distribution of PEG peaks.
2. Check the resolution as detailed in the previous chapter.
3. Acquire data for one minute over the range 100 - 1000 Da, with scan time of 

1second (for details on Acquiring Data see Section 7.2.1 on page 97).

4. Combine at least 30 scans of data.
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Check that the signal is not too intense and that the data acquired does not have an ion 
count above 200 counts/sec.

7.2.3  Check for Deadtime Distortion

With the data acquired in the previous section:

1. Select Process > Center from Spectrum, this invokes the TOF Spectrum Center 
dialog (Figure 7-6). Select the TOF button from this dialog to invoke the QTOF 
Accurate Mass dialog. Check that both the resolution and Np multiplier are set to 0 
(Figure 7-5).

Figure 7-5  The TOF Accurate Mass dialog

2. Center the Spectrum with the values shown in (Figure 7-6). 

For details on how to center spectra see the MassLynx User’s Guide.
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Figure 7-6  The TOF Spectrum Center Dialog

3. Re-center the data using a Resolution of 5000 and Np Multiplier of 0.7. Check that 
any differences in the centroided masses of the two centered spectra are less than 1 
mDa

Figure 7-7  Comparison of Centered Spectra With (top) and Without (bottom) Deadtime Correction

If the difference between the two peaks is more than 1 mDa then repeat the acquisition 
with less intense peaks, either by dilution or by reducing the capillary voltage.

Once a satisfactory centered spectrum has been acquired, save it in the spectrum history.
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7.2.4  Calibration

1. Select Calibration > Calibrate Instrument from the Tune Page. This invokes the 
Calibration Window (Figure 7-8).

2. Select the Reference file to use from the drop down list of the Calibration Window. 
(pehnh4, ref will give the correct masses with the sample used here).

3. Select Calibrate > From File. This will invoke he Display Calibration Graphs 
dialog (Figure 7-9).

4. Use the Browse option to select the centered spectrum which has been previously 
saved. In this example it is from the data file CJ0710_02.

5. Once the spectrum has been selected Click OK.

Figure 7-8  The Calibration Window.
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Figure 7-9  The Display Calibration Graphs Dialog

6. The Centered Spectrum will now be processed and compared against the Calibration 
File. When the processing is complete the results are displayed in a new calibration 
window.
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Figure 7-10  Calibration Window Showing Residual Errors

Note: The residual errors should all be less than 3 mDa.

7. Outliers can be removed from the calibration curve by right clicking the outlying 
peak in the reference file spectrum and clicking the associated peak on the data file 
spectrum.

8. The calibration parameters can be altered by selecting Edit to invoke the 
Calibration Parameters dialog (Figure 7-11). Set the Intensity Threshold to 5%. 
This will mean that lower intensity peaks will not be included in the calibration and 
will generally give a better fit.
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Figure 7-11  The Calibration Parameters Dialog

A firth order polynomial has been chosen here, as a large mass range is being covered by 
the calibration. It can be useful to do a first order calibration initially so that outliers are 
spotted more easily. When these have been removed reset the curve to a fifth order.

9. When the parameters have been set Exit the window and Accept the Calibration 
(below).

Figure 7-12  The Accept Calibration Dialog

10. The calibration will be updated with the time of the update displayed in the 
Calibration Window (Figure 7-8).

Note: Always Select File > Save As before exiting the calibration window and save the 
calibration with a unique filename. Exiting directly may result in the Uncal default file being 
overwritten.
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7.2.5  LockMass Correction

The application of a single point lock mass correction will now correct for subsequent 
instrument drift and bring masses back to within 5 ppm RMS, on the condition that there is 
no isobaric chemical interference with either lock mass or analyte peaks. 

The lock mass is found under the TOF Spectrum Center menu when QTOF is clicked:

Centering the spectrum with these parameters will force the peak at 520 to be 520.333 
exactly and recalibrate the entire mass spectrum.

7.2.6  Deadtime Correction

If you wish to Acquire Accurate Mass data at above 200 counts/sec then a deadtime 
correction needs to be applied to the calibration.

1. Acquire a spectrum of PEG at the higher concentration of 10 nl/ml and create a 
centered spectrum with no lock mass and no correction. (All parameters set to 
zero.)(Figure 7-5)

.

Figure 7-13  Calibration Window Deadtime Distortion 
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2. Follow steps for calibration in Section 7.2.4 on page 102, to when the Calibration 
results window is open and the residual errors are revealed.
There should now be a reduction in the mass deviation observed between adjacent 
peaks of high and low intensity.

3. Repeat this process at subsequently lower values of Np until the deviation is 
minimized. 

Figure 7-14  Same data as Figure 7-13 but with Np multiplier of 0.7

At this point the peaks should lie close to the axis - the line of best fit:
4. Typical values for Np Multiplier will be about 0.7, and the Resolution used should 

be as measured on the instrument at mass 500. 
5. Now that the deadtime correction has been set up, the difference in reported areas 

and masses between corrected and uncorrected centered data can be seen. In the 
example below, the 371 peak has been shifted by 8.7 mDa.
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Figure 7-15  Two Spectra One (bottom) with no Deadtime Correction and the Other (top) with.

Further Notes

The model successfully corrects for deviations of up to about 15 mDa at mass 500, at 
which point the limits of the model are reached, with no correction applied at higher ion 
current. 

Users should familiarize themselves with the ion current range over which successful 
mass measurements can be made. Once the Resolution and Np Multiplier figures have 
been evaluated they can be left active in the menu without affecting centered data in any 
adverse way.

The procedure involved using the Spectrum, Make Calibration commands is a             
post-processing calibration, producing a data file of a particular format and with the 
extension .scl.

The file resulting from the commands Instrument Calibrate, Save Calibration has the same 
file extension .cal, but it should be noted that because it is an instrument calibration file, it 
is of an incompatible format to that described above. 

Folders and naming conventions should be appropriately assigned.
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7.3  Exact Mass Measurement: Additional Hints

• Best results are obtained if the lock mass gives an intensity of approximately 100 to 
200 counts per second as shown on the real time tune display.

• The lock mass should be chosen to be at the upper end of the mass range used.
• Do not change transfer lens voltages without re-calibrating the instrument.
• Changing Cone will not change the calibration.
• Always be aware of possible chemical interference problems, either on the sample or 

the lock mass peak.
• When performing a base calibration (using PEG, for example) better results may be 

obtained by using a stronger solution and moving the probe off axis to limit the ion 
current, rather than using a lower concentration.

• This has the effect of minimizing any possible chemical interference from 
background ions.

• Always check the stability of the spray (see the instructions for the setting of the 
probe tip in Maintenance and Fault Finding). 

• Short term variations in the spray produce fluctuations in the number of ions per peak 
per pusher pulse, giving rise to errors in the deadtime correction calculations. The 
number of ions per peak per pusher pulse is calculated from the ion current integrated 
over a period of time thus only giving an average value.

• To obtain the best deadtime correction, only combine scans of a similar intensity, 
either at the top of a chromatographic peak or in the tail of a chromatographic peak.

• This ensures the number of ions per peak per push is calculated correctly.
• The deadtime correction algorithm can only correct for ion intensities and m shifts up 

to a limit. If the ion current approaches approximately 10,000 counts per peak 
(without correction) in one second then the limits of the model are being reached.

• If the limits of the model are exceeded no correction is applied - the same result will 
be obtained by centring the data with Resolution and Np Multiplier set to zero.

• If the limits of the deadtime correction algorithm are exceeded it may be possible to 
use the C13 isotope instead.

• For the best mass accuracy when mass measuring doubly charged ions, it is advisable 
to use a doubly charged lock mass peak.

• To obtain the true number of ions per peak, areas must be selected on the peak centre 
menu.
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• The standard deviation in the determination of the mass (strictly ) centroid of a 
triangular-shaped peak (σppm) due to ion statistics alone is given by the equation 
below.
A triangle is assumed to be a close enough approximation to the shape of the mass 
spectrometer peak for the equation to be valid.

σppm = 106∆M / M(24Np)0.5 ppm
where:

∆M is the width (m) of a triangular peak across the base.

M is the m value of the peak.

Np is the number of ions per peak.

Using the above equation we can calculate the number of ions per peak required to give 
a standard deviation of 5 ppm when measuring a peak at 500 m.

Assuming 5000 (FWHM) resolution, so ∆M = 0.2  (width at base = twice width at 
half height), then:

Thus standard deviations of less than 5 ppm cannot be expected unless the number of 
ions per peak is greater than 267.

Np 0.22 1012×( ) 24 500× 2 52×( )⁄( ) 267==
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Chapter 8
Data Acquisition

The following sections of this chapter will guide you through the basic acquisition 
methods used in MassLynx.

• Section 8.1, Starting an Acquisition
• Section 8.2, Monitoring an Acquisition
• Section 8.3, The Experiment Setup Editor
• Section 8.4, Automated Data Dependent Acquisition (DDA)

Before starting an acquisition the instrument will need to be tuned and calibrated (refer to 
Chapter 6, Tuning and Chapter 7, Calibration). You will also need to refer to the following 
chapters of the MassLynx User’s Guide.

• Chapter 4 - Sample Lists
• Chapter 6 - Chromatogram
• Chapter 7 - Spectrum

8.1  Starting an Acquisition

There are two ways of starting an acquisition:

• single sample acquisition from the tune page.
• multiple sample acquisition from the MassLynx sample list.

8.1.1  Starting an Acquisition from the Tune Page

The easiest way to acquire data is directly from the tune page.
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• Acquisitions can be started and stopped.
• Inlet programs cannot be used.
• Analog data cannot be acquired.
• Multiple sample sequences cannot be acquired.

To start a single sample acquisition:

1. Press Acquire on the tune page, or choose Acquire. This will invoke the Tune Page 
Acquisition Dialog.

2. Make any required changes to the settings.
3. Press Start

Figure 8-1  Tune Page Acquisition Dialog

Parameters

 Data File Name The can be up to 128 characters. If the file already exists on disk, a 
prompt is given to rename the file or to overwrite the existing one. 
The file is written to the data directory of the current project.

Set Mass Specifies the precursor mass that is used for the TOF MSMS acqui-
sition This control is disabled if the function selected is TOF MS.

Start Mass and 
End Mass

These specify the masses at which the scan starts and stops. Start 
Mass must be lower than End Mass.
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Pressing Origin allows additional information about the sample to be analyzed to be 
entered into the following fields:

• Submitter
• Job
• Task
• Conditions

To change the directory into which data are acquired:

1. Cancel the acquisition.
2. Create a new project by choosing MassLynx top level file menu, Project Wizard or 

open an existing one by choosing Open Project, from the MassLynx top level file 
menu.

3. The Text area is used to enter the sample description. The description can be 
displayed on any output of the acquired data and has a maximum length of 74 
characters. To display text on more than one line press CTRL+Return at the end of a 
line.

4. The type of acquisition Function used to collect the data can be either of the 
following:
• Tof MS
• Tof MS/MS

More information is given in Function List Editor later in this chapter.

The Data Format that are collected and stored on disk can be any of the following:

• Centroid
• Continuum
• MCA

Run Duration The length of the acquisition, measured in minutes.
Scan Time Specifies the duration of each scan in seconds.
Inter Scan Time Specifies the time in seconds between a scan finishing and the next 

one starting. During this period no data are stored.
Calibration Allows an appropriate, previously generated calibration file for 

either positive or negative ion to be selected - see chapter entitled 
Calibration and Exact Mass.
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More information is given on data formats later on in this chapter.

8.1.2  Multiple Samples

The MassLynx top level screen contains a sample list editor for defining multiple 
experiments. The list of samples is set up using a spreadsheet style editor, which can be 
tailored to suit different requirements.

For more information see the MassLynx User’s Guide, Chapter 4.

8.2  Monitoring an Acquisition

Acquisition status is shown on the MassLynx screen. The run time is shown on the MS 
panel and the scan status, sample number and scan number are shown on the Status bar at 
the bottom of the page.

8.2.1  The Acquisition Status Window

Figure 8-2  The Scan Report Dialog

The acquisition status window, or scan report (Figure 8-2), provides a scan by scan 
statistical report of the progress of an acquisition.

To display the scan report dialog, from the tune page:
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Select Options > Scan Status.

This shows details of the scan currently being acquired.

8.2.2  Chromatogram Real-Time Update

To view in real time the chromatogram that is currently being acquired:

1. Open the data file using the MassLynx data browser. 
2. Press , or select Real-Time Update from the Display menu. The chromatogram 

display is updated as the acquisition proceeds.

For Further Details see the MassLynx User’s Guide

8.2.3  Spectrum Real-Time Update

To view in real time the spectrum that is currently being acquired:

1. Open the data file using the MassLynx data browser.
2. Press , or select Real-Time Update from the Display menu.
3. Select Enable Real-Time update. 

For Further Details see the MassLynx User’s Guide

8.2.4  System Manager

To check the communications between the MassLynx software and the embedded PC:

Select Options > Communications Status from the Tune page menu bar.

8.2.5  Stopping an Acquisition

To halt the acquisition:

1. From the Tune page, press .
2. From the MassLynx screen choose Stop from the Run menu, or press .

Data acquired up to this point is saved.

8.3  The Experiment Setup Editor

The experiment setup editor is used to set up the function(s) that the mass spectrometer 
uses during an acquisition. A function list can be a mixture of MS or MSMS experiments 
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that can be arranged to run either sequentially or concurrently during an acquisition. 
Survey or parent functions must be run in isolation.

Typical uses for mixed function acquisitions are the acquisition of several MSMS product 
ion spectra over different retention windows.

A function list is produced, saved on disk and then referenced by name when an 
acquisition is started.

A simple function list is shown above, containing only one function: a centroided mode 
TOF MS scan, between 100 and 1500 amu using ES+ ionization. Immediately above the 
function bar display is a time scale that shows from when the function is active, and for 
how long it runs. In this case the acquisition runs from 0 to 60 minutes.

To access this dialog:

Select MS Method from the MassLynx Instrument Shortcut bar.

Figure 8-3  The Experiment Setup Editor

One example of a function list shown in Figure 8-3 shows 3 different MSMS functions in 
sequential time windows is shown above. The currently selected function is highlighted 
and enclosed in a rectangular frame. If the display shows more than one function a new 
function can be selected either by clicking with the mouse, or by using the arrow keys on 
the keyboard.

8.3.1  The Experiment Setup Editor Toolbar

The toolbar is displayed at the top of the tune window and allows some common 
operations to be performed with a single click.
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Create a new function of the Indicated type.

8.3.2  Adding a New Function

To add a new function to the list: 

1. Click one of the toolbar buttons, or select the required function from the Functions 
menu. 

The editor for the function type selected is displayed showing default values. 

2. Make any changes required to the parameters and press OK to add the new function. 

The function editors for each scan type is discussed in detail later on in this chapter. 

8.3.3  Modifying an Existing Function 

To modify an existing function: 

1. Select the function in the function list. 
2. Press , or double click on the function. 

This displays the appropriate editor for the function type and allows changes to be made. 

The function list display is updated to show any changes. 

Entering a new value in Total Run Time and pressing  sets the maximum retention 
time for the experiment. The ratio of the functions defined is maintained. For example, if 
two functions are defined one from 0 to 5 minutes and the other 5 to 10 minutes then a 
Total Run Time of 10 minutes is displayed. If this value is changed to 20 then the first 
function now runs from 0 to 10 minutes and the second from 10 to 20 minutes. 

Create a new function list. Edit the selected function.

Open an existing function list. Delete the selected function.

Save the current function list to disk. Move the selected function up the list of 
functions.

Print the current window in portrait for-
mat.

Move the selected function down the list 
of functions.
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8.3.4  Copying an Existing Function 

To copy an existing function: 

1. Select the function in the function list. 
2. Select Copy and then Paste from the Edit menu. 
3. Modify the parameters as described above. 

8.3.5  Removing a Function 

To remove a function: 

1. Select the function in the function list. 

2. Press , choose Delete from the Edit menu, or press Del on the keyboard. 
3. When asked to confirm the deletion, select Yes. 

8.3.6  Changing the Order of Functions 

Functions are displayed in ascending Start Time and End Time order and this order 
cannot be changed. For functions that have the same start and end time the order in which 
they are performed can be changed as follows: 

Highlight the required function. 

Press  or  repeatedly until the function is in the required position. 
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8.3.7  Setting a Solvent Delay 

Figure 8-4  The Solvent Delay Dialog

No data is stored during the solvent delay period, which means that solvent peaks that 
would normally be seen eluting on the TIC chromatogram are no longer seen. 

For APcI functions the APcI probe temperature is set to the value specified in the 
APcI Probe Temp control for the period of the solvent delay. 

To set a solvent delay for a function list: 

Select Options > Solvent Delay from the menu bar. 
The Experiment Setup Editor 119



8

Qtof Micro.book  Page 120  Thursday, December 19, 2002  3:39 PM
8.3.8  Analog Channels 

Figure 8-5  The Analog Data Dialog

If an analog channel’s hardware option is fitted, up to 4 channels of analog data can be 
acquired, which are stored with the data acquired from the mass spectrometer. Analog 
channels are typically used to collect data from external units such as UV detectors or FID 
detectors. A reading is made from the external channel at the end of each scan and stored 
with the data for that scan. The resolution of the chromatography for an analog channel is 
therefore dependent on the scan speed used to acquire the mass spectrometry data. 

To access this dialog: 

Select Options > Analog Data from the Method Editor dialog. 

To store data for an analog channel: 

1. Check the box(es) for the channel required. 
2. Enter a textual description for each of the selected analog channels. 

This description is used on the analog chromatogram dialog as the channel description. 
See “Chromatogram” in the MassLynx User’s Guide. 

3. Enter an Offset to align the external unit with the mass spectrometer.
4. Press OK.

8.3.9  Saving and Restoring a Function List

To save a function list:

1. Choose Save As from the function list File menu.
2. Enter a new file name, or select an existing file from the list displayed.
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3. Press Save.

If the file already exists on disk, confirmation is requested to overwrite the existing 
information.

Press Yes to overwrite the file, or No to select a different name.

When the editor is closed a prompt is issued to save any changed function lists.

To restore a saved function list:

1. Choose Open from the function list File menu.
2. Select the name of the function list to open, either by typing its name or by selecting 

it from the displayed list.
3. Press Open.

8.3.10  Setting up an MS Scan Function

The full scan function editor, activated by pressing or by selecting TOFMS Scan from the 
Functions menu, is used to set up centroid, continuum and MCA functions.

The full scan function editor, activated by pressing or by selecting 
TOFMS Scan from the Functions menu, is used to set up centroid, continuum and 
MCA functions. 
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Figure 8-6  The TOFMS Scan Dialog

Mass (m/z) 

Low Mass and High Mass specify the masses at which the scan starts and stops. 

Time (mins) 

Start Time and End Time specify the retention time in minutes during which this 
function becomes active, and data are acquired. 

Cone Voltage 

When Use Tune Page is checked, the cone voltage set on the tune page at the start of the 
acquisition is used. 

The cone voltage value cannot be altered during acquisition by typing new values into the 
tune page, since the new values are not downloaded during acquisition. This can only be 
done by acquiring from the tune page. 
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Method 

Ionization Mode, specifies the ionization mode and polarity to be used during 
acquisition.

Data, specifies the type of data to be collected and stored on disk. 

There are three options: 

• Centroid stores data as centroided, intensity and mass assigned peaks. Data are 
stored for every scan. 

• Continuum. The signal received by the interface electronics is stored regularly to 
give an analog intensity picture of the data being acquired. Data are not centroided 
into peaks, but are stored for every scan.
Due to the fact that data are acquired to disk at all times, even when no peaks are 
being acquired, continuum data acquisition places some extra burden on the 
acquisition system as compared to centroided acquisition. Data files tend to be 
significantly larger than centroided ones and the absolute scanning speed (amu/sec) is 
slower. 
It is possible, however, to set a threshold below which the data are not stored. 
Depending on the nature of the data acquired, this can greatly reduce these effects. 
The threshold can be set so that data considered to be ‘noise’ can be discarded, thus 
improving data acquisition speed and reducing data file sizes. 

• Multi Channel Analysis (MCA). MCA data can be thought of as ‘summed 
continuum’, with only one intensity accumulated scan being stored for a given 
experiment. As each scan is acquired, its intensity data is added to the accumulated 
summed data of previous scans. 
An advantage of MCA is that random noise does not accumulate as rapidly as real 
data and therefore effectively averages out over a number of scans. This emphasizes 
the real data and improves the signal to noise ratio. 
The disadvantage of MCA is that, as there is only one scan, it cannot be used for time 
resolved data. 
For MCA, Scans to Sum defines the number of scans to sum to create a spectrum. 

Scan Duration (secs) 

Scan Time specifies the duration of each scan in seconds while Inter-Scan Delay 
specifies the time in seconds between a scan finishing and the next one starting. During 
this period no data are stored. 
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APcI Probe 

Probe Temp, in degrees centigrade, is enabled when Ionization Mode is set to APcI. 

When Use Tune Page Settings is selected the APcI probe temperature set on the tune 
page at the start of the acquisition is used. This control is enabled when the ionization 
mode is set to APcI. 

The APcI probe temperature value cannot be altered by typing new values into tune page 
during the acquisition since the new values are not downloaded during the acquisition. 
This can be done by acquiring from the tune page. 

Setting up MS-MS Scanning Functions 

Figure 8-7  The MSMS Scan Dialog
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The MSMS scan function editor is activated by pressing the MSMS button or by selecting 
TOF MSMS from the Functions menu. 

Many of the fields in the MSMS scan editor are similar to those described in 
Section 8.3.10 on page 121. Only fields that differ significantly are described below. 

Masses 

Set Mass specifies the precursor mass to be selected by the quadrupole for fragmentation 
in the gas cell. 

When multiply charged species are being analyzed care should be taken when selecting 
the High Mass to ensure that the mass range is sufficient to include product ions with a 
lower charge but a higher  value than the precursor. 

Time 

The product ion spectra are acquired in the time window defined by the Start Time and 
End Time. Several MSMS scanning functions can be set up to either run sequentially or 
concurrently in overlapping time windows. 

Collision Energy 

When Use Tune Page Settings is checked, the collision energy set on the tune page at 
the start of the acquisition is used. 

8.4  Automated Data Dependent Acquisition (DDA)

For the automated MS/MS analysis of unknown compounds, the Micromass Q-Tof micro 
has a powerful software control system to enable the instrument to perform data dependent 
acquisition (DDA), switching from the MS to MS/MS mode and then returning to the MS 
mode using data dependent criteria. The advantage of this method is that it removes the 
requirement to analyze the sample in MS mode to identify the target precursor ions and 
then re-run the sample in MS/MS mode to acquire the MS/MS data from each of these 
precursors. This is particularly valuable in the analysis of unknown samples using on-line 
chromatography where the target precursor ions and their retention times may well be 
quite different for each sample.

During acquisition the instrument is controlled by the MS FILE in the MassLynx Sample 
List. DDA can only be acquired using the Sample List and may not be started by acquiring 
from the Tune Page.
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The MS FILE file is created using the method editor and then selected in the sample list in 
the usual way.

8.4.1  Creating a Data Dependent MS to MS/MS Switching Experiment

Accessing the Method Editor

In the MassLynx sample list, using the cursor to select the MS file, perform a right mouse 
button click and in the drop down menu select the Open command to access the Method 
editor for that MS file.

Creating a New Experiment

In the top banner of the Method editor window select File and in the drop down menu 
select New to create a new template with no predefined functions. Select the Survey 
button to create a data dependant acquisition.

Clicking the Survey button will launch Survey Scan Dialog (Figure 8-8). There are 8 
tabbed pages available. These are used to access all the relevant parameters for the data 
dependent function switching experiment. 

It is advisable to work through each page sequentially and fill in the appropriate values. 
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8.4.2  Survey

Figure 8-8  Survey Scan Dialog: Qtof MicroSurvey Page

The mass range is used to define the start and end mass range for the MS data.

Time (Mins), defines the start and end times for the complete experiment. The spectrum 
integration period (Scan Duration) and Inter-Scan Delay period for the MS data are 
selected. In the MS mode the minimum time required to transfer data from the embedded 
PC to the data file on the host PC is about 100 mSec. Scan times of less than 1 sec may be 
employed if required, but because the Inter-Scan Delay is fixed (by the data transfer rate) 
the duty cycle will decline at very fast acquisition rates.
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The Cone Voltage must either be set to Use Tune Page or set in this window to a suitable 
value. 

8.4.3  MS to MSMS 

Figure 8-9  Survey Scan Dialog: MS to MSMS Page

This tab has all the appropriate values that dictate when to switch into the MS/MS mode 
from the MS mode. They are as follows: -
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MS to MSMS Switch Criteria

The decision can be made using TIC or individual ion Intensity. Since multiple 
precursors may be selected for concurrent MS/MS experiments it is usual to set this to 
Intensity. It is useful to acquire some MS data to be able to measure the typical 
background level and the peak intensities from the sample peaks so that the detection 
Threshold can be set appropriately.

Within the mass range of the MS survey scan any peaks that rise above the Threshold (in 
ion counts/sec) will be identified as candidate precursor ions for selection.

To prevent the selection of the P+1 (13C) or P+2 (13C2) isotope peaks as additional 
candidate precursors a Detection Window is set. The window is an absolute mass value, 
i.e:- a setting of 1Da will extract a 1Da range of the m scale and identify only the most 
intense peak contained within that specific m range. A suitable value for 1+ and 2+ ions 
would be 2Da.

Number of Components defines the number of precursor masses that can be selected for 
concurrent MS/MS data acquisition from one MS survey scan. Once the candidate 
precursor are identified the N most intense will be used for MS/MS. The maximum that 
can be specified is eight, but often a more suitable number for LC peaks about 10-20 sec 
wide at half height is 3 - 4.

The detection criteria set here may be subsequently modified by charge state 
considerations (see later)

Retention Time Window (seconds) This parameter is only active when an include or 
exclude file has been generated and is selected (see later). If an include or exclude file is 
utilized where a retention time is included (e.g. 18 mins), then this window is a time value 
in seconds which is added to the retention time during which the peak must elute to be 
selected for fragmentation. For example, a value of 30secs would mean the peak expected 
to elute at 18 mins must elute between 18.00 and 18.50 mins). 

Charge State

These settings define the parameters used for the charge state recognition algorithm. 

Tolerance Window. The window used when measuring between adjacent peaks 
(isotopes). This should be a tight tolerance, and as a default set to 0.1Da.

Mass Extraction Window. This value in Da is the mass range around the peak identified 
that is extracted to perform the CS recognition on. For peptide work a value of 2Da is 
recommended as a default.
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(%) Intensity of Main Peak. This threshold value is utilized to remove low intensity 
noise peaks from being identified by the CS algorithm. A default value of 2% is 
recommended. 

Precursor Selection

Everything. No user-predefined masses are used and all peaks will be selected 
automatically according to the criteria defined in the Automatic Function Switching 
parameters.

Included Masses Only will perform MS/MS solely on those masses appearing in the 
Include Masses list, or file, (see later section page 7) provided that their intensities rise 
above the predefined threshold set in the MS to MS/MS switch criteria.

Included Masses and Everything Else allows masses in the Include Masses list to take 
precedence. These will be selected even if there are more intense peaks that would have 
been selected automatically. 

Detected Precursor Inclusion

Auto Exclude will exclude a m value and its associated detection window (which is now 
defined under the exclude tab) from subsequent selection.

Always Include allows the immediate selection of a previously selected m value.

Include After Time excludes a previously selected m value and its associated detection 
window, (which is now defined under the exclude tab) from subsequent selection for the 
period specified. This prevents multiple selection of the same precursor in the event of 
tailing from strong LC peaks, but allows the fragmentation of near isobaric components 
eluting at other retention times. The maximum value is 200 secs.

Data

Discard uninteresting survey scans stores only those survey scans which triggered an 
MS/MS experiment to disk. Depending on the exact nature of the experiment, discarding 
these scans may significantly reduce the data file size.
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8.4.4  MSMS to MS

Figure 8-10  Survey Scan Dialog: MSMS to MS Page

If the MSMS to MS switch method is set to Default then the mode change will be 
triggered by one of the mutually exclusive options selected in the MSMS to MS Switch 
Criteria. The Intensity falling below threshold option is measured on the base peak in the 
MS/MS spectrum. A value of 2-3 counts/sec is recommended for peptide work on Q-Tof 
micro.

If the MSMS to MS switch method is set to After time then the mode change will be as 
for the default setting, except that if these criteria are not met then a maximum time can be 
set. (For example in the above case the switch would occur after 7 seconds assuming the 
intensity of the base peak in the MS/MS spectrum had not fallen below 2 counts/sec).

These rules apply on a per precursor basis. For example if MS/MS were concurrently 
running on 3 precursors and one MS/MS spectrum fell below 2 counts/sec then MS/MS 
would be terminated on that precursor. The remaining 2 precursors would continue in 
MS/MS mode until either they fell below the 2 counts/sec threshold or each MS/MS 
precursor ion had been acquired for 7 seconds. If the intensity Threshold were set to 0 
counts/sec then MS/MS acquisition would continue on all three functions until a total of 
21 seconds had elapsed.

It is useful to set this to be equal to an integral number of cycles of MS/MS spectrum 
acquisition. For example if the MS/MS Scan Time is 1 sec with an Inter Scan Delay of 
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0.1 sec and CE profiling is in operation then to get 3 scans at each of three different 
collision energies would require the After time parameter to be set to 9.9 sec.

8.4.5  MSMS Template 

Figure 8-11  Survey Scan Dialog: MSMS Template Page

This page is used to set-up the parameters for the acquisition of the MS/MS data from each 
of the precursors.

It is important that the correct Q-Tof tune file (.ipr file) is selected in the instrument 
parameter window,
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The mass range for the acquisition of the MS/MS data is independent of the mass range 
selected for the MS survey data as in the example shown here. The spectrum integration 
(Scan Duration) and Inter-Scan Delay period can also be different to those values 
chosen in the MS survey mode. 

The Collision Energy parameter will define a default collision energy that will be used if, 
for any reason, a value cannot be selected from the parameters defined later under the 
collision energy settings.

8.4.6  Include Masses

Figure 8-12  Survey Scan Dialog: Include Masses Page
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The Include Mass option allows a number of predefined m values to be included in the 
decision making process for switching from MS to MS/MS mode. There are two distinct 
modes of operation, which are defined in the MS to MSMS criteria (Section 8.4.4).

Included Masses Only will restrict MS/MS data acquisition only to peaks having the 
same m as those defined in the Include Masses List, provided that these peaks rise above 
the threshold.

Included Masses & Everything else will preferentially perform MS/MS on masses in the 
Included Masses List, even though more intense masses may have been automatically 
detected, provided that the included masses are above the detection threshold.

The Listed option allows a list of m values separated by commas to be entered directly 
into the window. MS/MS experiments on these masses will be carried out using the 
parameters defined elsewhere.

In contrast, the File option allows included masses to be read from a file and specific 
parameters (Retention Time, Collision Energy, Cone Voltage, Charge State) may be 
associated with these m values to override those parameter set elsewhere. The files may be 
created or modified using the New, Add, Delete, Save As and Save buttons as necessary.

Charge State

The Use Include By Charge State option allows the selection of only those charge states 
specified to be selected for MS/MS analysis. This may be useful for example where singly 
charged ions are usually from the background and it is desirable, therefore, to preclude 
them from analysis.

The required charge states are specified and separated by commas as shown. It is possible 
to enter values greater than 4, but at present CE control is available only up to and 
including charge state 4.

The Number of Include Components option allows for the maximum number of 
components above the detection threshold from which the candidate precursors will be 
selected. For low level studies where singly charged ions are not to be selected for MS/MS 
it is clear that there may be many candidates above the threshold, among which the 
multiply charged ions may be the minor components. The range for this parameter is 1 - 
100 and a value of 60 or 80 would be a reasonable default value. However it should be 
noted that higher values slow down data processing and hence acquisition times. 
134 Data Acquisition



8

Qtof Micro.book  Page 135  Thursday, December 19, 2002  3:39 PM
8.4.7  Collision Energy

Figure 8-13  Survey Scan Dialog: Collision Energy Page

Use Default Collision Energy

When selected, all MS/MS data are acquired using the default collision energy specified in 
the MSMS template window (see Section 8.4.5).

Use Collision Energy Profile

This option allows a range of different collision energies to be used depending on the m 
value of the selected precursor. In addition, from 1 up to 5 collision energies may be used 
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for each precursor m to attempt to produce optimal fragmentation. Using the Browse 
button, files may be selected which have previously created collision energy profiles.

Using the Modify button new profiles can be created using the Modify CE Profile 
window and its associated Add, Delete, New, Save and Save As options.

The example shown is a typical set of collision energy profiles for peptides or protein 
digest applications. During the MS/MS experiment data are collected with the collision 
energy cycling through CE1, CE2....CEN on a per spectrum basis.

Figure 8-14  The CE Profile Dialog

Use Charge State Recognition

This mode will allow the collision energy to be set according the charge state (z) and m of 
the precursor as determined from the charge state recognition algorithm. Collision energy 
files for charge states from 1, 2, 3 and 4 may be created and selected using the Browse 
button. In this mode collision energy profiling by cycling around a number of different 
energies is less likely to be required for peptide analysis.
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Using the Modify button new profiles can be created using the Modify Charge State 
window and its associated Add, Delete, New, Save and Save As options. The examples 
shown are a set of suggested collision energy profiles for peptides or protein digest 
applications when selecting 2+ ions for MS/MS analysis. 

Figure 8-15  The Modify Charge State Dialog

8.4.8  Exclude Masses

The Exclude Mass option (Figure 8-16)allows predefined masses to be excluded from 
selection for MS/MS analysis. The Exclude Mass window is now defined on this page and 
a default value of at least 1000mDa should be selected for peptide work, otherwise C13 
isotopes will still be selected for fragmentation.

The Range option allows a list of m values separated by commas, or a mass range to be 
entered into the location in the Exclude Masses window. This is suitable for a small 
number of components.

For a larger number of components and particularly for components or impurities not 
permanently present the File option can be used to specify m values and an associated 
retention time. The window around the retention time is specified in the MS to MSMS 
section above).
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Figure 8-16  Survey Scan Dialog: Exclude Masses Page
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Chapter 9
Parent Ion Discovery

Before starting a Parent Ion Discovery Experiment refer to Chapter 8, Data Acquisition. 
You will also need to refer to the following chapters of the MassLynx User’s Guide.

• Chapter 4 - Sample Lists
• Chapter 6 - Chromatogram
• Chapter 7 - Spectrum

9.1  Creating a Parent Ion Discovery Experiment

In the MassLynx sample list use the cursor to select the MS file.

1. Select MS Method from the Instrument Shortcut bar 
2. Select File > New. to create a new template with no predefined functions.
3. In the drop down menu select New 
4. Select  to create a parent ion discovery experiment. This invokes the 

Parent Scan Dialog (Figure 9-1). This consists of 10 tabbed pages.
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9.1.1  Parent Survey Window

Figure 9-1  Parent Scan Dialog: Parent Survey Page

Masses (m/z) Specifies the start and end  range of the low and high-energy 
survey spectra 

Time (Mins) Specifies the start and end times in minutes for the experiment. 
Cone Voltage Allows the user to select either the cone voltage currently in use 

on the active tune page or to specify a user defined value by 
entering a suitable value into the text box 
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Method Specifies the ionization mode and the mode of data collection. It 
is essential that centroid acquisition is selected as this technique 
relies on mass difference in the neutral loss experiment and abso-
lute mass for the product ion experiment. 

Scan Duration Specifies the integration time for the low and high-energy survey 
scans. Typical values are 1 second for the scan and 0.1 second for 
the inter-scan delay. 

Collision Energy These are the collision energies used during the low and high 
energy survey spectra. Typically the low energy is performed at 
10eV or lower, whilst the high-energy data acquisition is 
performed at the appropriate value to produce the desired 
fragmentation. 
If a LockSpray interface is configured the Reference Scan options 
become available. 

Scans to Average The parameter determines the number of reference scans to be 
averaged to provide a correction factor for exact mass measure-
ments. Values between 5 and 10 are generally suitable. 

Frequency determines how often the reference will be selected and a value of 
10 seconds is typical. 

Cone Voltage allows the use to select a suitable cone voltage for the reference 
compound being used. 
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9.1.2  Product Ions

Figure 9-2  Example of a Screen Capture

If the parent ion discovery is to be triggered by the presence of product ions, the masses of 
these ions should be entered in the above list. Once created the list should be saved under 
a suitable name. 

Switch Criteria 

Any ion observed in the high-energy survey spectrum at the m specified above, +/- the 
detection window must exceed the Threshold (Counts/s) to be considered as the chosen 
product ion. 
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Detection Window +/- (mDa) is the mass window for detection placed around the product 
ion. Keeping this detection window low can increase the specificity of the experiment. 
Recommended value is 25 mDa. This value can be lowered to 10mDa in the case of an 
instrument operating with DXC or where a LockSpray interface is being used to apply a 
lock mass correction. 

If more than one product ion is entered in the list then the user must specify the Match as 
either requiring the presence of one/or more product ions. 

9.1.3  Neutral Loss

Figure 9-3  Parent Scan Dialog: Neutral Loss Page
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If the parent ion discovery is to be triggered by the detection of a neutral loss then the mass 
of the loss should be entered into the above list. The value of 97.9769, as in the above 
example, is the loss of H3P04, which is commonly observed from phosphopeptides. If 
multiply charged parent ions are to be considered the software will automatically adjust 
the mass of the neutral loss accordingly. 

9.1.4  MSMS Template

Figure 9-4  Parent Scan Dialog: MSMS Template

This window is used to set-up the parameters for the MSMS data acquisition. 

It is important that the correct Q-Tof tune file (.ipr file) is selected in the instrument 
parameter window 
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9.1.5  MS to MSMS

MS to MSMS Switch Criteria

The decision can be made using TIC or individual ion Intensity. Since multiple 
precursors may be selected for concurrent MS/MS experiments it is usual to set this to 
Intensity. It is useful to acquire some MS data to be able to measure the typical 
background level and the peak intensities from the sample peaks so that the detection 
Threshold can be set appropriately.

Within the mass range of the MS survey scan any peaks that rise above the Threshold (in 
ion counts/sec) will be identified as candidate precursor ions for selection.

To prevent the selection of the P+1 (13C) or P+2 (13C2) isotope peaks as additional 
candidate precursors a Detection Window is set. The window is an absolute mass value, 
i.e:- a setting of 1Da will extract a 1Da range of the m scale and identify only the most 
intense peak contained within that specific m range. A suitable value for 1+ and 2+ ions 
would be 2Da.

Number of Components defines the number of precursor masses that can be selected for 
concurrent MS/MS data acquisition from one MS survey scan. Once the candidate 
precursor are identified the N most intense will be used for MS/MS. The maximum that 
can be specified is eight, but often a more suitable number for LC peaks about 10-20 sec 
wide at half height is 3 - 4.

The detection criteria set here may be subsequently modified by charge state 
considerations (see later)

Mass (m) Specifies the m range over which MS/MS data will be acquired. 
Currently it is vital that both the parent survey and MS/MS 
template interrogate data over the same m range during the 
experiment. 

Cone Voltage Allows the user to select the cone voltage currently in use on the 
active tune page or to specify a value by entering it into the text 
box.

Collision Energy Will define a default collision energy that will be used in the 
MS/MS experiment if, for any reason, a value cannot be selected 
from the parameters defined later under the collision energy 
settings
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Retention Time Window (seconds) This parameter is only active when an include or 
exclude file has been generated and is selected (see later). If an include or exclude file is 
utilized where a retention time is included (e.g. 18 mins), then this window is a time value 
in seconds which is added to the retention time during which the peak must elute to be 
selected for fragmentation. For example, a value of 30secs would mean the peak expected 
to elute at 18 mins must elute between 18.00 and 18.50 mins). 

Charge State

These settings define the parameters used for the charge state recognition algorithm. 

Tolerance Window. The window used when measuring between adjacent peaks 
(isotopes). This should be a tight tolerance, and as a default set to 0.1Da.

Mass Extraction Window. This value in Da is the mass range around the peak identified 
that is extracted to perform the CS recognition on. For peptide work a value of 2Da is 
recommended as a default.

(%) Intensity of Main Peak. This threshold value is utilized to remove low intensity 
noise peaks from being identified by the CS algorithm. A default value of 2% is 
recommended. 

Precursor Selection

Everything. No user-predefined masses are used and all peaks will be selected 
automatically according to the criteria defined in the Automatic Function Switching 
parameters.

Included Masses Only will perform MS/MS solely on those masses appearing in the 
Include Masses list, or file, (see later section page 7) provided that their intensities rise 
above the predefined threshold set in the MS to MS/MS switch criteria.

Included Masses and Everything Else allows masses in the Include Masses list to take 
precedence. These will be selected even if there are more intense peaks that would have 
been selected automatically. 

Detected Precursor Inclusion

Auto Exclude will exclude a m value and its associated detection window (which is now 
defined under the exclude tab) from subsequent selection.

Always Include allows the immediate selection of a previously selected m value.
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Include After Time excludes a previously selected m value and its associated detection 
window, (which is now defined under the exclude tab) from subsequent selection for the 
period specified. This prevents multiple selection of the same precursor in the event of 
tailing from strong LC peaks, but allows the fragmentation of near isobaric components 
eluting at other retention times. The maximum value is 200 secs.

Data

Discard uninteresting survey scans stores only those survey scans which triggered an 
MS/MS experiment to disk. Depending on the exact nature of the experiment, discarding 
these scans may significantly reduce the data file size.

Note: It is not recommended to use this function with the neutral loss or product ion 
experiment.
Creating a Parent Ion Discovery Experiment 147



9

Qtof Micro.book  Page 148  Thursday, December 19, 2002  3:39 PM
9.1.6  MSMS to MS

Figure 9-5  Parent Scan Dialog: MSMS to MS Page

If the MSMS to MS Switch Method is set to Default then the mode change will be 
triggered by one of the mutually exclusive options selected in the MSMS to MS Switch 
Criteria. The Intensity falling below threshold option is measured on the base peak in the 
MS/MS spectrum. A value of 2-3 counts/sec is recommended. 

If the MS to MS Switch Method is set to After time then the mode change will be as for 
the default setting, except that if these criteria are not met then a maximum time can be set. 
(For example in the above case the switch would occur after 15 seconds assuming the 
intensity of the base peak in the MS/MS spectrum had not fallen below 3 counts/sec). 
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If Absence of Neutral Loss is selected the instrument will switch back to the MS mode if 
the presence of the tentatively assigned neutral loss cannot be identified in the MS/MS 
mode. This is highly recommended for phosphopeptide neutral loss experiments.

9.1.7  Include

Figure 9-6  Parent Scan Dialog: Include Page

The Include option allows a number of predefined  values to be included as targeted 
precursor ions, for switching from MS to MS/MS mode. There are two distinct modes of 
operation, when operating with an include list and these are defined in the MS to MSMS 
criteria (see above). 
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Included masses only will restrict MS/MS data acquisition only to peaks having the same 
 as those defined in the Include Masses List, +/- include window in mDa, provided that 

these peaks rise above the threshold. 

Included masses and Everything else mode will preferentially perform MS/MS on 
masses in the Include Masses List, even though more intense masses may have been 
automatically detected, provided that the included masses are above the detection 
threshold. 

The Listed option allows a list of  values separated by commas to be entered directly 
into the window or an  range e.g. 500_1000. MS/MS experiments on these masses will 
be carried out using the parameters defined elsewhere. 

In contrast, the File option allows included masses to be read from a file and specific 
parameters (Retention Time, Collision Energy, Cone Voltage, Charge State) may be 
associated with these  values to override those parameter set elsewhere. The files may 
be created or modified using the New, Add, Delete, Save As and Save buttons as 
necessary.

Charge State 

The Include By Charge State option allows the selection of only those charge states 
specified to be selected for MS/MS analysis. This may be useful, for example, where 
singly charged ions are usually from the background and it is desirable to preclude them 
from analysis. 

The required charge states are specified and separated by commas as shown. It is possible 
to enter values greater than 4, but at present CE control is available only up to and 
including charge state 4. 

The Number of Include Components option window defines the maximum number of 
components above the detection threshold from which the candidate precursors will be 
selected. For low level studies where singly charged ions are not to be selected for MS/MS 
it is clear that there may be many candidates above the threshold, among which the 
multiply charged ions may be the minor components. The range for this parameter is 1 - 
100 and a value of 60 to 80 would be a reasonable default value. It should be noted that 
raising this value will slow the acquisition process. 
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9.1.8  Exclude

Figure 9-7  Parent Scan Dialog: Exclude Dialog

The Exclude Mass window allows predefined masses to be excluded from selection for 
MS/MS analyses. The Exclude Mass window is now defined on this page and a default 
value of at least 1000mDa should be selected for peptide work, otherwise C12 and C13 
isotopes will still be selected for fragmentation as separate peaks. 

An exclude Range e.g. 50_250 can be entered to prevent switching on solvent or 
background ions which are known not to be of interest. 
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Alternatively, the Range option allows a list of  values separated by commas to be 
entered into the location in the Exclude Mass window. This is suitable for a small number 
of components. 

For a larger number of components and particularly for components or impurities not 
permanently present the File option can be used to specify  values and an associated 
retention time. The window around the retention time is specified in the MS to MSMS 
section above. 

9.1.9  Collision Energy

Figure 9-8  Parent Scan Dialog: Collision Energy Page
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Use Default Collision Energy 

When selected all MS/MS data are acquired using the default collision energy specified in 
the MSMS template window. 

Use Collision Energy Profile 

Figure 9-9  The CE Profile Dialog

The collision energy profile option allows a range of different collision energies to be used 
depending on the  value of the selected precursor. In addition, from 1 up to 5 collision 
energies may be used for each precursor  to attempt to produce optimal fragmentation. 
Using the Browse button, previously created files with collision energy profiles may be 
selected. 

Using the Modify button new profiles can be created using the Modify CE Profile 
window and its associated Add, Delete, New, Save and Save As options. 

During the MS/MS experiment data are collected with the collision energy cycling 
through CE1, CE2....CEN on a per spectrum basis. 
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The system will not interpolate values. MS/MS on any value of  not included in this 
table will be performed using the default value set in the MS/MS template. Below is a 
typical collision energy profile covering the range 400 to 1000 . 

Use Charge State Recognition 

Figure 9-10  The Modify Charge State Dialog

This mode will allow the collision energy to be set according to the charge state and  of 
the precursor as determined from the charge state recognition algorithm. Collision energy 
profiles for charge states from 1, 2, 3 and 4 may be created and the text files selected using 
the Browse button. In this mode collision energy profiling by cycling around a number of 
different energies is not required. The system will linearly interpolate between values in 
the table. 

Using the Modify button new profiles can be created using the Modify Charge State 
window and its associated Add, Delete, New, Save and Save As options. The examples 
shown are a set of suggested collision energy profiles for peptides or protein digest 
applications when selecting 2+ ions for MS/MS analysis. 
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Chapter 10
Maintenance and Fault 
Finding

Cleanliness and care are of the utmost importance whenever internal assemblies are 
removed from the instrument.

• Always prepare a clear clean area in which to work.
• Make sure that any tools or spare parts that may be required are close at hand.
• Obtain some small containers in which screws, washers, spacers etc. can be stored.
• Use tweezers and pliers whenever possible.
• If nylon or cotton gloves are used take care not to leave fibres in sensitive areas.
• Avoid touching sensitive parts with fingers.
• Do not use rubber gloves.
• Before reassembling and replacing dismantled components, inspect O rings and other 

vacuum seals for damage. Replace with new if in doubt.

Should a fault occur soon after a particular part of the system has been repaired or 
otherwise disturbed, it is advisable first of all to ensure that this part has been correctly 
refitted and / or adjusted and that adjacent components have not been inadvertently 
disturbed.

: 

This Chapter describes maintenance for the following integral parts of the Q-Tof micro:

• Section 10.2, The Source
• Section 10.3, The Electrospray Probe
• Section 10.4, The APcI Probe
• Section 10.5, The Analyzer

Caution: Many of the procedures described in this chapter involve the 
removal of possibly toxic contaminating deposits using flammable or 
caustic agents. Personnel performing these operations should be 
aware of the inherent risks, and should take the necessary 
precautions.
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In addition further advice and tips are given in the following sections:

• Section 10.6, Fault Finding
• Section 10.7, Cleaning Materials
• Section 10.8, Preventive Maintenance Check List

10.1  Electronics Maintenance

10.1.1  Cooling Fans and Air Filters

Always ensure that none of the cooling fans is obstructed. It is essential that the fan filter 
is checked and cleaned at regular intervals, and replaced if there is any doubt about its 
effectiveness.

10.1.2  The Vacuum System

The performance of the mass spectrometer will be severely impaired by the lack of a good 
vacuum in the ion transfer (hexapole) region or the analyzer.

• An excessive analyzer pressure results in a general loss in performance indicated by a 
loss of resolution and an increase in the background noise.

• As the vacuum deteriorates, the vacuum becomes insufficient to maintain the 
instrument in the operate mode.

Before suspecting a leak, the following points should be noted:

• The turbomolecular pumps will not operate if the rotary pump has failed.
• If the rotary pump is not maintained, the oil may become so contaminated that 

optimum pumping speed is no longer possible. Initially, gas ballasting may clean the 
oil. If the oil in the rotary pump has become discolored, then it should be changed 
according to the pump manufacturer's maintenance manual.

• The turbomolecular pumps switch off if an over temperature is detected. This could 
be due to poor backing vacuum, failure of the water supply or a leak in the source or 
analyzer.

Vacuum Leaks

If a leak is suspected, the following basic points may help to locate it:
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• Leaks very rarely develop on an instrument that has been fully operational. Suspect 
components that have recently been disturbed.

Leaks on flanges can usually be cured by further tightening of the flange bolts or by 
replacing the seal.

• All seals are made using O rings. When refitting flanges pay attention to the 
condition of O rings. Any that are cut or marked may cause a leak. The O rings 
should be clean and free from foreign matter.

A hair across an O ring is sufficient to prevent the instrument pumping down.

• Source components that operate at, or slightly above, atmospheric pressure are not 
susceptible to vacuum leaks.
In the unlikely event of a leak on a feedthrough, then the unit should be replaced or 
returned to Micromass for repair.

Pirani Gauge

The Pirani gauge head does not require routine maintenance.

Active Inverted Magnetron Gauge

In particular, the quadrupole analyzer gauge requires regular maintenance. For 
information on cleaning the active inverted magnetron (Penning) gauge, refer to the 
Edwards literature supplied with the instrument.
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Gas Ballasting

Figure 10-1  Rotary Pump

Gas ballasting serves two important purposes:

• When rotary pumps are used to pump away solvent vapors, the solvent vapor can 
become dissolved in the pump oil causing an increase in backing line pressure. Gas 
ballasting is a method of purging the oil to remove dissolved contaminants.

• Oil mist expelled from the rotary pump exhaust is trapped in the oil mist filter. This 
oil is returned to the rotary pump during gas ballasting.

Gas ballasting should be performed routinely on a weekly basis for 30 minutes. If the 
source is used in the APcI or megaflow electrospray modes, more frequent gas ballasting 
is recommended.

Gas ballasting is performed on the E2M28 pump by rotating the gas ballast valve 5 to 6 
turns in a counterclockwise direction.

It is normal for the rotary pump to make more noise when the gas ballast valve is open.

Caution: Failure to gas ballast the rotary pump frequently leads to shortened oil lifetime 
which in turn may shorten rotary pump lifetime.
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Oil Mist Filter

The E2M28 rotary pump is fitted with an Edwards EMF20 oil mist filter which traps oil 
vapor from the rotary pump exhaust. The trapped oil is then returned to the rotary pump 
during routine gas ballasting. The oil mist filter contains two elements; the odor element 
need not be changed, but the mist element must be changed every time the rotary pump oil 
is changed.

• To change the element follow the instructions in the Edwards manual.

Rotary Pump Oil

The oil in the rotary pump should be maintained at the correct level at all times. Check the 
oil level at weekly intervals, topping up if necessary.

It is important to monitor the condition of the oil regularly. Replace the oil when it has 
changed to a noticeable reddish brown color, or routinely at 4 month intervals (3000 hours 
operation). At the same time, replace the oil mist filter's mist element (see above).

Change the oil in the rotary pump as follows:

1. Gas ballast lightly for 30 to 60 minutes.
2. Vent and shut down the instrument as described in Routine Procedures.
3. It will be found easier to drain the oil while the pump is still warm.
4. Drain the oil through the drain hole situated near the oil level sight glass.
5. Flush the pump, then replace the drain plug and refill the pump with the correct 

grade oil to the correct level.
6. Gas ballast lightly for 30 to 60 minutes.

For further servicing information refer to the manufacturer’s manual.

Foreline Trap

This is used to protect against the chance of pump oil backstreaming into the collision gas 
solenoid and/or the turbo pumps. The activated alumina should be changed according to 
the manufacturer’s instructions.

10.2  The Source

The Z-spray source is a robust assembly requiring little maintenance. The source consists 
of three basic parts:
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• The probe adjustment flange.
• The glass tube.
• The source flange assembly.

The probe adjustment flange and the glass tube can be readily removed, without venting 
the instrument, to gain access to the source block and sample cone. This allows the 
following operations to be performed:

• Wiping the sample cone.
• Removing the sample cone.
• Fitting or removing the APcI corona discharge pin.
• Fitting or removing the exhaust liner and cleanable baffle.
• Fitting or removing the nanoflow electrospray interface.
• Enabling or disabling the purge gas.

The sample cone may be cleaned in situ, by gentle wiping with a cotton swab or lint tissue 
soaked with 50:50 acetonitrile:water. More thorough cleaning of the sample cone may be 
achieved by removing it from the source. This may also be done without venting the 
instrument, by closing the isolation valve located on the ion block. Less frequently it may 
be necessary to clean the ion block, the extraction cone and the hexapole lens, in which 
case the instrument must be vented. This should only be done when the problem is not 
rectified by cleaning the sample cone or when charging effects are apparent.

Charging is evidenced by a noticeable progressive drop in signal intensity, often resulting 
in a complete loss of signal. Switching the instrument out of and back into operate causes 
the beam momentarily to return.

The hexapole transfer lens should not require frequent cleaning. If it is suspected that the 
lens does need cleaning it may be withdrawn from the front of the instrument after 
removing the ion block support.

10.2.1  Cleaning the Sample Cone in Situ

This may be necessary due to lack of sensitivity or fluctuating peak intensity, or if 
deposited material is visible on the outside of the sample cone. Proceed as follows:

1. On the MassLynx Shortcut bar launch the tune page.

Caution: Cleaning the various parts of the source requires the use of 
solvents and chemicals which may be flammable and hazardous to 
health. The user should take all necessary precautions.
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2. Deselect Operate to put the instrument in standby mode
3. Switch off the LC pumps.
4. Disconnect the liquid flow at the rear of the probe.
5. Set Source Block Temp and either APcI Probe Temp or Desolvation Temp to 

20°C to switch off the heaters.

The cooling time will be significantly shortened if the API gases are left flowing.

Figure 10-2  Removing The Source Enclosure

When APcI Probe Temp or Desolvation Temp has cooled below 100°C:

6. Deselect API Gas to switch off the nitrogen supply.
7. Disconnect both gas lines from the front panel by undoing the knurled nuts.
8. Disconnect both electrical connections by pulling back on the plug sleeves to release 

the plugs from the sockets on the front panel.
9. Undo the two knurled thumb nuts that retain the probe and withdraw it from the 

source. Place it carefully to one side.

Caution: Removal of the APcI probe or desolvation nozzle when hot may cause burns.

Attention: Removal of the APcI probe when hot will shorten the probe heater's life.
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10. Undo the three thumb screws and withdraw the probe adjustment flange and glass 
tube. Place the glass tube, end on, on a flat surface and place the probe adjustment 
flange on top of the glass tube.

11. If fitted, remove the APcI corona discharge pin.

The sample cone is now accessible.

12. Using a suitable flat blade screwdriver rotate the isolation valve by 90° into its fully 
anticlockwise position.

A small improvement in the analyzer vacuum may be observed as a result of this 
operation.

The isolation valve (Figure 10-3) is closed when the slot is perpendicular to the direction of 
flow.

13. Carefully wipe the sample cone with a cotton swab or lint free tissue soaked in 
50:50 acetonitrile:water or 50:50 methanol:water.

Figure 10-3  The Source, With Housing Removed

.

14. Dry the cone using nitrogen.

Caution: When the source enclosure has been removed the source block is exposed. 
Ensure that the source block heater has cooled before proceeding.

Attention: Do not attempt to remove any obstruction by poking. This may result in 
damage 
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If the sample cone is still not clean, or if the aperture is partially blocked, proceed to the 
following section. Otherwise, when the cone is clean and dry:

15. Open the isolation valve.
16. Replace all removed components, following in reverse order the removal 

procedures.

10.2.2  Removing and Cleaning the Sample Cone

It is not necessary to vent the instrument to remove the sample cone. The source block 
incorporates an isolation valve for this purpose. To remove the sample cone proceed as 
follows:

1. Follow the procedure in the previous section, to gain access to the sample cone.
2. Using a suitable flat blade screwdriver rotate the valve by 90° into its fully 

anticlockwise position.

A small improvement in the analyzer vacuum may be observed as a result of this 
operation.

The isolation valve is in the closed position when the slot is perpendicular to the direction 
of flow.

Attention: The sample cone is a delicate and expensive component and should be 
handled with extreme care.
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Figure 10-4  Removing the Cone

3. Disconnect the cone gas inlet line (if fitted).
4. Take the sample cone extraction tool supplied in the source spares kit and screw it to 

the flange of the sample cone.
5. Remove the two sample cone retaining screws using a 1.5mm Allen key and 

withdraw the sample cone and cone gas nozzle (if fitted) from the ion block.
6. Remove the extraction tool, and separate the sample cone from the cone gas nozzle. 

Place both components in an ultrasonic bath containing 40:40:10 
acetonitrile:water:formic acid or 40:40:10 methanol:water:formic acid. Rinse and 
sonicate with 50:50 acetonitrile:water or methanol:water.

7. Dry the cone and nozzle using nitrogen.

To minimize down time fit a spare sample cone, obtainable from Micromass, at this stage.

If material has built up on the exhaust liner and cleanable baffle:

1. Remove the cleanable baffle and the exhaust liner.

Attention: Do not attempt to remove the baffle without first removing the sample cone,
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2. Clean these components, or obtain replacements.
3. Fit the cleaned (or the replacement) exhaust liner and cleanable baffle to the ion 

block.

Note: Refitting the sample cone is a reversal of the removal procedure.

10.2.3  Removing and Cleaning the Source Block and Extraction Cone

1. From Tune Page menu bar select Vacuum > Vent.

The rotary pump and the turbomolecular pumps switch off. The turbomolecular pumps are 
allowed to run down to 50% speed after which a vent valve automatically admits dry 
nitrogen.

Figure 10-5  Source Block and Extraction Cone Removed

2. Remove the source enclosure and the sample cone as described in the previous 
section.

When the Instrument has Vented:

3. Remove the two screws which secure the ion block and remove the ion block heater 
and the ion block.
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4. Separate the extraction cone and the PTFE insulating ring from the ion block.
5. Remove the plug and the PTFE sealing washer.
6. Remove the sample cone as described above.
7. Leaving the valve stem in place, immerse the ion block in an ultrasonic bath 

containing 50:50 acetonitrile:water or 50:50 methanol:water, followed by 100% 
methanol.

8. Clean the sample cone and the extraction cone using in turn:
• concentrated formic acid.
• 50:50 acetonitrile:water or 50:50 methanol:water.
• 100% methanol.

9. Dry all components using a flow of nitrogen, or place them in a warm oven.

Caution: Strong acid causes burns. Carry out this procedure in a fume cupboard using 
protective equipment.
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10.2.4  Removing and Cleaning the RF Lens Assembly

Figure 10-6  Removing The RF Lens Assembly

To remove the RF hexapole transfer lens assembly, proceed as follows:

1. Remove the ion block, as described above.
2. Remove the three screws retaining the ion block support and carefully withdraw it, 

together with the support liner and O rings, from the pumping block.
3. Using a lint free tissue to gently grasp the hexapole, carefully withdraw it.

To clean the hexapole transfer lens proceed as follows:

4. Immerse the complete assembly in a suitable solvent (100% methanol) and sonicate 
in an ultrasonic bath.

Attention: Take care not to scratch the internal bore of the pumping block as the 
hexapole lens assembly is withdrawn.
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Figure 10-7  The RF Lens Assembly

5. Thoroughly dry the assembly using a flow of nitrogen.

In severe cases:

1. Remove, clean, dry and replace each rod separately (one at a time).
2. Reassemble the assembly with extreme care, checking the assembly against 

the diagram.

10.2.5  Reassembling and Checking the Source

1. Feed the hexapole transfer lens into the instrument, allowing the recesses in the 
differential aperture plate to locate onto the two support rails within the analyzer 
assembly. Ensure that the assembly is pushed fully in.

2. Check the condition of the O rings on the ion block support. Replace them if 
necessary.

3. Replace the ion block support, pushing it in against the springs of the hexapole 
assembly.

4. Replace the three retaining screws.
5. Fit the plug and sealing ring to the ion block.
6. Fit the insulating ring and extraction cone.
7. Offer the ion block up to the peek ion block support, locate the two dowels and push 

firmly.
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8. Replace the ion block heater.
9. Replace and firmly tighten the two retaining screws taking care not to over-tighten 

the screws.
10. On the tune page select Vacuum > Pump.
11. Replace the PTFE exhaust liner and cleanable baffle, if removed.
12. Replace the sample cone and, if the nanoflow option is to be used, the cone gas 

nozzle on the ion block.
13. Reconnect the cone gas supply (nanoflow operation only).
14. Plug the purge and cone gas outlets and fit the APcI corona discharge pin.
15. Fit the source enclosure and the probe adjustment flange.
16. Insert the APcI probe and connect the Nebuliser Gas line.
17. Select Inlet > Gas and turn on Nitrogen. Fully open the Nebuliser Gas valve.
18. Set Desolvation Gas to read back 400 l/h (monitored on the tune page).
19. Check for gas leaks using soap solution.
20. Reduce Desolvation Gas to 150 l/h.
21. Set Source Block Temp to 150°C, and APcI Probe Temp to 20°C

22. Select Operate on the tune page.
23. With Corona set to zero, check that the Cone readback is reading the correct set 

value.
24. Set Corona to 4.0kV.
25. Check that the Corona readback is 4.0 kV and that the Cone readback is still reading 

the same set value.
26. Check that all other readbacks on the tune page agree with the set values.

10.2.6  The Corona Discharge Pin

If the corona discharge pin becomes dirty or blunt:

1. Remove it from the source.
2. Clean and sharpen it using 600 grade emery paper.

Attention: The maximum operating temperature for the source heater is 150°C. Do not 
set Source Block Temp higher than 150°C.
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If the needle becomes bent or otherwise damaged it should be replaced.

10.3  The Electrospray Probe
 

Indications that maintenance is required to the electrospray probe include:

• An unstable ion beam.
Nebulizing gas may be escaping from the sides of the probe tip.

Ensure that the probe tip O ring is sealing correctly.
The probe tip setting may be incorrect.

Adjust the probe tip setting as described in Electrospray.

The probe tip may be damaged.
Replace the probe tip.

There may be a partial blockage of the sample capillary or the tubing in the solvent 
flow system.

Clear the blockage or replace the tubing.
• Excessive broadening of chromatogram peaks.

This may be due either to inappropriate chromatography conditions, or to large dead 
volumes in the transfer capillaries between the LC column or probe connection.

Ensure that all connections at the injector, the column, the splitting device (if 
used) and the probe are made correctly.

• High LC pump back pressure.
With no column in line and the liquid flow set to 300 µl/min the back pressure should 
not exceed 7 bar (100 psi). Pressures in excess of this indicate a blockage in the 
solvent flow system.
Samples containing particulate matter, or those of high concentrations, are most 
likely to cause blockages.

Check for blockages at the tube connections and couplings to the injector, the 
column and, if used, the flow splitter.

Attention: The probe tip is sharp, and may be contaminated with harmful and toxic 
substances. Always take great care when handling the electrospray probe.
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Concentrated formic acid can be injected to clear blockages. Rinse thoroughly 
afterwards.

Blockage of the stainless steel sample capillary may occur if the desolvation heater is 
left on without liquid flow. This is particularly relevant for samples contained in 
involatile solvents or high analyte concentrations. To avoid this problem it is good 
practice to switch off the heater before stopping the liquid flow, and flush the 
capillary with solvent. 

A blocked stainless steel sample capillary can often be cleared by removing it 
and reconnecting it in the reverse direction, thus flushing out the blockage.

• Gas flow problems
Check all gas connections for leaks using soap solution, or a suitable leak 
searching agent such as Snoop.

10.3.1  Replacement of the Stainless Steel Sample Capillary

Figure 10-8  Removing the Stainless Steel Capillary form the Source

If the stainless steel sample capillary cannot be cleared, or if it is contaminated or 
damaged, replace it as follows:

1. Remove the probe form the source.
2. Disconnect the LC line from the probe and remove the finger-tight nut.
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3. Loosen the grub screw retaining the LC union.
4. Remove the two probe end cover retaining screws, and remove the probe end cover.
5. Unscrew and remove the probe tip.
6. Remove the LC union and adapter nut. Withdraw and discard the stainless steel 

sample capillary.
7. Remake the LC connection to the LC union.
8. Sleeve one end of new sample capillary with the PTFE liner tube.
9. Using a GVF/16 ferrule and the adapter nut, connect the sample capillary to the LC 

union, ensuring that both the liner tube and sample capillary are fully butted into the 
LC union.

10. Disconnect the LC connection and feed the sample capillary through the probe, 
ensuring that a 0.3mm graphitized vespel ferrule (GVF/003) is fitted.

11. Using a Rheodyne spanner, gently tighten the adapter nut onto the probe.
12. Replace the probe tip and adjust so that 0.5mm of sample capillary protrudes from 

the probe tip.
13. Replace the probe end cover and tighten the grub screw to clamp the LC union.

10.4  The APcI Probe

Indications that maintenance to the APcI probe is required include:

• The probe tip assembly becomes contaminated, for example by involatile samples if 
the probe temperature is too low during operation (300°C).

• The appearance of chromatogram peak broadening or tailing.
Samples that give rise to a good chromatogram peak shape in APcI (for example 
reserpine and common pesticides) should display peak half widths of the order 0.1 
minutes for 10µl loop injections at a flow rate of 1 ml/min. The appearance of 
significant peak broadening or tailing with these compounds is most likely to be due 
to a broken fused silica capillary or probe tip heater assembly.

• Low LC pump back pressure.
For 50:50 acetonitrile:water at a flow rate of 1 ml/min, a LC pump back pressure less 
than 14 bar (200 psi) is indicative of a broken fused silica capillary or a leaking 
connector.

• High LC pump back pressure.
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For 50:50 acetonitrile:water at a flow rate of 1 ml/min, a LC pump back pressure 
above 35 bar (500 psi) is indicative of a blockage or partial blockage in the fused 
silica capillary, in a LC connector or in the filter. It is advisable to change the inner 
filter pad on a regular basis (see “Replacing the Fused Silica Capillary” in the 
following pages).

• Gas flow problems.
Check all gas connections for leaks using soap solution, or a suitable leak searching 
agent such as Snoop.

10.4.1  Cleaning the Probe Tip

Remove any visible deposits on the inner wall of the probe heater with a micro-interdental 
brush (supplied in the spares kit) soaked in methanol:water.

Before starting an analysis:

1. With the probe out of the instrument, connect the nebulizing gas supply line.
2. Select API Gas and turn on Nitrogen.
3. Allow the gas to flow for several seconds to clear any debris from the heater.
4. Turn off Nitrogen.
5. Insert the probe into the source.
6. Select API Gas and turn on Nitrogen.
7. Raise APcI Heater gradually, starting at 100°C and increasing in 50°C intervals to 

650°C over a period of 10 minutes.

This procedure should remove any chemical contamination from the probe tip.

Attention: Do not set APcI Heater to 650°C immediately as this may damage the probe 
heater.
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10.4.2  Replacing the Probe Tip Heater

Figure 10-9  The APcI Probe Tip Heater

1. Remove the probe tip assembly by carefully loosening the two grub screws.
2. Disconnect the heater from the probe body by pulling parallel to the axis of the 

probe.
3. Fit a new heater assembly.
4. Reconnect the probe tip assembly.
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10.4.3  Replacing the Fused Silica Capillary

Figure 10-10  Replacing the Fused Silica Capillary on the APcI probe

With the probe removed from the source proceed as follows:

1. Remove the probe tip assembly and the heater, as described in the preceding section.
2. Remove the probe end cover by removing the two screws and the grub screws that 

retain the LC filter.
3. Loosen the filter from the adapter nut.
4. Unscrew the adapter nut from the probe.
5. Remove and discard the fused silica capillary.
6. Using a ceramic capillary cutter, cut a new length of 300µm o.d. × 100µm i.d. fused 

silica capillary, about 1 centimetre excess in length.
7. Using a GVF/004 ferrule and the adapter nut, connect the capillary to the filter 

ensuring that the capillary passes through the ferrule but stops short of the filter.
8. Feed the sample capillary through the probe, ensuring that a 0.4mm graphitized 

vespel ferrule (GVF/004) is fitted.
9. Using a ceramic capillary cutter, cut the capillary at the nebuliser so that between 

0.5 and 1.0mm of capillary is protruding from the nebuliser.
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It is important to cut the capillary square. This should be examined using a suitable 
magnifying glass.

10. Undo the adapter nut from the probe and withdraw the capillary from the probe.
11. Remove 20mm of polyamide coating from the end of the capillary using a flame and 

clean with a tissue saturated with methanol.
12. Carefully re-feed the sample capillary through the probe ensuring that the 

graphitized vespel ferrule is still fitted.
13. Using a Rheodyne spanner, gently tighten the adapter nut to the probe.
14. Replace the probe end cover and retaining screws.
15. Using a 1.5mm Allen key, tighten the grub screw in the probe end cover to clamp 

the filter.
16. Replace the heater and probe tip assembly.

10.5  The Analyzer

The analyzer element of any high performance quadrupole mass spectrometer is, of 
necessity, a precisely machined and aligned assembly.

Q-Tof micro is fitted with a prefilter assembly designed to protect the main analyzer by 
absorbing the majority of any contamination. The prefilter is not as mechanically critical 
as the main rods, as it has only RF applied and is, therefore, not resolving. It does, 
however, act as a high pass filter, and will reject ions of low mass before they enter the 
main rods.

Figure 10-11  The Prefilter and Main Analyzer of the Q-Tof micro
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It is unlikely that there will be any means on site for measuring the assembly to the micron 
level required. If analyzer charging effects cannot be resolved by the techniques below, it 
is almost certain that the analyzer will have to be returned to Micromass for 
refurbishment.

10.5.1  Removing the MS1 and Collision Cell Optical Bench Assembly

1. Vent the system as described at the beginning of this chapter.
2. Remove the analyzer housing top plate.

Working inside the MS1 analyzer housing proceed as follows:

3. Disconnect the two push-on connectors which take the analyzer RF through to the 
RF lens at the source end of the analyzer.

4. Disconnect the three push-on connections bringing RF and DC voltages to the gas 
cell (analyzer housing right hand side).

5. Disconnect the three push-on connections bringing RF and DC voltages to the 
hexapole transfer lens following the gas cell (analyzer housing right hand side).

6. Remove the gas line connection to the gas cell where it enters the gas cell.
7. Disconnect the push-on DC (pole bias) connection to the main filter.
8. Disconnect the heavy gauge copper RF/DC main filter supply from the feedthroughs 

on the left side of the naysayer housing.

All connections to the ion optical bench (main filter assembly/gas cell/RF lens assembly) 
should now have been removed.

9. At the front and rear of the optical bench, remove the two 4mm Allen socket screws 
that secure the bench to the mounting flanges.

Attention: Cleaning the analyzer on site is not a task to be undertaken lightly. It should 
be done only when there is clear evidence that the analyzer is the source of lack of 
performance. The main rods of the analyzer are precision ground, as are the ceramics in 
which they are mounted. Under no circumstances should any of the analyzer rods be 
removed from the ceramic mountings.

Attention: Before removing the optics from the housing prepare a clean area where it 
may be placed in preparation for removing and cleaning the prefilter rods.
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10. Holding the optical bench assembly, using two of the clamps that secure the optical 
elements to the aluminium base plate, lift the rear end upwards to clear the vacuum 
housing and then withdraw the optical bench from the housing.

11. Once removed replace the vacuum housing lid to prevent the ingress of dust into the 
housing.

10.5.2  Dismantling and Cleaning the Entrance Prefilter

Dismantling and cleaning of the entrance prefilter is a skilled procedure which should be 
entrusted only to a Micromass engineer.

10.5.3  Cleaning the MS1 Analyzer Assembly

1. Having removed the optical bench assembly as described above, remove the two top 
clamps that secure the main filter (including pre and post-filter assemblies) to the 
optical bench.

2. Roll up a narrow strip of absorbent lint-free paper. Pass one end through the gap 
between two adjacent main filter rods and back through the next gap so that the 
paper is wrapped one half turn around a rod.

3. Wet the paper with a solvent such as methanol, and move the strip up and down 
along the analyzer rod.

4. Remove the strip and use dry nitrogen gas from a cylinder (not compressed air) to 
blow out any dust or particles.

It is not anticipated that the gas cell or hexapole transfer lens will require cleaning.

10.5.4  Replacing the MS1 and Gas Cell Optical Bench Assembly

Reassembly is the reverse of the appropriate dismantling procedure. Take extra care to 
ensure that all electrical connections are correctly and securely made, and that the various 
mechanical assemblies are accurately aligned within the housing on their locating dowels.

Attention: Under no circumstances should any of the analyzer rods be removed from the 
ceramic mountings.

Attention: Tools, carborundum paper or micromesh must not be used to remove 
contamination from the main filter rods.
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10.5.5  The MS2 Analyzer and Detector Assembly

The orthogonal acceleration cell, reflectron and microchannel plate assemblies are 
separated from the MS1 and gas cell region by a differential pumping orifice. It is 
anticipated that this region of the instrument will not require routine maintenance under 
normal operating conditions.

The microchannel plate system is at risk from failure properly to condition the detector 
following venting of the system to atmosphere or vacuum failure.

10.6  Fault Finding

The majority of faults that occur can be traced to a malfunction of the ion source or inlet 
system. On systems equipped with more than one source, this can often be confirmed by 
changing sources to see if the fault “moves” with the source.

Should a fault occur soon after a part of the system has been repaired or otherwise 
disturbed, it is advisable first of all to ensure that this part has been correctly refitted and 
adjusted, and that adjacent components have not been inadvertently disturbed.

10.6.1  No Beam

Refer to the relevant chapters of this manual and check the following:

Attention: It is strongly recommended that assistance is sought from Micromass if 
maintenance to any of the components within the TOF analyzer housing are thought to 
be necessary (e.g. excessive noise, spikes, loss of detector gain or abnormal TOF peak 
shapes).
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• The tune page real time display is activated by pressing the appropriate button on the 
tool bar of the tune page.

• Normal tuning parameters are set and, where appropriate, readback values are 
acceptable.

• All necessary cables have been correctly attached to the source and probe.
• Solvent is reaching the probe tip and the solvent flow rate is as required.

For solvent flow rates below 100 µl/min it may be necessary temporarily to turn off the 
nebulizing gas and remove the probe from the source to allow the solvent to be seen at the 
probe tip.

• The flows of desolvation gas and nebuliser gas are on and are set to the correct flow 
rates.

• The source has been assembled correctly and is clean.

• The source isolation valve is open.

If, after performing the above checks, the beam is still absent:

1. Acquire TOF data with a mass range extending down to m 20.
2. Check that there is an interference ‘peak’ at approximately m 55 due to the pusher 

pulse being switched off.

If this interference peak is not present, either the pusher is not pulsing or the output from 
the detector is not reaching the TDC (time to digital converter).

The most likely cause of an absent pusher interference pulse is a faulty attenuator. 

If the pusher interference peak is not present no data will be acquired.

10.6.2  Unsteady Beam

Refer to the relevant chapters of this manual and check that:

• Capillary (electrospray) and Sample Cone are tuned correctly.
• The capillary is not protruding too far from the end of the probe.
• The probe is not too far into the source.
• The flow of solvent from the HPLC pump is correct and steady.

To do this, remove the probe, degas the solvent, increase the flow rate for several minutes 
to purge any trapped air then reset and re-measure the flow rate.
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• Solvents have been adequately degassed.
• The nitrogen flow of desolvation gas and nebuliser gas is steady. The nitrogen supply 

pressure should be 7 bar (100 psi) ±10%.
• Desolvation Temp is not set too high for the liquid flow rate used.

High temperatures can vaporize solvent within the electrospray probe.

Should the preceding checks fail to reveal the cause of the problem, proceed to the 
following section.

10.6.3  High Back Pressure

For electrospray, a higher than normal back pressure readout on the HPLC pump, together 
with a slowing of the actual solvent flow at the probe tip, can imply that there is a 
blockage in the capillary transfer line or injection loop due to particulate matter from the 
sample.

To clear the blockage:

Remove the probe from the source and increase the solvent flow to 50 µl/min to 
remove the blockage.

Often, injections of neat formic acid help to redissolve any solute which has precipitated 
out of solution.

If the blockage cannot be cleared in this fashion:

Remove the finger-tight nut and tubing from the back of the probe.

If the back pressure remains high:

Replace the tubing with new tube (or first try removing both ends of the tube).

If the back pressure falls:

Replace the stainless steel sample tube inside the probe (or try reversing the tube to 
blow out any blockage).

Reconnect the tubing to the probe.

The solvent flow can now be readjusted and the probe replaced into the source.

To check the flow rate from the solvent delivery system, fill a syringe barrel or a graduated 
glass capillary with the liquid emerging from the probe tip, and time a known volume, say 
10µl.
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Once the rate has been measured and set, a note should be made of the back pressure 
readout on the pump, as fluctuation of this reading can indicate problems with the solvent 
flow.

For APcI a higher than normal back pressure readout on the HPLC pump can imply that, 
after a long period of use, the filter pad requires replacement.

10.6.4  Loss of Sensitivity

As the ion source becomes dirty after prolonged use, the performance will degrade.

Unstable or reduced ion currents are indicators that the source needs cleaning. The usual 
remedy is to clean the source as described earlier in this chapter.

An increase in the analyzer pressure above 4e-6 mbar can also cause loss of sensitivity, 
although the pressure at which this occurs will be sample dependent.

10.6.5  Incorrect Isotope Distributions

Incorrect isotope distributions can be caused by:

• The TDC Stop (mV) threshold being set too high.
Refer to the tune page settings section of Routine Procedures for information 
regarding the setting of this parameter.

• A faulty attenuator.

Attenuators can fail so that they are open circuit (no beam or pusher interference ‘peak’ 
present), or they can fail such that they stop attenuating.The latter failure mode gives rise 
to incorrect isotope distributions.

When the attenuator fails in this way the TDC Stop (mV) threshold can be increased 
to a significantly higher value than that used previously without reducing the beam 
intensity.

In normal operation setting the TDC threshold above 200 or 250mV will start to reduce the 
beam intensity. If the attenuator has failed the TDC threshold can be increased to 500mV 
or higher before the beam intensity is reduced.

10.6.6  High Noise Levels

High noise levels can either be chemical or electronic in nature.

Chemical Noise

Chemical noise usually originates from contaminated samples, solvents or source gases.
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Chemical noise can be distinguished from electronic noise simply by stopping source 
ionization. If no liquid or gases are entering the source and all the source voltages are set 
to zero then the remaining noise will be electronic in nature.

Electronic Noise

Electronic noise can be caused by setting the TDC Stop (mV) threshold too low. Refer to 
the Tuning Chapter for information regarding the setting of this parameter.

The microchannel plate detector can be damaged by failure to properly condition the 
detector following venting of the system to atmosphere. If the detector is producing 
microdischarges, excessive noise will be apparent on the baseline of mass spectra in the 
absence of any ion beam. Reducing the detector voltage will reduce the number of 
discharges and reduce the noise.

10.6.7  Poor Analyzer Vacuum

Before suspecting a pump fault or vacuum leak (see Vacuum System earlier in this 
chapter) it is worth checking the inverted magnetron (Penning) gauge. If this gauge has 
become dirty it will indicate a poor vacuum, or even fail to register at all.

For information on cleaning the gauge, refer to the Edwards literature supplied with the 
instrument. 

Note: If the instrument has been vented to atmosphere (instead of dry nitrogen) it may 
take one to two days before reaching the vacuum levels obtained prior to venting.

Attention: It is strongly recommended that assistance is sought from Micromass if 
maintenance to the detector system is thought necessary.

Attention: Assistance from Micromass should be sought if, due to symptoms such as 
excessive noise, spikes, loss of detector gain or abnormal peak shapes, maintenance to 
any of the components within the TOF analyzer housing is thought to be necessary.

Caution: The instrument must be vented and electrically isolated at the supply outlet 
before removing the instrument's covers to gain access to the active inverted magnetron 
gauge.
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10.7  Cleaning Materials

It is important when cleaning internal components to maintain the quality of the surface 
finish. Deep scratches or pits can cause loss of performance. Where no specific cleaning 
procedure is given, fine abrasives should be used to remove dirt from metal components. 
Recommended abrasives are:

• 600 and 1200 grade emery paper.
• Lapping paper (produced by 3M).

After cleaning with abrasives it is necessary to wash all metal components in suitable 
solvents to remove all traces of grease and oil. The recommended procedure is to sonicate 
the components in a clean beaker of solvent and subsequently to blot them dry with 
lint-free tissue. Recommended solvents are:

• Isopropyl Alcohol (IPA)
• Methanol
• Acetone

Following re-assembly, components should be blown with oil-free nitrogen to remove 
dust particles.

 

10.8  Preventive Maintenance Check List

• Avoid venting the instrument when the rotary pump is gas ballasting.
• Do not gas ballast the rotary pump for more than 2 hours under any circumstances.

For full details of the following procedures, consult the relevant sections of this chapter and 
/ or refer to the manufacturer's literature.

Attention: Many of the procedures described in this chapter involve the removal of 
possibly toxic contaminating deposits using flammable or caustic agents. Personnel 
performing these operations should be aware of the inherent risks, and should take the 
necessary precautions.
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10.8.1  Daily
• Gas ballast the rotary pump for 30 minutes at the end of a day's megaflow or APcI 

operation.

It is normal for the rotary pump noise level to increase during gas ballasting.

10.8.2  Weekly

• Gas ballast for at least 30 minutes by rotating the gas ballast knob anticlockwise by 5 
to 6 turns.
When gas ballast is complete, check the rotary pump oil level and color.

Oil that has become noticeably red in color should be replaced.

• Check the water chiller level and temperature (if fitted).

10.8.3  Monthly

Check all cooling fans and filters.

10.8.4  Four-Monthly
• Change the mist element in the oil mist filter.
• Change the oil in the rotary pump.

Gas ballast lightly for 30 to 60 minutes both before and after changing oil.
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Appendix A
Reference Information

The reference files listed in this chapter have all ion intensities set to 100%. Actual ion 
intensities are not, of course, all 100%, but the calibration software does not take account 
of the ion intensities and this is a convenient way to store the reference files in the required 
format.

Most samples can be purchased from the Sigma chemical company. To order, contact 
Sigma via the internet, or by toll-free (or collect) telephone or fax:

Internet:

http://www.sigma.sial.com

This site contains a list of worldwide Sigma offices, many with local toll-free numbers.

Toll-free telephone:

USA & Canada800-325-3010

Outside USA & Canada++1 314-771-5750 (call collect)

Toll-free fax:

USA & Canada 800-325-5052

Outside USA & Canada ++44 314-771-5750 call collect and ask for the fax machine)

Direct fax:

Outside USA & Canada ++1 314-771-5757 (this is a toll call)
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A.1  Positive Ion

Ref. File 
Name

Chemical Name
[Sigma Code #]

Molecular 
Mass

/ Uses

UBQ Bovine Ubiquitin
[U6253]

8564.85 650-1500 General

HBA Human α globin
[H753]

15126.36 700-1500 Hb analysis

SOD Superoxide dismutase
[S2515]

15591.35 900-1500 Hb (internal 
cal.)

HBB Human β globin
[H7379]

15867.22 800-1500 Hb analysis

MYO Horse heart myoglobin
[M1882]

16951.48 700-1600 General

PEGH1000 Polyethylene glycol + 
ammonium acetate 
mixture
PEG 200+400+600+1000

80-1000 ES+ and 
APcI+ 
calibration

PEGH2000 Polyethylene glycol + 
ammonium acetate 
mixture
PEG 200+400+600+1000
+1450

80-2000 ES+ 
calibration

NAICS Sodium Iodide / Caesium 
Iodide mixture

20-4000 General,
ES+ 
calibration

NAIRB Sodium iodide / Rubidium 
Iodide mixture

20-4000 ES+ 
calibration
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A.1.1  Horse Heart Myoglobin

Reference File: MYO.REF - Molecular Weight: 16951.48

A.1.2  Polyethylene Glycol

PEG + NH4+

Reference Files: PEGH1000.REF, PEGH2000.REF

Charge 
State

Calculated  
Value

Charge 
State

Calculated  
Value

Charge 
State

Calculated  
Value

28+ 606.419 21+ 808.222 13+ 1304.969
616.177 20+ 848.583 12+ 1413.633

27+ 628.841 19+ 893.192 11+ 1542.053
26+ 652.989 18+ 942.758 10+ 1696.158
25+ 679.068 17+ 998.155 9+ 1884.508
24+ 707.320 16+ 1060.477 8+ 2119.945
23+ 738.030 15+ 1131.108 7+ 2422.651
22+ 771.531 14+ 1211.829

Calculated  Value

63.04 459.28 855.52 1251.75 1647.99
107.07 503.31 899.54 1295.78 1692.01
151.10 547.33 943.57 1339.80 1736.04
195.12 591.36 987.60 1383.83 1780.07
239.15 635.39 1031.62 1427.86 1824.09
283.18 679.41 1075.65 1471.88 1868.12
327.20 723.44 1119.67 1515.91 1912.15
371.23 767.46 1163.70 1559.94 1956.17
415.25 811.49 1207.73 1603.96 2000.20
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A.1.3  Sodium Iodide and Caesium Iodide Mixture

Reference File: NAICS.REF

A.1.4  Sodium Iodide and Rubidium Iodide

Reference File: NAIRB.REF

A.2  Negative Ion

Calculated  Value

22.9898 772.4610 1671.8264 2571.1918 3470.5572
132.9054 922.3552 1821.7206 2721.0861 3620.4515
172.8840 1072.2494 1971.6149 2870.9803 3770.3457
322.7782 1222.1437 2121.5091 3020.8745 3920.2400
472.6725 1372.0379 2271.4033 3170.7688
622.5667 1521.9321 2421.2976 3320.6630

Calculated  Value

22.9898 772.4610 1671.8264 2571.1918 3470.5572
84.9118 922.3552 1821.7206 2721.0861 3620.4515
172.8840 1072.2494 1971.6149 2870.9803 3770.3457
322.7782 1222.1437 2121.5091 3020.8745 3920.2400
472.6725 1372.0379 2271.4033 3170.7688
622.5667 1521.9321 2421.2976 3320.6630

Ref. File Name
Chemical Name
[Sigma Code #]

Molecular 
Mass

/ Uses

MYONEG Horse heart myoglobin 
[M1882]

16951.48 700-2400 General
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A.2.1  Horse Heart Myoglobin

Reference File: MYONEG.REF

A.2.2  Mixture of Sugars mixture

Reference File: SUGNEG.REF

A.2.3  Sodium Iodide and Caesium Iodide (or Rubidium Iodide Mixture

Reference File: NAINEG.REF

SUGNEG Sugar mixture of: 
maltose [M5885] 
raffinose [R0250]
maltotetraose [M8253]
corn syrup [M3639]

100-1500 Low mass 
range

NAINEG Sodium Iodide / 
Caesium Iodide (or 
Rubidium Iodide) 
mixture

200-3900 ES- calibration

Calculated  Value

891.175 1209.812 1882.490
940.741 1302.952 2117.927
996.138 1411.615 2420.632
1058.460 1540.036
1129.091 1694.140

Calculated  Value

179.06 665.21 1151.37
341.11 827.27 1313.42
503.16 989.32 1475.48

Calculated  Value

126.9045 1026.2699 1925.6353 2825.0008 3724.3662
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A.3  Preparation of Calibration Solutions

A.3.1  PEG + Ammonium Acetate for Positive Ion Electrospray and 
APcI

Prepare a solution of polyethylene glycols at the following concentrations:

Use 50% acetonitrile and 50% water containing 2 mmol ammonium acetate.

Use reference file PEGH1000.REF.

A.3.2  PEG + Ammonium Acetate for Positive Ion Electrospray
(Extended Mass Range)

Prepare a solution of polyethylene glycols at the following concentrations:

Use 50% acetonitrile and 50% water containing 2 mmol ammonium acetate.

Use reference file PEGH2000.REF.

276.7987 1176.1641 2075.5296 2974.8950 3874.2604
426.6929 1326.0584 2225.4238 3124.7892
576.5872 1475.9526 2375.3180 3274.6835
726.4814 1625.8469 2525.2123 3424.5777
876.3757 1775.7411 2675.1065 3574.4719

PEG 200 25 ng/ml
PEG 400 50 ng/ml
PEG 600 75 ng/ml

PEG 1000 250 ng/ml

PEG 200 25 ng/µl
PEG 400 50 ng/ml
PEG 600 75 ng/ml

PEG 1000 250 ng/ml
PEG 1450 250 ng/ml
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A.3.3  Sodium Iodide Solution for Positive Ion Electrospray

Method 1

Prepare a solution of Sodium Iodide at a concentration of 2 µg/µl in 50:50 
propan-2-ol (IPA):water with no additional acid or buffer.

Add Caesium iodide to a concentration of 0.05 µg/µl.
The purpose of the caesium iodide is to obtain a peak at 133 (Cs+) to fill the gap in 
the calibration file between 23 (Na+) and the first cluster at 173, which would 
lead to poor mass calibration in this mass range.

Do not add more CsI than suggested as this may result in a more complex spectrum due 
to the formation of NaCsI clusters.

Use reference file NAICS.REF.

Method 2

Prepare a solution of Sodium Iodide at a concentration of 2 µg/µl in 50:50 
propan-2-ol (IPA):water with no additional acid or buffer.

Add Rubidium iodide to a concentration of 0.05 µg/µl.
The purpose of the rubidium iodide is to obtain a peak at 85 (85Rb+) with an intensity 
of about 10% of the base peak at 173. Rubidium iodide has the advantage that no 
rubidium clusters are formed which may complicate the spectrum. Note that rubidium has 
two isotopes (85Rb and 87Rb) in the ratio 2.59:1, giving peaks at 85 and 87.

Use reference file NAIRB.REF.

A.3.4  Sodium Iodide Solution for Negative Ion Electrospray

Either of the above solutions is suitable for calibration in negative ion mode. In both cases 
the first negative reference peak appears at 127 (I–) and the remaining peaks are due 
to NaI clusters.

Use reference file NAINEG.REF.
193



A

Qtof Micro.book  Page 194  Thursday, December 19, 2002  3:39 PM
194



B

Qtof Micro.book  Page 195  Thursday, December 19, 2002  3:39 PM
Appendix B
Instrument Specifications

To enable the instrument to give its best performance the recommended environmental 
conditions and power and water supplies are outlined below. Preparation of the laboratory 
in advance will assist us in efficiently installing the instrumentt.

B.1  Room Location

Dimensions

The Micromass Q-Tof micro MS is 180 mm wide by 635 mm deep by 1163 mm long and 
weighs 200 kg. It is mounted on 6 supporting feet. An external Edwards EM28 requires an 
additional 650 mm by 200 mm of floor space.

In the event that the unit needs to be lifted, the side panels should be removed and suitable 
lifting bands passed beneath the bottom of the frame. These should be attached to a 
suitable device (hoist etc.) to raise the analyser unit in a safe and controlled way. Only 
trained personnel with the correct equipment should carry this out.

A separate table 1200 mm by 730 mm is supplied for the computer terminal. 

Doorways through which the instrument is to be transported should be a minimum of 
820 mm wide.

In the laboratory a minimum clearance of 500 mm should be allowed all round the bench 
for service access, apart from at the rear of the instrument where 900 mm is required.

Note: The instrument should not be placed close to heavy machinery (compressors, 
generators etc.) which give excessive floor vibration.

B.2  Environment

It is recommended that the instrument be sited in an air conditioned laboratory, in a 
draught free position and away from excessive amounts of dust.
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B.2.1  General

Altitude: upto 2000m

Pollution degree 1 in accordabce with IEC 664

Rotary Pump

150 to 400C 

Instrument

The maximum ambient laboratory temperature should not exceed 300C, optimum 
temperature lies in the range 190 - 220C. Short term (1.5 hour) variations should be no 
more than 20C.

The relative humidity should not exceed 70%.

Heat dissipated into the laboratory from the instrument is about 1.2 kW.

The instrument conforms to IEC 1010 - 1, Pollution Degree 1, and Installation Category 
II.

B.2.2  Magnetic Fields

OA-Tof instruments are relatively tolerant to stray magnetic fields. We would advise an 
upper limit of 10 Gauss for both AC and DC components of magnetic field measured at 
the mass spectrometer.

B.2.3  Radio Emissions

The instrument should not be placed within a RF field greater than 0.2 V/metre. This 
approximates to a 1W hand held unity gain transmitter at a distance of 10 m.

Possible sources of RF emission include RF linked alarm systems or LANs, portable 
telephones and hand held transmitters.

B.3  Water Supplies

The heat dissipated into the cooling water is about 400 Watts. The water flow required to 
dissipate the heat generated by the turbo pumps is 35 L/hour for an inlet temperature of 
about 200 C or 23 L/hour at an inlet temperature of about 150 C assuming an outlet 
temperature of about 300 C.
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The water may be supplied by a recirculating chiller with the following characteristics:- 
• Heat dissipation into system: 400 W
• Temperature stability: +/- 20C
• Minimum reservoir volume: 5 L
• Minimum supply pressure:10 psi (outlet at atmospheric pressure).
• Maximum supply pressure: 60 psi
• Minimum flow rate at 150C: 0.4 L/min

The above assume that the outlet water temperature will be no more than 300C. Inlet water 
temperatures below 150C are not recommended since excessive condensation may form 
on exposed pipework.

Alternatively, when there is a cooled water supply available it may be used either directly 
through the instrument or indirectly via a water-to-water heat exchanger. In this latter case 
the chilled water supply to the heat exchanger must be at least 100C below the required 
inlet temperature for the instrument.

One inlet and one outlet are required for the instrument. Reinforced 10mm (3/8 inch) 
flexible hose is preferred. 

To prevent blockage of the water pipes suitable in-line filters will be required to remove 
particulate matter from town water supplies when these are used.

Operation above 2000 metres altitude may adversely affect the cooling of the system.

B.4  Power Requirements

The instrument requires a single phase 50 - 60 Hz, 230 V nominal power supply rated at 
13 A (UK) or 15 A (Europe).

An additional single phase 50 – 60 Hz, 230 V or 115 V nominal power supply rated at 5A 
(UK) is required to run the embedded PC.

In the USA and Canada a single-phase 50 – 60 Hz supply at 230 V phase to neutral fused 
and rated at 15 A is required. Alternatively two phases of a 50 – 60 Hz 208 V phase to 
phase, 3 phase supply, rated and fused at 15 A may be used. It is mandatory that no other 
apparatus is connected to this supply.
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Circuit breakers are an acceptable alternative to fuses. The supply should be terminated in 
the laboratory no more than 2 m from the instrument with either a wall mounted isolator or 
socket and plug to be fitted to the instrument.

Other supply voltages can be accommodated using a transformer to change the primary 
supply voltage to 230 V. Advance notice is required and Micromass should be contacted.

On single-phase supplies the power supply should ensure that the line and neutral wires 
cannot be transposed.

On pump start-up currents of up to 30 A may be drawn for several seconds. Time delay 
fuses and breakers are recommended to prevent nuisance tripping.

A safety earth (ground) correctly rated must be provided in all cases.

Data system components, chromatographs, syringe pumps etc. should be connected 
directly to laboratory power outlets (no ancillary outlets are provided on the instrument).

A residual current device (RCD) is recommended for additional protection. In the case of 
instruments fitted with a transformer the RCD should be fitted in the supply side of the 
transformer.

Supply brownout should not fall to less than half main voltage for greater than 20 msec 
duration.

B.5  Gases and Regulators

Nitrogen

The instrument requires oil free dry nitrogen regulated at 7 bar (100 psi) minimum outlet 
pressure to provide nebulising and drying gas to the instrument.

During API operation typical usage of nitrogen is about 400 L/hour, but under high flow 
rate conditions (Megaflow/APcI) this may increase to 650 L/hour. This equates, 
approximately, to the consumption of a large cylinder of compressed nitrogen each day 
and it may be preferred to use a liquid nitrogen dewar which may last several weeks.

Collision Gases

Typically Argon is used as the collision gas for CID experiments. This should be 99.9% 
pure, regulated at no more than 50 psi. Connection is via 1/8 inch OD stainless steel or 
copper tubing (NOT SUPPLIED).
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B.6  Exhaust Outlets

Rotary Pump Outlet

The rotary pump exhaust outlet must be vented to the atmosphere external to the 
laboratory clear from any air intakes for air conditioning systems. A 12 mm (1/2 inch) 
hose connection is required. If the length of exhaust exceeds 4 m then the internal 
diameter of the pipe should be increased to 48 mm (2 inch) for the excess distance.

Nitrogen Outlet

Severe damage to the instrument will result if the electrospray/APcI exhaust is connected 
to the rotary pump exhaust line. This will occur when the nitrogen supply is off and rotary 
pump oil vapour will migrate via the source exhaust to the ion source and then through the 
sampling orifice into the quadrupole and gas cell assembly.

A separate exhaust for the ion source gas (nitrogen) must be provided to the atmosphere 
external to the laboratory clear from any air intakes for air conditioning systems. A (6mm 
OD) hose connection is required. If the length of exhaust exceeds 3 m then the internal 
diameter of the pipe should be increased to 12 mm (1/2 inch) for the excess distance.

B.7  Performance Specifications

Time of Flight Mass Resolution, Positive Ion

5000 (FWHM) on (M+H)+ ion from Leucine Enkephalin.

Time of Flight Mass Resolution, Negative Ion

5000 (FWHM) on (M-H)- ion from Raffinose.

Full Scan MS Sensitivity, Positive Ion

The signal height obtained from a sample consumption of 200 fmol of horse heart 
Myoglobin (16952 Da) will be greater than 166 ion counts on the most intense peak in the 
charge state envelope. 

A solution of 200 fmol/µL horse heart Myoglobin (in 50/50 acetonitrile/water + 0.2% 
formic acid) will be introduced at a flow rate of 5 µL/min.
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Full Scan MS Sensitivity, Negative Ion

The signal height obtained from the sample consumption of 1 ng of raffinose will be 
greater than 200 counts on the (M-H)- peak at m/z 503. This will correspond to a signal to 
noise ratio of greater than 200:1 (after a 1x3 smooth).

The instrument will be tuned at 5000 resolution (as demonstrated in specification 2a) and a 
solution of 5 ng/L in 50/50 acetonitrile/water (no additives) will be introduced at 
10 µL/min.

Full Scan MS/MS Sensitivity, Positive Ion

The signal height obtained from a consumption of 20 fmol of [Glu1] -Fibrinopeptide B 
(1569 Da) will be greater than 6 counts on the most intense yî sequence ion from the 
MS/MS spectrum of the doubly charged precursor ion. 

This will correspond to a signal to noise ratio of greater than 30:1 (after a 3x9 smooth) on 
the most intense yî sequence ion. 

A solution of 100 fmol/µL will be introduced at a flow rate of 5 µl/min.

Mass Measurement Accuracy (with internal reference)

The RMS error between the measured and the accepted masses of peaks which have 
sufficient intensity and are free from interference from other masses, over the range from  
150-900 Daltons, will be less than 5 ppm. 

One suitable peak of known mass will be used as an internal reference.

The instrument will be tuned at 5000 resolution as demonstrated in specification 1a.

B.7.1  Electrospray Option - Nanoflow

Full Scan MS/MS Sensitivity, Positive Ion

The signal to noise from a consumption of 2 fmol of [Glu1]-Fibrinopeptide B (1569 Da) 
will be greater than 30:1 (after a 3x9 smooth) on the most intense yî sequence ion from the 
MS/MS spectrum of the doubly charged precursor ion. 

A solution of 500 fmol/L concentration in MeOH/H2O + 0.2% formic acid solution and 
with glass micropipettes with 1 or 2 µm tips will be used.

The integration period per spectrum will be about 5 sec and data will be summed over a 
period appropriate for the required consumption of sample.
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B.7.2  Electrospray Option – Transform Software

(Software for the determination of molecular weight from a spectrum containing a series 
of multiply charged ions on a m/z scale by a transform of the data to a true mass scale.)

Mass Measurement Accuracy (no internal reference)

The mean measured mass of transformed data shall be 15867.2 +0.5 Da and the standard 
deviation (σ) of the mean <0.5 Da. 

The transform data will be created from five repeat analyses of the  globin from normal 
human haemoglobin. Mass calibration to be performed using the multiply charged 
α globin peaks from a separate analysis. The raw data should be transformed over the 
range 15,000 - 16,000 Da and smoothed appropriately. 

The instrument will be tuned at 5000 resolution. It is recommended that a solution 
containing 10 pmol/µL of each globin in 50/50 acetonitrile/water + 0.2% formic acid is 
used.
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A
Accept Calibration  105
Accurate Mass  93
Acquisition Status Window  114
Add Task  34
Ammonium Acetate  192
Analog Channels  120
Analyzer

Maintenance  176
APcI  67

Obtaining an Ion Beam  69
APcI Probe

Maintenance  172
Argon  198
Atmospheric Pressure Chemical Ionization

see APcI  67
Automatic Startup / Shutdown  28

B
Borosilicate Capillary  55

C
Caesium Iodide  190, 191
Calibration  93, 102, 113
Calibration Parameters  104
Calibration Solutions  192
Calibration Window  102
Camera System

Nanoflow  60
Capillary  82
Capillary Voltage

ElectroSpray  48
Centroid  123

Charge State  129, 146
Charge State Recognition  154
Checking the ESI Probe  44
Checking the Probe

APcI  68
Checking the Resolution  90
Chromatogram

Real-Time Update  115
Chromatographic Interfacing  52
Cleaning Materials  184
Cleaning Sample Cone  160
Collision Energy

Parent  152
Survey  135

Collision Energy Profile  153
Collision Gases  198
Combine  91
Components  10

Electrical  10
Mechanical  10

Cone Gas
ElectroSpray  48

Configure Contact Closures   31
Configure Shutdown on Error  30
Continuum  123
Conventions, documentation  3
Copy Function  118

D
Daily Maintenance  185
Data Acquisition  111
Data File Name  112
Data System  18
Deadtime Correction  106
Delete Task  34
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Desolvation Gas
APcI  72
ElectroSpray  47

Detected Precursor Inclusion  146
Dialogs

Accept Calibration  105
Analog Data  120
Calibration Parameters  105
Display Calibration Graphs  103
Gas Threshold  33
MCP Conditioning  23
Scan Report  114
Shutdown on Error Configuration  31
Solvent Delay  119
TDC Settings  88
TOFMS Scan  122
Tune Page Acquisition  91, 112

Dimensions  195
Documentation

conventions  3
related  1

E
Electrical Components  10
Electronics  17
Electronics Maintenance  156
Electrospray  39
ElectroSpray Operation  43
Electrospray Probe

Maintenance  170
Electrospray Tip  45
Environment  195
Error

Shutdown  30
ESI interface  39
ESI Source  43
Event Out  17
Exclude Masses

Parent  151
Survey  137

Exhaust Outlets  199
Experiment Setup Editor  115, 116

Toolbar  116
Experimental Record  78
Extraction Cone Voltage  49

F
Fault Finding  155, 179
Four-Monthly Maintenance  185
Front Panel Connections  14
Front Panel Controls  15
Function List  116

G
Gas Ballasting  158
Gas Thresholds  32
Gases and Regulators  198
Glass Capillary Option  61

H
Horse Heart Myoglobin  189, 191

I
Include Masses

Parent  149
Survey  133

Infusion Pump  40
Injection Valve  40
Insert Task  34
Installing Nanoflow  57
Instrument Specifications  195
Instrument Warm-up  24
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I

Intensity Threshold  104
Internal Layout  9
Ion Optical System  76
Ion Optics  8
Ionisation Techniques

APci  6
Ionization Techniques

Electrospray  6
Nanoflow Electrospray  7

L
LC column  39
LC-MS Sensitivity  53
Lock Mass  89
LockMass Correction  106
Log Parameters  37
Lteff  89, 94

M
Maintenace

Electrospray Probe  170
Source  159

Maintenance  155
Analyzer  176
APcI Probe  172

Manual Pusher  87
MCP  87
MCP Conditioning  23
Mechanical Components  10
Megaflow  43
Microscope

Nanoflow  60
Mobile phase  39
Modify Function  117
Modify Task  34
Monthly Maintenance  185
MS to MSMS

Parent  145
MS to MSMS Switch Criteria  129, 145
MSMS Template

Parent  144
Survey  132

MSMS to MS  131
Parent  148
Survey  131

Multi Channel Analysis (MCA).  123
Multiple Sample Acquisition  114
Myoglobin  189, 191

N
NanoFlow Electrospray  55
Nanoflow Interface  55
Nano-LC  55
Nano-LC Assembly  64
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